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Safety Notices
Read all product manuals and consult with Beckman Coulter-trained personnel before attempting 
to operate instrument. Do not attempt to perform any procedure before carefully reading all 
instructions. Always follow product labeling and manufacturer’s recommendations. If in doubt as 
to how to proceed in any situation, contact us.
Beckman Coulter, Inc. urges its customers to comply with all national health and safety standards 
such as the use of barrier protection. This may include, but it is not limited to, protective eyewear, 
gloves, and suitable laboratory attire when operating or maintaining this or any other automated 
laboratory analyzer.
This manual assumes that users have basic knowledge of the Windows operating system, as well as 
experience working with laboratory testing technology. Users are invited to consult the 
appropriate documentation for such information.

Alerts for Warning, and Caution

WARNING
WARNING indicates a potentially hazardous situation which, if not avoided, could 
result in death or serious injury.

CAUTION
CAUTION indicates a potentially hazardous situation, which, if not avoided, may 
result in minor or moderate injury. It may also be used to alert against unsafe 
practices.
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Safety Precautions

WARNING
Risk of operator injury if:
 • All doors, covers and panels are not closed and secured in place prior to and 

during instrument operation.
 • The integrity of safety interlocks and sensors is compromised.
 • Instrument alarms and error messages are not acknowledged and acted upon.
 • You contact moving parts.
 • You mishandle broken parts.
 • Doors, covers, and panels are not opened, closed, removed and/or replaced 

with care.
 • Improper tools are used for troubleshooting.

To avoid injury:
 • Keep doors, covers and panels closed and secured in place while the 

instrument is in use.
 • Take full advantage of the safety features of the instrument. Do not defeat 

safety interlocks and sensors.
 • Acknowledge and act upon instrument alarms and error messages.
 • Keep away from moving parts.
 • Report any broken parts to your Beckman Coulter Representative.
 • Open/remove and close/replace doors, covers and panels with care.
 • Use the proper tools when troubleshooting.

CAUTION
System integrity could be compromised and operational failures could occur if:
 • This equipment is used in a manner other than specified. Operate the 

instrument as instructed in the Product Manuals.
 • You introduce software that is not authorized by Beckman Coulter into your 

computer. Only operate your system's computer with software authorized by 
Beckman Coulter.

 • You install software that is not an original copyrighted version. Only use 
software that is an original copyrighted version to prevent virus 
contamination.
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CAUTION
If you purchased this product from anyone other than Beckman Coulter or an 
authorized Beckman Coulter distributor, and it is not presently under a Beckman 
Coulter service maintenance agreement, Beckman Coulter cannot guarantee that 
the product is fitted with the most current mandatory engineering revisions or 
that you will receive the most current information bulletins concerning the 
product. If you purchased this product from a third party and would like further 
information concerning this topic, contact us.

CAUTION
Risk of instrument damage. This device is intended for indoor use only. To avoid 
device damage, do not install the instrument outdoors.

WARNING
Risk of personal injury. Safety protection can be impaired if used in a manner not 
specified by the manufacturer. To avoid personal injury, use the instrument 
according to the manufacturer's instructions only.

Instrument Safety Precautions

The instrument has been engineered with safety as one of its primary features. Safety of the 
operator, field service personnel, bystanders, and valuable samples, is paramount to Beckman 
Coulter’s commitment to high performance design and engineering. 
This section explains some general safety and hazard symbols and necessary precautions operators 
of the instrument should follow during operation. Engineering controls have been put in place to 
protect the operator, and deliberate misuse of the instrument or its instructions may result in 
unintentional harm. Please follow all safety and hazard instructions as directed.

General Safety
To protect the health, environment, and safety of instrument sites and their users, the following 
information should be reviewed by all operators.
 • The instruments are intended for Professional Use Only. All operators should be trained on the 

proper use and limitations of the instrument prior to its operation.
 • Be aware that the Sort Chamber, Interrogation Chamber, and cabinet doors on the instrument 

present possible pinch points. While the doors are light-weight and do not have sharp edges, 
care should be taken when opening and closing doors. 

 • The view screen on the Biosafety Cabinet can be moved manually up and down thereby creating 
a possible pinch point. Position hands appropriately when moving the view screen on the 
Biosafety Cabinet. 
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 • The sample station has electronically controlled moving parts. Do not insert your hand in the 
sample chamber when it is moving.

 • Wear appropriately sized gloves providing good manual dexterity to reduce the likelihood of 
skin pinches and abrasions.

 • Use proper lifting techniques or seek assistance when handling the BioSafety Cabinet, or full 
tanks. Take care to reduce the likelihood of back injury.

 • Protect the skin and eyes whenever handling chemicals of any kind, regardless of how benign 
they may appear.

 • Check with the site safety officer for correct disposal of waste products and for spill clean-up 
protocols.

 • The user should rest appropriately to avoid strain due to repetitive use, awkward movements, 
or sitting too long.

Biohazard Safety
Use universal precautions when working with pathogenic materials. Means must be available to 
decontaminate the instrument and to dispose of biohazardous waste.
IMPORTANT If any hazardous organism, material, or agent is used in the instrument, the site operator or 

Principal Investigator is responsible for informing Beckman Coulter in writing of those hazards before 
receiving service or repair. This includes a list of all pathogenic cell lines, hazardous reagents, radioactive 
material, or agents with a BSL Level II or higher. This information will be kept confidential and will be used 
to inform Beckman Coulter Field Service Representatives of any hazards prior to visiting any instrument 
site. Failure to report this information may delay service on an instrument. Safety of the user as well as 
safety of Beckman Coulter employees is of overriding importance. Proper decontamination procedures 
must be followed for all applicable returned parts.

 • Gloves, a laboratory coat, and eye protection should be worn whenever handling samples 
including insertion and removal of sample tubes from the sample station.

 • If the system loses vacuum or the waste tube becomes clogged, waste fluid could spill into the 
sort chamber. Immediately turn off sheath and sample flow, wear proper personal protective 
equipment and attend to the spill.

 • Waste fluid may contain hazardous levels of biological and chemical contamination. Gloves, a 
laboratory coat and eye protection should be worn whenever exposure to waste fluid exists.

 • To ensure inactivation of biological organisms in the waste container, an appropriate type and 
quantity of an EPA registered disinfectant should be placed in the tank initially upon use, and 
every time the waste container is emptied and reinstalled.

 • The Aerosol Containment Shield, also known as the Sort Chamber door, is part of a passive 
aerosol containment assembly that isolates the contents of a sort from the rest of the 
instrument, the operator, and the laboratory. When closed, the door limits movement of air 
into and out of the Sort Chamber. It is optional to purchase an Aerosol Evacuation system for 
additional protection from aerosols. See Aerosol Evacuation System. 
NOTE Use of the Aerosol Evacuation system precludes the use of Biosafety Cabinet, or vise versa.

 • A BSL-2, Level A2 Biosafety Cabinet is available for purchase as an optional system accessory. 
Refer to APPENDIX C, Biosafety Cabinet Accessory.
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For additional information on laboratory biosafety, please review the U.S. Department of Health 
and Human Services, Centers for Disease Control document, Biosafety in Microbiological and 
Biomedical Laboratories. Contact the safety officer at your site and discuss proper waste disposal 
precautions and practices. Consult the Original Equipment Manufacturer (OEM) manuals for the 
Biosafety Cabinet and the Aerosol Evacuation System for additional information.

Electrical Safety
The instrument conforms to international regulations encompassing the accessibility of high 
voltages by the user (IEC 61010-1) and exposure to laser emission: IEC 60825-1:2014 Safety of Laser 
Products - Part 1: Equipment Classification and Requirements; 21 CFR 1040 FDA/CDRH Laser 
Product Performance Standard. Please familiarize yourself with the following features of the 
instrument and their corresponding potential hazards.

Safety Interlocks
Under normal operating conditions, the instrument protects the user from exposure to high 
voltages and is considered a Class 1 laser product. The instrument is equipped with four safety 
interlocks designed to protect the operator from inadvertent exposure to high voltage, laser 
radiation, and pinch hazard. 
 • When the Sort Protection door opens, the safety interlock disables the voltage to the deflection 

plates.
 • When the optical bench cover is opened, all the lasers turn off.
 • When the sample station door is opened, the movement of the sample chamber stops and the 

system LED indication turns red.
DO NOT attempt to defeat these interlocks except when this document specifically instructs you to 
do so. Ensure that you have the proper laser safety training prior to defeating safety interlocks.

Stream Charge
When the sheath stream is charged and individual droplets are formed, the droplets retain the 
charge present on the stream.
 • Do not defeat the safety interlock and insert any object into the charged stream.

Drop Drive Voltage
This ranges from 50-250 Vac and is used to drive the piezoelectric crystal mounted in the nozzle. 
The frequency can be set either by Auto Droplet Calibration or by the operator.
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Deflection Plates

CAUTION
Risk of personal injury. Do not touch the charged plates when power is applied.

The range of voltage applied to these plates is ±3800 ~ ±4200 Vdc. This high voltage is present only 
when the plate voltage is turned on and the interlock is closed. High voltage is accessible only if the 
interlock is defeated, and only if the operator inserts an object between the charged plates. Once 
high voltage is enabled by the operator, it is constant until changed by the operator.

Deflection Plate Arcing
Arcing may occur due to buildup of sheath solution on the deflection plates. If arcing occurs, refer 
to deflection plate arcing in CHAPTER 9, Troubleshooting.

Laser Power Supplies
Laser power supplies have dangerous amounts of energy and could be a hazard to the operator. 
Contact us if laser power supplies require service.

Electromagnetic Compatibility
This device complies with the emissions and immunity requirements as specified in the EN/IEC 
61326 series of Product Family Standards for a “basic electromagnetic environment.” Such 
equipment is supplied directly at low voltage from public mains network. This equipment is not 
intended for residential use.
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CAUTION
This device generates, uses and can radiate un-intentional radio-frequency (RF) 
energy. If this device is not installed and operated correctly, this RF energy can 
cause interference with other equipment. It is the responsibility of the end user to 
ensure that a compatible electromagnetic environment for the device can be 
maintained in order that the device will operate as intended.
In addition, other equipment can radiate RF energy to which this device is 
sensitive. If one suspects interference between this device and other equipment, 
Beckman Coulter recommends the following actions to correct the interference:
1. Evaluate the electromagnetic environment before installation/operation of 

this device.
2. Do not operate this device close to sources of strong electromagnetic 

radiation (e.g. unshielded intentional RF sources), as these can interfere with 
proper operation. Examples of unshielded intentional radiators would be 
hand-held radio transmitters, cordless phones and cellular phones.

3. Do not place this device near medical electrical equipment that can be 
susceptible to malfunctions caused by close-proximity to electromagnetic 
fields.

4. This device has been designed and tested to CISPR 11, Class A emission limits. 
In a domestic environment, this device may cause radio interference, in which 
case, you may need to take measures to mitigate the interference.

Symbol Explanations 

Safety symbols alert you to potentially dangerous conditions. The symbol applies to specific 
procedures and appears as needed throughout this manual.

Symbol Warning Condition Action

Biohazard Symbol Consider all materials (specimens, reagents, controls, 
and monoclonal antibodies) and areas these materials 
come into contact with as being potentially infectious.
Wear appropriate barrier protection and follow safe 
laboratory procedures when handling any material in 
the laboratory.

Caution To indicate that caution is necessary when operating 
the device or control close to where the symbol is 
placed, or to indicate that the current situation needs 
operator awareness or operator action in order to 
avoid undesirable consequences. 

Caution, Risk of Electric 
Shock

To indicate hazards arising from dangerous voltages.
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Pinch To warn of a closing motion of mechanical parts of 
equipment.

Recycling Symbol
WEEE Wheeled Bin 
Symbol

The symbol of a crossed-out wheeled bin on the 
product is required in accordance with the Waste 
Electrical and Electronic Equipment (WEEE) 
Directive of the European Union. The presence of 
this marking on the product indicates:
1. that the device was put on the European Market 

after August 13, 2005 and 
2. that the device is not to be disposed via the 

municipal waste collection system of any member 
state of the European Union.

For products under the requirement of WEEE 
directive, please contact your dealer or local 
Beckman Coulter office for the proper 
decontamination information and take-back 
program which will facilitate the proper 
collection, treatment, recovery, recycling, and 
safe disposal of device.
For the Japan market:
This system is considered an industrial waste, subject 
to special controls for infectious waste. Before disposal 
of the system, refer to the Waste Disposal and Public 
Cleaning Law for compliance procedures.

Laser Radiation The laser radiation symbol indicates that there 
can be laser light radiation in the area. Take 
precautions to prevent exposure.

RoHS Caution Symbol This label indicates that the electronic 
information product contains certain toxic or 
hazardous substances. The center number is the 
Environmentally Friendly Use Period (EFUP) date, 
and indicates the number of calendar years the 
product can be in operation. Upon the expiration 
of the EFUP, the product must be immediately 
recycled. The circling arrows indicate the product 
is recyclable. The date code on the label or 
product indicates the date of manufacture. 

California Proposition 
65 Symbol

This label indicates that this product can expose 
you to chemicals including phthalates, which are 
known to the State of California to cause cancer 
and birth defects or other reproductive harm. For 
more information go to 
www.P65Warnings.ca.gov.

Symbol Warning Condition Action

www.P65Warnings.ca.gov
www.P65Warnings.ca.gov
www.P65Warnings.ca.gov
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Laser Class I This label indicates that this product is a Class I 
Laser product. Take precautions to prevent 
exposure.

Consider all materials 
(specimens, controls, 
monoclonal 
antibodies, and so 
forth) as being 
potentially infectious.

Wear standard laboratory attire and follow safe 
laboratory procedures when handling any 
material in the laboratory.

UKCA Mark A "UKCA" mark indicates that a product has been 
assessed before being placed in UK market, and 
has been found to meet UK safety, health, and/or 
environmental protection requirements.

Symbol Warning Condition Action

CLASS  1 LASER PRODUCCLASS  1 LASER PRODUCT
PRODUIT LASER CLASSE 1
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Introduction

Overview

This introduction contains the following information:
 • How to Use Your Manual
 • About this Manual
 • Conventions Used
 • Graphics

How to Use Your Manual

Use this Instructions for Use manual for information on the day-to-day operation of your CytoFLEX 
SRT Sorter. You can find detailed step-by-step procedures for Daily Startup and Quality Control, 
configuring settings, running samples, sorting, analyzing data, and performing Shutdown. This 
manual also contains physical and system specifications, safety and troubleshooting information, 
as well as procedures for cleaning and replacement.

About this Manual

The information in your Instructions for Use manual is organized as follows:
CHAPTER 1, System Overview
Provides information regarding the individual components of the CytoFLEX SRT Sorter and the 
corresponding functions of these components. 
CHAPTER 2, Using the CytExpert SRT Software
Provides an overview of each aspect of the software’s functions.
CHAPTER 3, Daily Startup
Provides instructions for starting your CytoFLEX SRT instrument and navigating to the sample 
testing standby state.
CHAPTER 4, Instrument Quality Control and Standardization
Provides instructions for performing daily quality control (QC) on your CytoFLEX SRT instrument 
to confirm the instrument is working correctly and to ensure accurate experimental data 
measurement. Quality control allows you to determine whether your instrument can provide 
adequate signal strength and precision.
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CHAPTER 5, Sorting
Provides instructions for operating the CytoFLEX SRT instrument, including data acquisition, 
sorting, analyzing, and exporting results, and manually adjusting the compensation during the 
acquisition and analysis.
CHAPTER 6, Compensation
Describes how to create a compensation experiment and automatically calculate compensation 
values after acquiring the single color data. It also explains how to use these calculations for other 
experiments.
CHAPTER 7, Data Review
Describes how to use the Analysis screen to analyze data that has already been acquired. 
CHAPTER 8, Shutting Down the System
Describes how to keep the instrument in optimal condition through daily cleaning during the 
shutdown procedure.
CHAPTER 9, Troubleshooting
Describes some common problems and their solutions in a basic troubleshooting matrix.
CHAPTER 10, Cleaning Procedures
Describes how to carry out certain routine and nonscheduled cleaning procedures.
CHAPTER 11, Replacement/Adjustment Procedures
Describes how to carry out certain routine and nonscheduled replacement and adjustment 
procedures. 
APPENDIX A, Approved Cleaners and Disinfectants
Contains a list of Cleansers and disinfectants that can be used on the instrument.
APPENDIX B, Consumables
Contains a list of consumables to be used with the instrument.
APPENDIX C, Biosafety Cabinet
Defines the cautions and warnings for the optional Biosafety Cabinet. 
APPENDIX D, Instrument Installation
Provides instructions for installing CytExpert software.
APPENDIX E, Good Practices for Cyber Security
Provides a list of good practices for cyber security.
APPENDIX F, Table of Hazardous Substances
Provides the table of hazardous substances with the hazardous substance name and concentration.

Conventions Used

This document uses the following conventions:
 • Bold face font indicates buttons or selections that appear on the workstation screen.
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 • The term “select” is used to indicate the following action:
— To click with a mouse.
NOTE The verb “press” is reserved for mechanical buttons, such as keys on the keyboard.

 • Sections that contain entirely new content are flagged with a New Section icon  at the end 
of the section title.

 • The software path to a specific function or screen appears with the greater than (>) symbol 
between screen options.

 • Links to information in another part of the document for additional information are in blue and 
are underlined. To access the linked information, select the blue, underlined text.

IMPORTANT IMPORTANT is used for comments that add value to the step or procedure being performed. 
Following the advice in the IMPORTANT adds benefit to the performance of a piece of equipment or to a 
process.

NOTE NOTE is used to call attention to notable information that should be followed during use, or 
maintenance of this equipment.

Graphics

All graphics, including screens and printouts, are for illustration purposes only and must not be 
used for any other purpose. For example, software screens that show the CytoFLEX SRT system in 
the background may not depict the latest production version of the system.
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CHAPTER 1
System Overview

Overview

This chapter describes the individual components of the CytoFLEX SRT instrument and the 
corresponding functions of these components. 
This chapter contains information on:
 • Product Description
 • Main Components
 • Fluidics System
 • Optical Components
 • Cell Sorting
 • System Connections
 • Instrument Specifications
 • Performance Characteristics
 • Material Safety Data Sheets (SDS/MSDS)

Product Description

For Research Use Only. Not for use in diagnostics procedures. The use of data generated by this 
instrument depends upon the regulatory status of the reagents used.
The CytoFLEX SRT Cell Sorter is a research instrument that analyzes and sorts cellular suspensions 
and other similarly sized particle suspensions. 
The system can be ordered in various configurations from 2 lasers, 5 colors, to a maximum of 4 
lasers, 15 colors. 

Operation Principles
The CytoFLEX SRT Sorter examines individual particles that are propelled in saline sheath through 
a flow cell (1), then through one to four spatially separated laser beams (2) of differing wavelengths. 
If the properties of the particle, or fluorescent dye added to the particle, are excited by the 
wavelength of laser light, the particle emits broadband fluorescence and scattered light. The 
emitted light is collected, focused, reflected, and filtered, so that discrete wavelengths of light are 
detectable by the fiber array photo detectors (FAPD). The FAPD converts the light signals to 
electronic signals that are sent to the instrument electronics. Data is then acquired by CytExpert 
SRT software according to the parameters set by the operator.
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During sorting, drop drive energy (5) is applied to the piezoelectric crystal in the flow cell. The 
piezoelectric continually vibrates to break the stream into droplets (7). Droplets detach from the 
stream a few millimeters downstream from the nozzle (3). When a particle is detected and meets 
the predefined sorting criteria, an electrical charge is applied to the stream just as the droplet 
containing that particle breaks off from the stream. Once broken off from the stream, the droplet 
which retains its charge, passes through the strongly charged deflection plates (8). Electrostatic 
attraction and repulsion cause each charged droplet to be deflected into the appropriate collection 
device (11). Several side stream detectors (9) inside the instrument are used to monitor the 
deflection angle. Uncharged droplets go down into the waste catcher (10) in the default mode.
Drop delay (12) is defined as the amount of time it takes for a particle to travel from the 
interrogation point of the primary 488-nm laser to the point the droplet breaks off from the stream. 
To ensure the accuracy of drop delay calculation, a second 638-nm laser (4) is introduced to 
calculate the first part of the drop delay (referred to as DD1). DD1 is calculated during the QC. The 
second part of drop delay (referred to as DD2) is the time for a particle to travel from the 
interrogation point of the second 638-nm laser to the last attached drop. DD2 can be determined 
automatically by the sort calibration. During the sort calibration, a strobe LED and a camera (6) 
capture the real-time break-off images and feed them back to the software for algorithm. Refer to 
Figure 1.1. 
During a sort setup, IntelliSort makes use of the stream camera and software to automatically 
optimize droplets, and to determine DD2 without the use of calibration particles. When a sort is in 
process, IntelliSort monitors the droplet stream for instability. Several factors can alter droplet 
stream stability including ambient temperature, fluid temperature, and pressure changes. If 
IntelliSort detects instability, it modifies control parameters to ensure that the sort continues 
uninterrupted and without operator intervention. In the event that IntelliSort detects a dramatic 
drop-formation failure, sample flow is stopped, and the waste catcher moves into place to protect 
the sorted sample. 
 The CytoFLEX SRT Sorter can acquire and analyze up to 15 fluorescence, and two light-scatter 
parameters for each particle. Additional computed parameters can be created based on collected 
data. 
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Figure 1.1  Sort Overview Diagram

Main Components

CAUTION
Risk of instrument damage and/or instrument stability. Do not place any 
unnecessary objects on top of the instrument, as this could cause warping of the 
top cover or affect the stability of the optical path. However, airfoil is an exception 
if the instrument is used inside a Biosafety Cabinet.

The instrument consists of three main components: fluidics cart, Sorter, and the workstation. The 
fluidics cart houses a sheath tank, a shutdown fluid container, and a waste container. Refer to 
Figure 1.2.
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Figure 1.2  Main Components

1. Fluidics cart. Accommodates sheath fluid and shutdown fluid as required for operation of the 
instrument, and collects the waste fluid from the Sorter.

2. Sorter. Provides signal generation and sorting.
3. Workstation. Acquires and analyzes data using the CytExpert SRT software, and displays data 

generated by the Sorter.
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Fluidics System

The fluidics system helps to transmit the sheath fluid at a stable rate into the flow cell, forming a 
laminar flow to ensure that the tested particles go through the detection area sequentially. The 
fluidics system consists of the Sample Station, the fluidics module, and the fluidics cart. The 
following figure shows the whole fluidic flow.

Figure 1.3  Fluidic Flow

1. Sample Chamber
2. Flow cell
3. Waste catcher 
4. Vacuum chamber
5. Waste pump
6. Internal air pump
7. Waste container
8. Pressure chamber
9. Sheath tank
10. Shutdown fluid container
11. Regulator
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Fluidics Cart
IMPORTANT We recommend placing the fluidics cart on the floor for easy accessibility. However, you can 

place the fluidics cart on the same level as the instrument depending on your workspace. 
If you want to relocate the fluidics cart from a table to the floor or conversely, from the floor to the table, 
no user intervention is required for the pressure calibration. 

The fluidics cart (Refer to Figure 1.4) contains three fluidic containers, some quick connectors, fluid 
harness, and a sheath tank scale. Take all necessary biosafety precautions and use proper personal 
protective equipment when handling the fluidics containers.

Figure 1.4  Fluidics Cart

NOTE The system accommodates both the rubber pads and the wheels for the fluidics cart. However, the 
stability of the fluidics cart is critical to the soring performance. Beckman Coulter recommends using the 
rubber pads for the fluidics cart on a solid and stable surface. 
If you prefer to use the scroll-wheels, activate the lock pins of the scroll-wheels to avoid any unexpected 
movement of the fluidics cart. 

NOTE You can put the waste container on the right side of the Sorter inside a Biosafety Cabinet. In this case, 
you need an extension cable to connect the waste level sensor cable from the waste container to the 
quick connector on the fluidics cart. The extension cable is an optional accessory that can be purchased 
separately from Beckman Coulter. For instructions on the connection, refer to Figure 1.35.

1. Shutdown fluid container
2. Waste container 
3. Sheath tank
4. Sheath tank scale
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Figure 1.5  Fluidics Cart (Back)

1. Signal cable of sheath tank scale 
2. Shutdown fluid tubing
3. Waste fluid tubing
4. Sheath fluid tubing
5. Fluidics cart signal cable
6. Sheath pressure check point (for service)
7. Shutdown Fluid filter
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Figure 1.6  Fluidics Cart Connection Panel

1. Shutdown fluid in. Connects the shutdown fluid tubing to the shutdown fluid container.
2. Shutdown fluid level sensor connector. Connects the shutdown fluid sensor cable to the shutdown 

fluid container.
3. Waste level sensor connector. Connects the waste fluid sensor cable to the waste container.
4. Waste out. Connects the waste tubing to the waste container.
5. Air inlet. Connects the air tubing to the sheath tank.
6. Debubble connector. Connects the sheath filter debubble tubing to the debubble filter.
7. Sheath fluid in. Connects the sheath fluid tubing to the sheath fluid filter from the sheath tank.
8. Air filter. Filters particles larger than 0.01 μm.
9. Sheath fluid filter. Filters particles larger than 0.2 μm.

NOTE Beckman Coulter recommends replacing the sheath fluid filter every six months or sooner to 
ensure system performance. Using unfiltered sheath fluid can shorten the service life of the flow 
cell and/or nozzle, and increase noise and debris detection.

10. Debubble filter. Filters particles larger than 50 μm.
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Figure 1.7  Connector Color Convention

Sheath Tank
The sheath tank is an autoclavable, electroplated and stainless-steel tank, with 4-L capacity. Refer 
to Figure 1.8. The system accommodates the 7.5 L sheath tank as an optional accessory that can be 
purchased separately.
Sheath fluid is transported to the flow cell through a clear sheath tubing. Sheath flow is controlled 
through the sheath pressure. The sheath status icon  is shown on the right corner of the 
CytExpert SRT software. When the sheath tank is near empty, a warning notice is transmitted to the 
instrument and audible signal sounds as a warning. For the sheath status information, refer to 
Table 3.1. 

1. Green: shutdown fluid
2. Orange or red: waste fluid
3. White: air tubing
4. Blue: sheath fluid

d
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Figure 1.8  Sheath Tank

Shutdown Fluid Container
The shutdown fluid container is a polypropylene container with 1-L capacity. Refer to Figure 1.9. It 
accommodates the shutdown fluid for decontaminating the fluid lines. The container does not 
require pressurization.

1. Sheath outlet. Connects the sheath tubing to the sheath filter.
2. Air inlet. Provides pressure to convey the sheath to the flow cell or wash station.
3. Safety valve. Releases the pressure from the tank in case of emergency.
4. Pressure relief valve. Releases the pressure from the tank manually.
5. Sheath tank scale. Monitors the volume of sheath remaining in the sheath tank.

NOTE If you need to switch between the 4 L sheath tank and the 7 L sheath tank, reset the sheath 
tank scale first. Refer to Resetting the Sheath Tank Scale in CHAPTER 11, 
Replacement/Adjustment Procedures.
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The shutdown fluid icon  is shown on the right corner of the CytExpert SRT software. When 
the shutdown fluid container is near empty, a warning notice is transmitted to the instrument and 
audible signal sounds as a warning. For the shutdown fluid status information, refer to Table 3.3.
NOTE Beckman Coulter recommends using CytoFLEX SRT Shutdown fluid to ensure system performance. 

For instructions on filling the Shutdown Fluid container, refer to Filling the Shutdown Fluid Container in 
CHAPTER 11, Replacement/Adjustment Procedures.

Figure 1.9  Shutdown Fluid Container

Waste Container
The waste container holds 7-L of waste fluid. Refer to Figure 1.10. The waste from the sample 
station, flow cell or the waste catcher are transported to the waste container by a dual-head pump 
and a waste pump. The waste status icon  is shown on the CytExpert SRT software screen. 
When the waste container is near full, a warning notice is transmitted to the instrument and 
audible signal sounds as a warning. For the waste status information, refer to Table 3.2.
Attention to biosafety and waste labeling is required.

1. Fluid tubing. Connects the container to the fluidics cart. 
2. Level sensor cable. Transfers the fluid level signal from the container to the fluidics cart.

c

b
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Figure 1.10  Waste Container

Fluidics Module
The Fluidics module is on the right side of the Sorter. Inside the module, in addition to working 
pumps, valves, regulators, tubing, several sensors, and fluid filters, there is a pressure chamber, a 
vacuum chamber. 

1. Waste air filter. Filters the contaminated aerosol.
2. Waste level sensor. Monitors the volume of waste in the waste container.
3. Waste inlets. Carries the waste fluid from the Sorter to the waste container.

c db
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Figure 1.11  Interconnections on the Right Side of Sorter

Sample Station

Use universal precautions when working with pathogenic materials. Means must be available to 
decontaminate the instrument and to dispose of biohazardous waste.

WARNING
Risk of biohazardous contamination and/or instrument damage. When running 
samples, it is important to insert the sample tube all the way down into the sample 
tube holder, until the bottom of the sample tube touches the base of the holder. 
Failing to do this could cause the sample probe to bend or break on entry. 
Sample tubes must not exceed 80 mm in height and the outside diameter must not 
exceed 12 mm.

1. Waste out. Connects the waste tubing from the Sorter to the fluidics cart.
2. Air outlet. Connects the sheath air tubing from the Sorter to the fluidics cart.
3. Debubble tubing. Connects to the debubble tubing from the fluidics cart to the Sorter.
4. Shutdown fluid tubing. Connects the shutdown fluid tubing from the fluidics cart to the Sorter.
5. Sheath fluid in. Connects the sheath fluid tubing from the fluidics cart to the Sorter.
6. Grounding cable. For system earthing protective.
7. Fluidics sensor cable. Connects the fluidics signal cable from the fluidics cart to the Sorter.
8. Camera USB cable. Connects the camera USB cable to the workstation.
9. Aerosol connector. Connects to the Aerosol Evacuation system.
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WARNING
Risk of personal injury. Keep your hands off the sample station when the sample 
chamber is moving to avoid pinching your hand.

The Sample Station is where to load a tube and introduce a sample to the instrument. During 
acquisition, the sample chamber is enclosed and pressurized to force the sample toward the flow 
cell. The sample chamber supports sample temperature control and automatic mixing. 

Figure 1.12  Sample Station 

URGENT STOP
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1. Wash station. Automatically cleans the sample probe when the instrument performs a 
backflush.

2. Safety interlock. Stops the sample chamber movement when the sample station door 
is opened.

3. LED indicator. Indicates the working status of the Sorter. 
 • Green: Sorter is in either idle, or ready, or standby state.
 • Red: A critical error has occurred
 • Yellow: The system requires the operator’s attention.
 • Flashing green: Certain program is in process, for example, loading sample, QC, etc.

4. Sample chamber. During the sampling process, the sample chamber cover moves down 
to form a closed and pressurized chamber.
NOTE Do not open the sample station door when the sample chamber cover is moving. 

Otherwise, the system prompts an error.

5. Sample station door. Engages or disengages the safety interlock of the sample chamber 
movement.

6. Sample tube holder. Supports 12 x 75 mm tubes for sample acquisition. 
7. Sample probe. Draws and transfers sample into the flow cell.
8. Tube light. Illuminates the sample tube.

CAUTION
Risk of saline buildup in the fluidics system. Do not use the Urgent Stop button for 
routine shutdown. Urgent stop skips the important cleaning steps and may cause 
high carryover.

9. Urgent Stop. Puts the system into the idle state in urgent cases.
NOTE Long-pressing this button puts the instrument in the following states:

 • Sample loading stopped
 • Sheath flow off
 • Waste catcher extended
 • Deflection plate voltage off
 • Lasers off.

NOTE After using the Urgent Stop button, follow the Daily Startup procedures to resume use. 
Refer to CHAPTER 3, Daily Startup. Beckman Coulter recommends running Shutdown 
Program prior to perform the acquisition or sorting.

10.Backflush tubing. Provides fluid to clean the sample probe, and conveys the waste 
liquid to the waste container.
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Optical Components

CAUTION
Risk of operator injury. When operating the instrument, keep the top cover in the 
closed position to prevent the top cover from falling. When opening the top cover, 
be cautious to avoid any possible pinch points.

The optical components are located in the upper portion of the Sorter and are visible when the top 
cover is open. Three parts are included: an optical bench, detector arrays also known as wavelength 
division multiplexers (WDMs), and optical fibers. Optical components include equipment such as 
lasers and signal detectors that are used to excite, transmit, and collect optical signals. Refer to 
Figure 1.13.

Figure 1.13  Optical Components

1. Optical bench. Includes laser light sources, optical beam combiners, and an integrated optics flow cell assembly. 
The optical bench cover is equipped with a laser interlock that turns the lasers off unless the cover is tightly closed. 

2. Optical fiber. Transmits emitted fluorescence to the specific WDM.
3. Optical filter mirror. Indicates the positions of optical filters inside the WDM when the WDM cap is removed.
4. Wavelength division multiplexer (WDM). Each WDM is a unique detector array that corresponds to a different 

laser, or in some cases two lasers. Each WDM contains optical filters and detectors for detecting channel 
fluorescence or scatter from a particular laser. It is necessary to ensure that the filter and software settings match 
for each channel. Refer to Verifying, Selecting, Editing, and Creating Detector Configuration in CHAPTER 5, Sorting.

CAUTION
Risk of instrument damage. Do not place sample tubes in the optical filter holder. Liquid spills can damage 
instrument components. Use a tube rack to hold any sample tubes.

5. Optical filter holder. Securely holds additional CytoFLEX SRT optical filters.
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Laser Beam Shaping
Before the laser beam reaches the sample stream, lenses focus the beam (refer to Figure 1.14). 
Focusing keeps the beam perpendicular to the sample stream flow while making the beam small 
enough to illuminate only one cell at a time.

Figure 1.14  Laser Beam Shaping

Cell Illumination
As cells in the sample stream go through the sensing area of the flow cell, the elliptical beam 
illuminates them. The cells scatter the laser light and emit fluorescent light from autofluorescence 
and the fluorescent dyes attached to them.

Forward Scatter
The amount of laser light scattered at narrow angles to the axis of the laser beam is called forward 
scatter (FSC). The amount of FSC is proportional to the size of the cell that scattered the laser light.

Side Scatter and Fluorescent Light
The amount of laser light scattered at about a 90° angle to the axis of the laser beam is called side 
scatter (SSC). The amount of SSC is proportional to the granularity of the cell that scattered the 
laser light. For example, SSC is used to differentiate between lymphocytes, monocytes, and 
granulocytes.
In addition to the SSC, the cells emit fluorescent light (FL) at all angles to the axis of the laser beam. 
The instrument measures the amount of FL emitted by cells depending on the reagents used. For 
example, FL above the background FL is used to identify molecules, such as cell surface antigens.

1. Yellow laser beam
2. Blue laser beam
3. Red laser beam
4. Violet laser beam

5. First stage reshaping lens
6. Cuvette
7. Flow cell
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Forward Scatter Collection
The Forward Angle Light Scatter (FALS) detector collects scattered light from a particle that 
intersects with a laser and delivers information roughly proportional to the size of the particle. The 
forward angle light is filtered with a 488 nm band pass before it reaches the FS sensor which 
generates voltage pulse signals. These signals are proportional to the amount of light the sensor 
receives.

Side Scatter and Fluorescent Light Collection
Both side scatter and fluorescence are measured 90 degrees from the laser axis.

Side Scatter
The wavelength of SS is 488 nm. It is much more intense than FL.
Side scatter light collected by the objective lens is delivered by fiber optics to a patent-pending 
design with high performance, solid-state, high efficiency, and low-noise detector arrays.

Fluorescent Light
 Fluorescence and scattered light are transmitted by optical fibers to the Wavelength division 
multiplexer (WDM). Each WDM is a unique detector array that corresponds to a different laser. 
Refer to Wavelength Division Multiplexer (WDM) in CHAPTER 1, System Overview. Each WDM 
contains optical filters and detectors for detecting channel fluorescence or scatter from a particular 
laser. It is necessary to ensure that the filter and software settings match for each channel.
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Figure 1.15  Light Path through the WDM with a Single Port

Wavelength Division Multiplexer (WDM)
Each WDM corresponds to a different laser, or in some cases two lasers. The color of the ring on each 
cap corresponds to the color of the respective laser. Pressing the two release buttons on opposite 
edges of the cap allows you to open the WDM and replace the filters inside. Refer to Figure 1.16. All 
optical filters are designed to be interchangeable. Refer to Replacing the Optical Filter in 
CHAPTER 11, Replacement/Adjustment Procedures to replace an optical filter. 

Figure 1.16  Optical Filter Mounts

1. Fiber array photo detectors (FAPD)
2. Filter
3. 45-degree reflector
4. Doublet lens
5. Light path
6. Mirror
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Each optical filter mount has an optical filter glass piece. Refer to Figure 1.17.

Figure 1.17  Optical Filter Mount with Optical Filter

Each optical filter mount is labeled with the corresponding laser and band-pass information. Refer 
to Figure 1.18.

Figure 1.18  Optical Filter Mount Labeled with the Band-Pass Information

The top of each optical filter mount has two marks. The color of the dot (1) indicates the color of 
the laser. Refer to Figure 1.19. The color of the line (2) indicates the wavelength range of the optical 
band-pass filter. Refer to Figure 1.19.

Figure 1.19  Optical Filter Mount (Top)

Band-pass filters are used to transmit fluorescence within a specific range of wavelength. These 
ranges are designed to measure fluorescence from fluorochromes such as those listed in Table 1.1. 
You can change the optical filters according to your detector configuration. There is no need to 
realign the optical system when the filters are changed.

1. Optical filter glass piece

1. . Indicates corresponding laser color: Blue indicates a 488 nm laser; Red indicates a 
638 nm laser; Violet indicates a 405 nm laser; Yellow indicates a 561 nm laser.

2. . Indicates the band-pass wavelength ranges; the midpoint of the band-pass is 
indicated numerically on the lateral side of the mount.

b
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Table 1.1  WDM Optical Filter Mount Color Codes

Laser Fluorescent Channel
CytoFLEX SRT 
Channel Names

Commonly used 
Fluorescent Dyes

405 nm 450/45 BP
V450 Pacific Blue™ dye, V450, 

eFluor™ 450, BV421

525/40 BP

V525 Krome Orange, AmCyan, 
V500, BV510

610/20 BP
V610 BV605, Qdot® 605

660/10 BP
V660 BV650, Qdot® 655

 780/60 BP
V780 BV780

488 nm 525/40 BP
B525 FITC, Alexa Fluor™ 488, 

CFSE, Fluo-3

690/50 BP
B690 PC5.5, PC5, PerCP, 

PerCP-Cy5.5, PI, DRAQ7™

638 nm 660/10 BP
R660 APC, Alexa Fluor™ 647, 

eFluor™ 660, Cy5

712/25 BP
R712 APC-A700, Alexa 

Fluor™700, Cy5.5

 780/60 BP
R780 APC-A750

561 nm 610/20 BP
Y610 mCherry, ECD, PE-CF594

 780/60 BP
Y780 PC7

585/42 BP
Y585 PE, DsRed

710/50 BP
Y710 PC5.5, mPlum

675/30 BP
Y675 PC5, PE-AF680
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Optical Fiber

CAUTION
Risk of data integrity damage.
 • During use, verify that the optical fibers are securely connected to the WDM. 

A loose connection can alter the optical path and affect fluorescence 
detection.

 • Do not disconnect the fiber as this could contaminate the tip and weaken the 
signal. 

 • Do not kink the optical fibers.

Fluorescence emitted by laser-excited fluorochromes is picked up and delivered by each optical 
fiber to the corresponding detector module. Each optical fiber has an indicator number on the end 
that connects to the WDM. Ensure that the indicator number of the optical fiber matches the 
number of the corresponding WDM.

Figure 1.20  Optical Fiber

1. Blue laser fiber
2. Red laser fiber
3. Yellow laser fiber
4. Violet laser fiber
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Cell Sorting

Sort Chamber
The Sort Chamber is located in the center enclosure. The Sort Chamber is well lit, and designed for 
easy access and cleaning. The sort chamber sliding door, is part of a passive aerosol containment 
assembly that isolates the contents of a sort from the rest of the instrument, the operator, and the 
laboratory. When closed, the door prevents movement of air in and out of the Sort Chamber. To 
easily clean the back side of the sort chamber sliding door, a transparent auxiliary door is designed. 
The auxiliary door is behind the sort chamber sliding door and can be removed completely by 
pulling towards right when the sort chamber sliding door is open. Refer to Figure 1.21.

Figure 1.21  Sorter

1. Sort chamber sliding door
2. Auxiliary door
3. Sort protection door
4. Sort chamber
5. Sample station
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Figure 1.22  Overview of Sort Chamber

1. Sort protection door (open)
2. High voltage safety interlock
3. Waste catcher
4. CyClone movement system
5. Sort chamber illumination
6. Side stream illumination source
7. Nozzle module
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Figure 1.23  Sort Chamber [with Side Stream Illumination Source Removed]

Stream Camera and Droplet Monitor
The camera located opposite to the laser axis is not accessible by the operator. The camera is used 
to view the real-time break-off point, and the droplet status in the stream. 

Select  from the right corner of the software status bar or select Sorter Status 
from the Sorting menu to access the Droplet Status screen. Refer to Figure 1.24.

1. Deflection plates
2. Side stream detection window
3. Side stream illumination
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Figure 1.24  Droplet Status

NOTE For more details, refer to Starting and Monitoring a Sort in CHAPTER 5, Sorting.

Deflection Plates

CAUTION
Risk of personal injury. Do not touch the deflection plates when the high-voltage 
power is applied.

High-voltage deflection plates deflect droplets from the mainstream and direct droplets to specific 
appropriate receptacles. These plates can be polarized with up to ± 4000 Vdc. Caution should be 
exercised when the plate voltage is enabled. 
When opening the sort protection door, the high voltage will be disabled automatically by the high 
voltage safety interlock.
The deflection plates are designed to be easily removed and cleaned. To access the deflection plates, 
you need to open the sort protection door and remove the side stream illumination source. For 
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instructions on removing and cleaning the Deflection Plate, refer to Cleaning the Side Stream 
Illumination Source and the Deflection Plates in CHAPTER 10, Cleaning Procedures.

Nozzle Module
The nozzle module (hereinafter referred to as Nozzle) contains a detachable 100-μm nozzle (1), 
O-ring (2) and a nozzle holder (3). The stream of sheath and sample is pressurized to go through the 
nozzle. This produces a tiny, fine, and fast-moving jet of sample particles. Refer to Figure 1.25.

Figure 1.25  Nozzle Module

1. Nozzle
2. O-ring
3. Nozzle holder
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For instructions on cleaning the nozzle, refer to Cleaning the Nozzle in CHAPTER 10, Cleaning 
Procedures. For instruction on removing/installing the nozzle module, refer to 
Removing/Installing the Nozzle Module in CHAPTER 11, Replacement/Adjustment Procedures.

Waste Catcher
The waste catcher is located under the Side Stream Illumination Source. The waste catcher extends 
during the QC, and sort calibration. During normal sorting, the waste catcher is retracted so that 
the sorted sample can be deposited in the appropriate sort receptacles while the unwanted drops 
are directed to the waste catcher. 
When a fault condition is detected, the waste catcher extends automatically to protect the collected 
sample. The fluid in the waste catcher is finally vacuumed to the waste container. Refer to Table 1.2.

IMPORTANT Ensure that the position of the waste catcher matches the selected Stream Mode. For 
instruction on changing the positions of the waste catcher, refer to Changing the Stream Mode in 
CHAPTER 11, Replacement/Adjustment Procedures.

The waste catcher has two installation positions depending on the Stream Mode: the left position 
for Straight Down Mode, and the right position for Default Mode. The waste catcher receipts the 
core stream as the unwanted in the Default mode while it receipts the side stream L1 as the 
unwanted in the Straight Down mode.

Table 1.2  Waste Catcher

Waste Catcher (Retracted) Waste Catcher (Extended)
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CyClone Movement System

WARNING
Risk of hand pinching. Keep your hands away from the sort chamber when the 
CyClone Movement System is moving.

CAUTION
Risk of damaging the CyClone Movement System. Do not place objects like tube 
holders, unused tubes, slides, gloves inside the Sort Chamber, which might 
interfere with the movement of CyClone System or damage the CyClone System.

The CyClone movement system, located in the Sorter Chamber, supports X-axis and Y-axis 
movements. The system includes a 3-in-1 holder to hold tubes, slides or microplates. Preconfigured 
sort output definitions determine plate voltage and defanning to automatically direct sort streams 
to the appropriate receptacles.

Figure 1.26  Two 5 mL Tubes and Two 15 mL Tubes 
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Figure 1.27  Four 5 mL Tubes

NOTE The tube adapters are required in the lateral tube slots for 5 mL tubes.

Figure 1.28   Standard 96-Well Plate
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Figure 1.29  96-Well Deep Well Plate

The CyClone output holder is designed to be easily removed for cleaning. For instructions on 
cleaning the CyClone holder, refer to Daily Decontamination During Shutdown in CHAPTER 10, 
Cleaning Procedures.

Sample Temperature Control
The system supports temperature control both for the sample tube and the sort collection 
receptacle. This requires a separately purchased Water Bath console which is a stand-alone unit. 
The operator selects a constant, regulated temperature at which to maintain samples. The Sorter 
transfers the refrigerant at a regulated temperature from the Water Bath through the body of the 
sort output holder and the sample tube holder. The Water Bath console is connected to the Sorter 
by two dedicated interconnection adapters (refer to Figure 1.30) which you can find in the 
CytoFLEX SRT system package. 
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Figure 1.30  Interconnection Adapters
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Figure 1.31  Connecting Water Bath to the Sorter

To ensure that the sample collection receptacle is at the desired temperature, start the Water Bath 
console at least 40 minutes before you start sorting.
NOTE A manual with safety instructions for the Water Bath is available directly from the manufacturer. 

Follow all safety and maintenance actions indicated in the manufacturer’s manual.

1. Communication cable
2. Power cord
3. Power supply for Water Bath
4. Return flow tubing from Sorter to Water Bath
5. Circulating flow tubing from Water Bath to Sorter

NOTE Ensure that the color of the quick connectors on the interconnection adapters match that of the 
quick connectors on the Sorter.

NOTE You can use temperature control only for sample tube by connecting only the SAMPLE quick 
connectors on the Sorter, for sort collection receptacles by connecting only the COLLECTION quick 
connectors on the Sorter.

NOTE Figure 1.31 is for reference only. The back of a Water Bath can be different depending the model 
you use. For more details about the Water Bath, refer to the manufacturer’s manual.
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CAUTION
Risk of instrument damage and/or erroneous results. To ensure a long service life 
of the Sorter, the allowable range of the temperature setting for a Water Bath is 
5°C - 49 °C if using DI water, and 0°C - 49 °C if using 25% propylene glycol-Water. 
For the recommended temperature control setting, refer to Table 1.3.

WARNING
Risk of chemical injury from propylene glycol. To avoid contact with the glycol, use 
barrier protection, including protective eyewear, gloves, and suitable laboratory 
attire when working with the Water Bath. Refer to the Safety Data Sheet for 
details about chemical exposure before using the chemical.

Aerosol Evacuation System
The optional Aerosol Evacuation System removes aerosols and micro droplets, which may be 
generated during the course of normal operation or sort failure conditions, from the sort chamber 
without disturbing sorting. The system features an ultra-quiet motor (40 dB Min and 69.5 dB Max) 
and a high-suction, high flow rate centrifugal action pump. Micro droplets and particulates greater 
than 0.12 μm are removed under vacuum and trapped in an Ultra-Low Penetration Air (ULPA) filter. 
The air flow rate of the Aerosol Evacuation System is fully user adjustable, providing clearance of 
the sort chamber at rates of 10 to 40 complete air exchanges per minute. A single disposable filter 
is used on the system to simplify installation and removal of filters. The filter is completely enclosed 
to protect the operator from potential contamination when changing filters. Refer to Figure 1.32.

Table 1.3  Temperature Control Settinga

a. The temperature setting and the actual time can be affected by several conditions such as, the model of your 
Water Bath, the volume of the refrigerant you use, and the ambient temperature in your laboratory. For the 
performance specification of your Water Bath, refer to the manufacturer’s manual.

Required Sample 
Temperature (°C)

Recommended 
Setting (°C)

Time Needed 
(min)

Refrigerant

2-8 0 60 25% Propylene Glycol-Water
35-39 39.5 8 25% Propylene Glycol-Water
8-10 5 45 DI Water
35-39 39.5 8 DI Water
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Figure 1.32  Aerosol Evacuation System

NOTE The sorting performance is sensitive to air disturbances. Beckman Coulter recommends using the 
30% Suction Setting.

The aerosol connector is located at the lower right corner of the Sorter. Refer to Figure 1.11.
The Aerosol Evacuation System vacuums aerosols from the port in the Sort Chamber and vents 
them out the right side of the instrument, trapping them in the filter on the front of the unit. Refer 
to Figure 1.33.

Figure 1.33  Aerosol Evacuation Vents
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Instrument Electronics

The instrument achieves an acquisition rate of 40,000 particles per second, and a sorting rate of 
30,000 particles per second. Electronics and 64-bit software can store up to 34 million events in a 
single data file. 

System Connections

CAUTION
Risk of data loss and/or instrument damage. Never shut off the power or 
disconnect a data cable while the Sorter is in the process of performing a task. 
This could cause data loss or damage to the system.

IMPORTANT The sorting performance is sensitive to the vibration or airflow interference which could impact 
the stability of break-off point. Avoid placing the Sorter near the vibration source or the ventilation outlet.

 • Keep the sheath fluid tubing away from the ventilation outlets on the back of the Sorter, or other 
ventilation equipment.

 • Ensure that the sheath fluid tubing is separated from the waste fluid tubing to avoid any proper 
vibration transmission.
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Figure 1.34  Power and Signal Cable Connections

1. Sorter
2. Back of fluidics cart
3. Workstation
4. Shutdown fluid tubing
5. Sheath air tubing
6. Sheath debubble tubing
7. Waste fluid tubing
8. Waste fluid tubing
9. Sheath fluid tubing

10.  Earthing protective cable
11. Fluidics cart signal cable
12. Camera cable (USB 3.0)
13. USB 2.0 cable
14. Ethernet cable
15. Sorter power supply
16. Water bath connections
17. HDMI cable
18. Workstation power supply
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Figure 1.35  Power and Signal Cable Connections [Waster Container inside Biosafety Cabinet]

1. Sorter
2. Back of fluidics cart
3. Workstation
4. Shutdown fluid tubing
5. Sheath air tubing
6. Sheath debubble tubing
7. Waste fluid tubing
8. Waste fluid tubing
9. Sheath fluid tubing
10.  Earthing protective cable
11. Fluidics cart signal cable

12. Camera cable (USB 3.0)
13. USB 2.0 cable
14. Ethernet cable
15. Sorter power supply
16. Water bath connections
17. HDMI cable
18. Workstation power supply
19. Waste level sensor cable

NOTE You need a separately purchased extension 
cable.

20. Waste container

7809421AB
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Figure 1.36  Fluid Harness Connections

NOTE For the fluidic connections on the fluidic cart, refer to Figure 1.6.

Figure 1.37  Overview of Sorter Connections 

1. Shutdown fluid harness cable
2. Waste harness cable
3. Sheath harness cable

1. USB 2.0 interface. Remote power on/off the Sorter.
2. Ethernet socket. Connects the Sorter to the workstation. 
3. Power switch. Turns the Sorter on and off. An indicator light glows when the power is on. 
4. Fuse. Protects the internal system from damage by high electrical current.
5. Power line socket. Supplies the power to the Sorter.
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Instrument Specifications

Dimensions

NOTE For the Biosafety Cabinet dimensions, refer to the manufacturer’s Product Specification.

Dimensions

Instrument dimensions 
(Length x Width x 
Height)

Sorter 72.5 cm x 47.5 cm x 45 cm
Fluidics cart 34.5 cm x 60 cm x 48.5 cm

Weight Sorter 62 kg
Fluidics cart (without fluid) 13.5 kg
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Installation Category
Installation Category IIa

Maximum Altitude
IMPORTANT If operating the instrument at an altitude greater than 2000 m, you could encounter startup 

failure, sort calibration failure, electric spark, fluid leakage, high carryover rate, or other unknown 
problems. Beckman Coulter assumes no responsibility for any problem resulting from operating 
instrument at an altitude greater than 2000 m (6561 ft).

Do not operate at an altitude greater than 2000 m (6561 ft).

Pollution Degree
Pollution Degree 2b

Acoustic Noise Level
Measure Level: ≤ 65 dBA (CytoFLEX SRT System with or without Biosafety Cabinet)

Electrical Ratings
Input Voltage: 100-240 VAC
Frequency: 50/60 Hz 
Power: 200 VA

a Indicating the transient overvoltage of this level is < 2500 VAC. The instrument is intended for indoor use only.
b Normally, only non-conductive pollution occurs occasionally, however, a temporary conductivity caused by 

condensation must be expected.
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Sorter

Optics

Excitation Optics The CytoFLEX SRT system is configured with four spatially separated lasers. The 
optical system is alignment-free. The laser delays are automatically adjusted by the 
daily QC system, if required. No user intervention is required to ensure optimum 
system performance.

Laser devices Standard wavelengths 
and power 

Violet laser
 • Wavelength: 405 nm, 90 mW
Blue laser
 • Wavelength: 488 nm, 50 mW
Yellow laser
 • Wavelength: 561 nm, 30 mW
Red laser
 • Wavelength: 638 nm, 100 mW

Forward scatter 
detection

Silicon photodiode with built-in 488/15 band-pass filter.

Fluorescence and 
side scatter 
detection

Fluorescence and side scatter light collected by the objective lens is delivered by 
fiber optics to a patent-pending design with high performance, solid-state, high 
efficiency, low-noise detector array.
Reflective optics with a single transmission band-pass filter in front of each detector.

Violet side scatter 
configuration 
(VSSC)

The system offers the ability to configure the violet laser detector to collect side 
scatter to better resolve nanoparticles from noise.

Fluidics System

Sample flow rate 10~100 μL/min
Dimensions Nozzle: 100-μm internal diameter.
Fluid capacity Sheath tank: 4-L, or 7.5-L

Waste container: 7-L 
Shutdown fluid container:1-L

Automated 
maintenance cycles

System Startup program, Backflush, Sheath Filter De-bubble, Flow Cell 
Debubble, Flow Cell Clean, Daily Clean, Aseptic Clean, System Shutdown 
program, Long-term shutdown

Sample input formats 5 mL (12 x 75 mm) polystyrene and polypropylene sample tubes
Sample dead volume < 60 μL
Supported sort 
collection devices

1-way sorting: 6-well plates, 24-well plates, 48-well plates, standard 96-well 
plates, 96-well deep well plates, 384-well plates, slides
4-way sorting: 4 x 5 mL tubes, 2 x 15 mL tubes and 2 x 5 mL tubes
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Performance Characteristics

Electronics

Signal processing 7-decade data display
Signal Pulse area and height for every channel, width for two selectable channels

Data Management

Software CytExpert SRT software
Language English and Chinese
FCS format FCS 3.0
Recommended 
Workstation/
computer 
requirements

Operating system Windows® 10 Enterprise LTSC 2019 x64-bita

a. Windows 10 (2019 LTSC) is the only operating system that has been validated to work with the CytoFLEX SRT workstation.

Processor Intel® Core™ i7-7700 (8MB Cache, 3.6 GHz;
or Intel® Core™ i7-8700T 12MB Cache, 2.4 GHz) 

Monitor 2560 x1440 32 inch
Memory 8 GB RAM or higher
Storage 1 TB or higher
Ethernet integrated 100 MB, Dual Ethernet ports 
USB interface ≥ 5b interfaces, at least one USB 3.0 interface

b.  If you need connect an external device or USB to the computer, Beckman Coulter recommends using the wireless keyboard 
and/or wireless mouse for the computer. Otherwise, you need at least 6 interfaces to ensure one can be used for the 
external device or USB when using the wired keyboard and the wired mouse.

Compensation Full matrix compensation, manual and automatic.
Novel Compensation Library for storage of spillover values of dyes to easily 
determine the correct compensation matrix with new gain settings.

Performance

Sensitivity MESF FITC: < 30 molecules of equivalent soluble fluorochrome 
(MESF-FITC)
PE: < 10 molecules of equivalent soluble fluorochrome 
(MESF-PE)
APC: < 25 molecules of equivalent soluble fluorochrome 
(MESF-APC)

Fluorescence resolution rCV < 3% 
The CytoFLEX SRT cell sorter is capable of achieving <3% rCV. Using 
CytoFLEX Daily QC Fluorospheres or CytoFLEX Ready to Use Daily QC 
Fluorospheres for daily QC, the pass criteria is ≤ 5%.

Side scatter resolution < 300 nm
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Material Safety Data Sheets (SDS/MSDS)

To obtain an SDS or MSDS for the CytoFLEX SRT reagents used on the CytoFLEX SRT systems:
 • On the Internet, go to www.beckman.com:

1. Select Safety Data Sheets (SDS/MSDS) from the Support menu.
2. Follow the instructions on the screen.
3. Contact us if you have difficulty locating the information.

 • If you do not have Internet access, contact us.

Violet Side scatter 
resolution

200 nm relative to polystyrene particles

Forward and side scatter 
resolution

≤ 1 μm
Scatter performance is optimized for resolving lymphocytes, monocytes, 
and granulocytes as well as nanoparticles.

Carryover  < 0.1% (QC beads) 
Sorting The system shall be capable of simultaneously bulk sorting up to 4 defined 

populations of particles with a mode that allows ≥ 99% at purity mode with 
meeting the criteria below:

 • Target population ≤ 5%
 • Sample threshold rate ≤ 10,000 EPS
 • Yield rate: ≥ 80% theoretic rate
 An efficiency rate up to 30,000 events per second can be achieved without 
affecting purity but with a decrease in yield based on Poisson’s statistics.

Performance

http://www.beckman.com
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CHAPTER 2
Using the CytExpert SRT Software

Overview

The CytExpert SRT software is a full-feature software package that controls the instrument's 
operation, which allows you to acquire, sort, and analyze flow cytometry data and then save the 
data in FCS format. This chapter will explain the software’s functions and features.
This chapter contains information on:
 • Launching the Software
 • Main Software Screen
 • User Management
 • Role Management
 • Account Policies
 • Operation Log
 • Graphic and Gating Styles
 • Collection Device Library
 • Software Settings

Launching the Software

Select the desktop shortcut  to launch the CytExpert SRT software.
If there is no desktop shortcut, run the “CytExpert SRT.exe” software directly from the software 
installation directory. The default installation path is C:/Program Files/CytExpert SRT. Or, select 

> All Programs > CytExpert SRT.
Refer to Logging Into the Software in CHAPTER 3, Daily Startup, for detailed instructions on 
opening the software and confirming the connection status.

Main Software Screen

Hover your cursor over any button to display a text pop-up of the button’s function. 
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Start Page
The start page automatically opens after logging into the software.

The following operations can be selected from the start page:

 • New Experiment. Creates a new experiment. The process creates a file with the .xits extension 
and a folder with the same file name where the raw data (.fcs files) are kept.

 • New Experiment from Template. Creates an experiment using a template saved from a 
previously saved experiment.

 • New Compensation. Sets up compensation for an experiment.
 • Open Experiment. Opens a previously created experiment.
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 • Open Compensation. Opens a previously created compensation experiment.
 • Exit. Exits the CytExpert SRT software.
The Experiment, Template, and Compensation tabs below give you the option of opening one of the 
10 most recently opened experiments.

Acquisition Screen
Selecting New Experiment, New Experiment from Template, or Open Experiment automatically opens 
the Acquisition screen. The Acquisition screen can be accessed by selecting  on the left side of 
the page. 

1. Navigation. Gives the option of accessing the Acquisition screen, or Analysis screen.
2. Menu. Allows you to configure settings for sample acquisition, instrument operation, and software 

options.
3. Instrument operation controls. Controls sample loading/unloading, data acquisition/sorting, and 

recording.
4. Collection. Establishes control over data recording options, displays the acquisition status, controls the 

sample flow rate, and sample mixing.
5. Tube management. Allows you to manage sample tubes, set tube attributes, manage experimental 

data and compensation, define sorting criteria.

NOTE The Tube section of the screen can be expanded or retracted by dragging the top border of 
the Tube section of the screen. Expanding this section covers other elements of the screen, 
including: Events/Sec, Events to Display, Sample Flow Rate and Sample Mixing Speed.

6. Plot area. Includes plot and gating controls, as well as an area for creating plots and generating 
graphs.

7. Status bar. Displays instrument status, system information, and fluidics container status.
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Acquisition Screen Navigation
The Acquisition screens have two navigation icons, the Acquisition screen, and the Analysis screen.

1. Acquisition screen icon. Accesses the Acquisition screen.
2. Analysis screen icon. Accesses the Analysis screen.
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Collection

Idle state Standby state Initialized state

System: idle
 • Sample chamber: open
 • CyClone: home position
 • Lasers: off
 • Sheath fluid: off

System: standby
 • Sample chamber: open
 • Cyclone: loading position
 • Lasers: off
 • Sheath fluid: off

System: ready for use
 • Sample chamber: open
 • CyClone: loading position
 • Lasers: on
 • Sheath fluid: on
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1. Acquisition control. Controls sample loading/unloading, sorting, and access acquisition setting.
2. Acquisition status. Displays information such as the acquisition rate (Events/Sec), Processed Events 

(%), Events, and Time.
 • Events/Sec: events acquired/acquisition time. 

NOTE The sorting pause during the data acquisition is excluded from the acquisition time.

 • Processed Events (%): events processed/total detected events. The unprocessed events go into the 
waste stream.

NOTE The Processed Events(%) may be less than 100% if the acquisition rate is too high or the 
sorting contains too many hierarchical gates, which exceed the system processing capability. 
If this situation persists, you need decrease the sample flow rate or optimize the gate settings.

3. Stop conditions. Sets the necessary conditions for recording data.
Explanation of restrictions:
Events displayed: 1-500,000
Events recorded: 1-100,000,000
Recording time: 1-28,800 seconds

4. Sample Flow Rate. Sets the sample flow rate. The amount of sample pressure depends on the sample 
flow rate you specify. The allowable range is 10-100. 

NOTE High acquisition rate may increase the abort rate and measurement CVs. It is recommended 
to customize the acquisition rate according to the nature of your sample.

NOTE For more details, refer to Setting Sample Flow Rate in CHAPTER 5, Sorting.

5. Sample Mixing. Sets the mixing speed.

NOTE High mixing speed may affect the viability of sorted cells.

NOTE For more details, refer to Setting Mixing Speed in CHAPTER 5, Sorting.
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Acquisition/Sorting Control

Acquisition Sorting

Ready for acquisition: Ready for sorting:

Acquisition in process: Sorting in process:

Sorting paused:
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Tube Management

1. Run. Starts sample acquisition.
2. Sort. Starts sorting.
3. Stop. Stops sample acquisition or sorting and save the experiment.
4. Unload. Releases the sample chamber pressure and moves up the sample chamber cover.

NOTE Unload is only available when the sample loading is stopped or paused. Select 
Unload when you need to replace the sample tube.

5. Restart. Restarts the sample acquisition.
6. Pause. Pauses the sorting.
7. Resume. Resumes the sorting. 
8. Record. Record the data. The recorded data cannot be overwritten. 
9. UnRec. Stop recording the data without stopping the sorting.

NOTE UnRec is only available when a sorting is in process. The unrecorded data is not 
archived in the FCS file.

10. Standby. Turns off the sheath and puts the system in the Standby state.

NOTE Beckman Coulter recommends re-running the sort calibration to ensure the auto 
drop delay is accurate if the system enters standby state during a sorting. For Sort 
Calibration, refer to Sort Calibration (Auto Drop Delay) in CHAPTER 5, Sorting.
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1. Tube management controls. Used to add or delete a tube, open the tube property, open the 
experiment folder, open the compensation matrix, define the tube/plate sorting settings, and open the 
sort report.

2. Test tube status indication. Displays a colored symbol in front of each tube indicating the status of 
the tube processing.

 •  indicates that a tube is created, but the tube setting is not defined.

 •  indicates that a tube is created, and the tube sorting setting is defined.

 •   indicates that a tube is created, and the plate sorting setting is defined.

 •  indicates that the tube data without sorting setting was acquired by selecting Run, but can be 
overwritten.

 •  indicates that the tube data with tube sorting setting was acquired by selecting Run, but can 
be overwritten.

 •  indicates that the tube data with plate sorting setting was acquired by selecting Run, but can 
be overwritten.

 •  indicates that the tube data was saved by selecting Record, and that this data cannot be 
overwritten.

 •  indicates that the tube data with tube sorting setting was saved by selecting Record, and this 
data cannot be overwritten. 

 •  indicates that the tube data with plate sorting setting was saved by selecting Record, and this 
data cannot be overwritten.

 •  indicates that the tube is collecting sorting data. 

 •  indicates that the tube data with tube sorting setting was acquired by selecting Sort, but this 
data cannot be overwritten. 

 •  indicates that the tube data with plate sorting setting was acquired by selecting Sort, but this 
data cannot be overwritten. 

 •  indicates imported FCS data.

NOTE  to the left of the test tube status indication symbol indicates that the sample has 
been compensated.

 •  indicates imported FCS data with sorted tube data.

 •  indicates imported FCS data with sorted plate data.

 •  indicates the data file is missing or there is an error in the data file.
3. Test tube list. Displays the sample tubes used in the experiment. Right-click a tube in the list to 

perform additional operations.
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Plot Area

1. Plot controls. Creates single or multiple plots, such as dot plots, histograms, density plots, pseudo 
color plots, and contour plots.

2. Index sorting. Enables index sorting. Refer to Index Sorting in CHAPTER 5, Sorting.
3. Statistics and hierarchy controls. Creates statistical and hierarchical charts.
4. Graphical gating controls. Creates graphical gates.
5. Zoom controls. Zooms in and out within a plot.
6. Pan axis display controls. Scales axis ranges in the plots.
7. Gain adjustment control. Increases and decreases gain adjustments on the plots.

NOTE The gain adjustment control only works when a sample is running.

8. Adjust compensation control. Adjusts compensation of either of the parameters on a 2D histogram.
9. Threshold control. Sets the minimum particle size limit, scatter value, or fluorescence intensity that 

acquisition will allow.
10. Undo and redo controls. Undoes or redoes an action in the drawing area.
11. Display controls. Controls how plots and tables are aligned and arranged.
12. Rearrange. Restores the plots to the default positions.
13. Printing controls. Prints and previews the plot area.
14. Plot area. Displays plots, statistics, and hierarchy tables.
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Status Bar

Analysis Screen
The Analysis screen is similar to the Acquisition screen, without the acquisition control modules.

Drawing controls (Refer to Figure 2.1) include the multi-data histograms and graphical display data 
controls.

Figure 2.1  Drawing Controls Toolbar (Top of Screen)

1. Communication connection status. Displays whether the Sorter and the Workstation are connected. 
2. Instrument state information. Displays the working state of the instrument.
3. System log information. Accesses the system log window.
4. Sorter Status. Accesses the Sorter Status window.
5. Stream Mode. Displays which stream mode is used, Default or Straight Down mode.

NOTE To change the stream mode, refer to Changing the Stream Mode in CHAPTER 11, 
Replacement/Adjustment Procedures.

6. LED indicator. Turns the sort chamber light or the sample tube light on/off.
7. Fluid status information. Displays the liquid level of the fluid containers.
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Compensation Experiment Screen
The Compensation Experiment screen appears when you open or create a new compensation 
experiment.

The Tube management section of the screen can import saved data (.fcs) files for computational 
purposes.
Compensation Controls
The control options include the compensation controls, coordinate pan axis display controls, gain 
adjustment controls, and the undo and redo controls. The compensation controls give you the 
option of calculating the compensation value, displaying the compensation matrix, or changing the 
compensation parameters.

Plots Scale

Index
sorting Gain

Statistics Compensation

Hierarchy Threshold

Gates Undo/Redo

Zoom

1. Tube management. Displays sample tubes required for the compensation experiment.
2. Plot area. Displays compensation plots and gating.
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Compensation 
Calculation

Single Side 
Pan

Compensation 
Matrix

Adjust Gain

Compensation 
Setup

Undo/Redo

Add/Delete 
Negative Gate

Alignment

Zoom Rearrange

Pan Print
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QC Experiment Screen
The Quality Control (QC) Experiment screen appears when select Start QC/Standardization from the 
QC/Standardization tab.

QC Report Screen
Before starting the QC routine, a Settings screen appears.

Figure 2.2  QC Report Screen

1. Menu. Allows you to configure settings related to QC experiments.
2. Acquisition control. Controls sample loading/unloading and data recording. 
3. Lot selection. Allows you to select the lot number of the QC reagent. 
4. QC results list area. Displays the time and results of completed QC runs. 
5. QC reports area. Displays detailed reports for the selected QC experiment.
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QC Experiment Screen
When acquiring QC samples, the software opens the QC screen.

QC Screen Navigation
The Analysis screens have two navigation icons, one for the QC screen and the other for the 
Levey-Jennings (LJ) charts. Refer to Creating Levey-Jennings Charts in CHAPTER 4, Instrument 
Quality Control and Standardization.

1. QC experiment progress indicator. Displays the QC stage.
2. Plot area. Displays the QC plots.

1. QC screen icon. Accesses the QC screen.
2. LJ screen icon. Accesses the Levey-Jennings (LJ) screen.

c

b
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Software Menu
IMPORTANT All menu items apply to the CytExpert SRT Default software option unless otherwise specified. 

Depending on the Sorter state, certain functions may not be available.

The CytExpert SRT software contains the following selectable menu items:

Figure 2.3  Software Menu Tree

*Only available in the CytExpert User Management software option.

The  icon is hyper linked to the Cytobank spotlight page where you can login to the 
Cytobank Premium server, request a 30 day free trial and access additional information. The 
Cytobank platform allows you to analyze, manage and securely share flow cytometry data. FCS files 
can be uploaded to the platform with related attachments such as pdf files.

Figure 2.4  QC Software Menu Tree

*Only available in the CytExpert User Management software option.
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Acquisition and Analysis Screen Menu
CytExpert Default Software Option

CytExpert User Management Software Option

File Menu
For creating new experiments, opening existing experiments, saving new experiments and data, 
and importing/exporting FCS data files.
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Cytometer Menu
For configuring Cytometer settings and controlling Sorter functions. Depending on the Sorter state, 
certain functions may not be available.

[CytExpert SRT Software Option-Standby State]

QC/Standardization Menu
Select Start QC/Standardization from the QC/Standardization menu to start the QC routine.
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Sorting Menu
For controlling sorting options.

Settings Menu
Used to select and/or change software options and settings.

Advanced Menu
Used to access advanced settings for experienced users, including laser time delay settings, 
calibrations.

[Acquisition Mode] [QC/Standardization Mode]
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Account Menu
Used for user account management settings.

NOTE The Account menu is only available in the CytExpert User Management software option.

Log Menu
Used to access logs including the User Management Operation Log, System Operation Log, and the 
User Management Operation Log.

NOTE The Log menu is only available in the CytExpert User Management software option.

Backup/Restore Menu
Used to backup and restore databases.

NOTE The Backup/Restore menu is only available in the CytExpert User Management software option.

Help Menu
For displaying software version information and system Instructions for Use.
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User Management

IMPORTANT Only an Administrator or authorized users can manage users. You must have the CytExpert 
User Management software option installed to use this feature. Refer to CytExpert Software Installation 
Options in APPENDIX D, Instrument Installation. 

User Management is used to create and manage user accounts.
Select Account > User Manager. The User Manager window appears.

Figure 2.5  User Manager (Card View)
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Figure 2.6  User Manager (Grid View)

1. Search text box: Filters users by user name and 
full name.

2. View drop-down: Toggles between Card View 
(see Figure 2.5) and Grid View (see Figure 2.6).

3. New: Used to create a new user profile.
4. Modify: Used to modify an existing user profile.
5. Delete: Used to delete an existing user profile.

6. Unlock: Used to unlock an existing account that 
has been locked.

NOTE An account locks after 3 failed password 
attempts by default. The number of 
attempts can be changed by the 
administrator. Refer to Account Policies.

NOTE An account automatically unlocks after 
30 minutes by default. The duration can be 
changed by the administrator. Refer to 
Account Policies.

7. Reset Password: Used to reset an existing user 
password to a random password.

8. Close: Closes the User Manager window.
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Creating, Deleting, and Modifying Users in User Manager
The initial System Administrator is a system default user and it cannot be deleted, modified, or 
disabled.

Creating a New User in User Manager

1 Select  in the User Manager window. The New window appears.

2 Fill in the new user information.
a. Enter the Username.

NOTE Username has the following naming requirements:
 • The maximum number of allowable characters is 36.
 • Special symbols are allowed.
 • Username cannot be left blank.

b. Enter the Full Name.
NOTE Full Name has the following naming requirements:

 • The maximum number of allowable characters is 72.
 • Special symbols are allowed.
 • Full name cannot be left blank.

c. Select the user Role.
d. Select the Enabled checkbox to enable the user.

NOTE The Enabled checkbox can only be changed by an administrator.
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e. Optional: Select the portrait to import an image.

3 Select . The new user displays in User Manager.

4 Select .

Deleting Users in User Manager

IMPORTANT If an account has been used and log information has been generated related to it, the account 
cannot be deleted, but it can be disabled. 

1 Select the user to be deleted in the User Manager window then select .

2 The following message appears: Are you sure to you want to delete the selected user? Select Yes to 
confirm.

3 Select .

Modifying Users in User Manager

IMPORTANT If an account has been used and log information has been generated related to it, the 
username cannot be modified. 

1 Select  in the User Manager window. The Modify window appears.
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2 Modify the user information as necessary.
NOTE Uncheck the enabled box to disable a user.

3 Select .

4 Select .

Unlocking a User Account
Select a Locked user in the User Manager window and select Unlock. 
NOTE You cannot unlock an active user.
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Resetting a User Password
IMPORTANT Only an administrator or authorized users can reset a password for the users who forget their 

passwords. However, a common administrator cannot reset a password for the initial System 
Administrator because the initial System Administrator is a super administrator. 
If you are the System Administrator and forget your password, refer to Forgot Username or 
Password.

1 Select a user in the User Manager window then select . 

The confirm window appears.
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2 Select Yes. A new random password is automatically generated.

NOTE Select  to copy the username and password to a 
clipboard and inform the user of the change. The user is required to change the new random 
password immediately upon the initial login.

Changing a User Password
Beckman Coulter recommends changing your password on a regular basis.

1 Select Account > Change Password. The Change Password window appears.

2 Enter the current password, the new password, and confirm the new password.
NOTE The new password must contain at least ten digits and four of the following character types:

 • letter in upper case
 • letter in lower case
 • numbers
 • special character
 • Unicode character that is categorized as an alphabetic character but is not uppercase or 

lowercase.
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3 Select .

Forgot Username or Password
The Forgot username or password function allows only the initial System Administrator to reset a 
password using the system administrator credential file. If you are a common user and forget your 
password, contact the administrator to reset a password for you. For instructions, refer to Resetting 
a User Password.
IMPORTANT The System Administrator password cannot be reset without the system administrator 

credential file. Beckman Coulter is not responsible for and will not be able to recover your system 
administrator account if the system administrator password is forgotten and the credential file is lost.

1 Select Forgot username or password on the login window.

The Reset Password window appears.
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IMPORTANT Find the system administrator credential file from the backup folder when installing the 
CytExpert software. You can also export the credential file by selecting Export Credential File from the 
Account menu if you are logged in.

2 Navigate to the system administrator credential file and select Open.

3 Select OK. The Change Password window appears.
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4 Enter the new password, and confirm the new password.
NOTE The new password must contain at least ten digits and all four of the following character types by 

default:
 • letter in upper case
 • letter in lower case
 • numbers
 • special character
 • Unicode character that is categorized as an alphabetic character but is not uppercase or 

lowercase.

However, the password complexity requirements can be disabled by the administrator. Refer to 
Figure 2.8.

Role Management

IMPORTANT Only an Administrator can manage users.

Role Management is used to manage user account permissions.
NOTE Multiple users can be applied to the same role.
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Select Account > Role Manager. The Role Manager window appears. Refer to Figure 2.7.

Figure 2.7  Role Manager

1. New: Used to create a new role profile.
2. Modify: Used to modify an existing role profile.
3. Delete: Used to delete an existing role profile.
4. Close: Closes the Role Manager window.
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Creating, Deleting, and Modifying User Roles in Role Manager

Creating New User Roles in Role Manager

1 Select . The New window appears.

2 Fill in the new role information.
a. Enter the role name.

NOTE Role Name has the following naming requirements:
 • The maximum number of allowable characters is 50.
 • Special symbols are allowed.
 • The text box cannot be left blank.
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b. Enter the role description.
NOTE Role Description has the following naming requirements:

 • The maximum number of allowable characters is 100.
 • Special symbols are allowed.
 • The text box cannot be left blank.

c. Select the permissions applicable to the new role.

3 Select . The new role displays in the role list.

4 Select .

Deleting User Roles in Role Manager

IMPORTANT If a role has already been assigned to a user, that role cannot be deleted.

IMPORTANT The Administrator and Operator Roles are system defaults and may not be deleted.

1 Select the Role to be deleted in Role Manager then select .

2 Select .
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Modifying User Roles in the Role Window

IMPORTANT The Administrator and Operator Roles are system defaults and may not be modified.

1 Select the role to be modified and then select . The Modify window appears.

2 Modify the role information as necessary.

3 Select .

4 Select .
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Account Policies

IMPORTANT Only an Administrator can manage users.

Account policies are used to define the default properties for the password policy, account lockout
policy, and application inactivity policy.
Select Account > Account Policies. The Account Policies window appears.

Figure 2.8  Account Policies - Password Policy

NOTE The allowable range for each entry is as follows:
 • Password Recorded: 10-12
 • Minimum Password Length: 10-14 characters
 • Minimum Password Age: 0-89 days
 • Maximum Password Age: 1-90 days
 • Reminder for Expiration: 1-90 days

NOTE Minimum password age refers to a frozen period within which a password cannot be changed. 
Maximum password age refers to a date when a password expires.
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Figure 2.9  Account Policies - Account Lockout Policy

NOTE The allowable range for each entry is as follows:
 • Invalid Login Attempts: 3-5 times
 • Lockout Time: 30-1,440 minutes
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Figure 2.10  Account Policies - Application Inactivity Policy

NOTE The allowable range for each entry is as follows:
 • Inactivity Duration: 1-15 minutes

Operation Log

Use the Log feature to view, export, or manage the operation logs including the experiment 
operation log, the system operation log, and the user management operation log.
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Viewing and Exporting Experiment Operation Logs

1 Select Log > Experiment Operation Log. The Experiment Operation Log window appears.

2 Select . The Select Experiment Profile window appears.
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3 Select the experiment to be viewed. 

4 Enter the filter conditions: User and Time Range, and then select . The logs 
appear.

5 To export the log, select .
NOTE Experiment Operation logs are exported as a .pdf or .csv file.
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Viewing and Exporting System Operation Logs

1 Select Log > System Operation Log. The System Operation Log window appears.
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2 Enter the filter conditions: User and Time Range, and then select . The logs 
appear.

3 To export the log, select .
NOTE User logs are exported as a .pdf or .csv file.
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Viewing and Exporting User Management Operation Logs

1 Select Log > User Management Operation Log. The User Management Operation Log window 
appears.

2 Enter the filter conditions: User and Time Range, and then select . The logs 
appear.
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3 To export the log, select .
NOTE User logs are exported as a .pdf file.

Graphic and Gating Styles

Plots
The CytExpert SRT software offers a variety of plot formats including:
 • Single-parameter plots and histogram overlays
 • Dual-parameter plots: dot plots, density plots, pseudo color plots, contour plots, and dot plot 

overlays
NOTE Histogram Overlays and Dot Plot Overlays can only be created from multiple samples in the 

Analysis screen. A maximum of 10 samples can be overlaid.

Histogram Multi-sample histogram overlays

Dot plot Density plot



C37808AC   2-44

Using the CytExpert SRT Software
Graphic and Gating Styles  

Gates
Various gating choices are available. 
The software includes the following gate types:
 • For dual-parameter plots: lasso, polygon, rectangle, four-quadrant, hinged gates, and auto 

polygon
 • For single-parameter plots: line-segment, vertical gates, and auto line segment

Pseudo color plot Contour plot Dot plot overlay

Lasso gate Polygon gatea Rectangle gate

Four-Quadrant gate Hinged gate Line Segment gatea
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Collection Device Library

The Collection Device Library is used to manage and calibrate the position of plates or slides. To 
calibrate a plate or a slide, refer to Calibrating the Sort Collection Device in CHAPTER 5, Sorting. 
Select Advanced > Collection Device Library to access the Collection Device Library. Refer to 
Figure 2.11.

Vertical gate
a. This gate can be created using the autogate functionality. Refer to Creating and Adjusting Auto Gates in CHAPTER 5, Sorting.
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Figure 2.11  Default Collection Device Library 

NOTE The 96-well deep well plate and the standard 384-well plate support only the Straight Down mode.

NOTE Additional collection device could be created or deleted from the library based on your needs.

1. Add. Creates a new plate or slide.
2. Edit. Edits a plate or slide.
3. Duplicate. Duplicates a plate or slide.
4. Delete. Deletes an existing plate or slide.
5. Calibrate. Calibrates the position of a plate or slide.
6. OK. Saves the settings.
7. Cancel. Cancels the settings.
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Sort Mode Library

The Sort Mode Library is used to manage the sort modes, and set the default sort mode for sorting. 
To customize a sort mode, you have to add a sort mode first. Refer to Figure 2.12.
Select Advanced > Sort Mode Library to access the Sort Mode Library. 

Figure 2.12  Sort Mode Library 

NOTE The Sort Mode Library can be edited only when an experiment is closed.

NOTE Select Default for Tube or Default for Plate to set the most frequently used Sort Mode as the default 
for the tube sorting or plate sorting. 

Sort Mode
Sort Mode is a combination setting of Sort Precision Level and Drop Envelope. Four sort modes 
including Single, Purity, Purity 1-2 and Enrich are available by default and cannot be deleted or 
changed.
The target population may be sorted using four different modes depending on the output desired. 
Each mode is defined by the location of the particle within the drop and the location of 
contaminants in either the primary drop (the central drop of interest for the sort logic) or an 
adjacent drop (a single drop on either side of the primary drop). 
 • Single Mode: Used when having only one event per drop is the most important aspect of the 

sort.
 • Purity Mode: Used when the purity of the sort is the most important.
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 • Purity1-2 Mode: Used when the purity of the sort is the most important. The Purity 1-2 Mode is 
more inclusive than Purity Mode.
NOTE Beckman Coulter recommends the Purity 1-2 Mode for sorting macro-particles.

 • Enrich Mode: Used when recovery is the most important aspect of the sort. With Enrich, all 
positive events (an event that falls within the sort logic) are sorted.

Sort Precision Level
Below is a detailed explanation of the three Sort Precision Levels. 
Single:
 • Having one positive event per droplet is the most important aspect of single mode, recovery is 

not as important.
 • Only a single positive event and no negative events will be in the drop sorted.
 • If the nearest edge of an adjacent drop contains any positive or negative events, the primary 

drop will be aborted. As the event rate increases, the abort rate will also increase because of the 
likelihood that the primary or near edge of an adjacent droplet will have either a positive or 
negative event.
NOTE The nearest edge depends on the setting of Sort Guard Band. Refer to Sort Guard Band. 

 • Used most often for single cell deposition into plates/slides for cloning purposes.
Purify: 
 • Purity is more important than recovery.
 • The drop being sorted will contain only positive events.
 • If the drop contains negative events, it will be aborted.
 • If the nearest edge of an adjacent drop contains any negative events, the primary drop will be 

aborted. As the event rate increases, the abort rate will also increase because of the likelihood 
that the primary or near edge of an adjacent droplet will have a negative event.
NOTE The nearest edge depends on the setting of Sort Guard Band. Refer to Sort Guard Band. 

Enrich

 •  Recovery is more important than purity.
 • All positive events are sorted, regardless of any negative events (an event that falls outside the 

sort logic) in or near the drop being sorted.
 • Cannot be aborted due to negative events or hardware coincident events. 
 • Provides the greatest efficiency and recovery but least purity. Purity decreases as the event rate 

increases.
The Sort Precision Levels are illustrated in Figure 2.13. The stream is represented by the dark blue 
dots flowing down the figure with either the target population (pink) or the contaminant 
population (blue) located within the droplet. Droplets are either sorted (black highlight) or aborted 
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(red highlight) depending on the sort precision level chosen. The sort precision levels are showed 
from left to right: Single, Purify and Enrich.

Figure 2.13  Sort Precision Modes Applied to the Same Sort Stream

Drop Envelope
The sort drop envelope defines how many drops are sorted based on the position of the positive 
event in the drop. Refer to Figure 2.14. Depending on the required sort application, researchers may 
want a more stringent event location (1/2 Drop) or more inclusive (1-2 Drop). If the drop envelope 
is set incorrectly, recovery of the sorted population may be affected.

Figure 2.14  Drop Envelope

 • 0.5 Drop: One drop is sorted if all positive events are in the center half of the drop. This envelope 
typically provides the poorest yield (most aborts). This is generally used when an exact sort 
count is required such as for single cell deposition (Single Mode). It should never be used with 
the Enrich Mode because positive events will be aborted.

 • 1 Drop: One drop is sorted if the positive events fall anywhere within the drop. This envelope is 
used when determining drop delay. Otherwise, the only time it should be used is when sorted 
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volume/dilution must be minimized. When using this envelope and the drop delay is not 
perfect, recovery will be reduced by 1% for each 1% error in drop delay.

 • 1-2 Drop: One drop is sorted if all positive events are in the center of the droplet. If a positive 
event is outside the center, then the drop adjacent to the edge containing that event is also 
sorted. If there is a positive event in both edges, then both adjacent drops are sorted. This 
envelope ensures that the positive events are always sorted. The sorted volume will be about 
30% greater than the 1-drop envelope if the Sort Guard Band is set to 15%.

Sort Guard Band
For the accuracy of sort decision, a droplet is divided into three sections, the leading edge (1), the 
middle (2), and the trailing edge (3). The leading edge and the trailing edge are equal. Sort Guard 
Band defines the size of the two equal edges in a droplet. Refer to Figure 2.15. 

Figure 2.15  Sort Guard Band

The default Sort Guard Band setting is 15%. You can set the Sort Guard Band to 25% by selecting Sort 
Guard Band Setting from the Advanced menu. 

25%

25%

15%

15%1

2

3
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The sort decision with the 25% Sort Guard Band applied are illustrated in Figure 2.16. The stream is 
represented by the gray dots flowing down the figure with either the target population (red) or the 
contaminant population (blue) located within the droplet. Droplets are either sorted (black box) or 
aborted depending on the sort mode chosen. The sort modes are demonstrated from left to right: 
Single Mode, Purity Mode, Purity1-2 Mode, and Enrich Mode.

Figure 2.16  Sort Decision with Different Modes Applied (Sort Guard Band 25%)

Sort Stream Precedence

IMPORTANT When setting up a sort, place the most precious and/or rare events in the outer streams (L2/
R2) for maximum purity. However, it is better to use the inner streams (L1/R1) for sorting macro-particles 
(≥15 μm).

During a sort, an analyzed cell may meet the sort logic for more than one stream. The sort logic has 
two precedence settings: Sort Mode and Stream Precedence. When multiple populations are being 
sorted simultaneously (especially at high speeds), users should choose the proper Sort Mode and 
Sort Stream location. Ineffective precedence decisions may affect the recovery of the desired 
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population. The sort mode precedence is as follows: Single > Purify > Enrich. The Stream Precedence 
is from outside to inside streams (L2>R2>L1>R1). 

Adding a Sort Mode

1 Select Sort Mode Library from the Advanced menu. The Sort Mode Library window appears.

NOTE The Sort Mode Library is editable only when the experiment has been closed.

2 Select Add from the Sort Mode Library window.



C37808AC   2-53

Using the CytExpert SRT Software
Sort Mode Library  2

A new sort mode is added in the Sort Mode Library.

NOTE Enter a name for this new sort mode.

3 Select the desired Sort Precision Level from the dropdown menu.
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4 Select the desired Drop Envelope from the dropdown menu.

5 Select OK.

The SortMode1 is added in the Sort Mode Library. To apply this new sort mode, refer to Setting 
Up Tube Sorting or Setting Up Plate/Slide Sorting in CHAPTER 5, Sorting.
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Deleting a Sort Mode
IMPORTANT The system default sort modes that are in bold cannot be deleted.

1 Select Sort Mode Library from the Advanced menu. The Sort Mode Library window appears.
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2 Select a sort mode to be deleted, and select Delete.
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Software Settings

Select Options in the Settings menu to configure the software settings.
In the experiment settings, you can set the experiment’s default save path.
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In the tube settings, you can select the columns that display in the tube section of the screen.
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In the plot settings, you can define the background of the graphics display area, configure the 
histograms, and set the default signal parameters to either the channel’s area or the channel’s 
height. The default is area. You can also set the default axis display range. 
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In the Gate settings, you can choose to display population percentage on all plots except overlay.

NOTE  Show as rare events is to increase the visibility of the gated population anywhere they appear on 
the plots. Rare event display factor is to set the degree to which the rare event size is increased on the 
plots.
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In the Page Setup settings, you can change the page size, orientation, margin size, and display 
options. Select Show page breaks to display page boundaries within the Acquisition or Analysis 
views for simplifying plot arrangement for printing.
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In the Bubble Detect settings, you can enable/disable the Bubble Detector function. 

IMPORTANT Only use the Bypass Bubble Detector for the colored or turbid samples. 

The bubble detector is sensitive to light scattering and attenuation. When running colored or turbid 
samples, or sample with high concentration, the error 090025 is likely to occur. If this occurs, select 
Bypass Bubble Detector.
NOTE  If the Bypass function is enabled, the system will not alert you when the sample runs empty. 
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In the Record settings, you can set the default record count.

Language Settings
Select Settings > Language Settings to open the Language Settings window. In the Language 
Settings window, you can select which language to use for the software menus and graphical 
statistics. The two options currently offered are English and Simplified Chinese.
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Daily Startup

Overview

IMPORTANT Verify that the correct USB configuration key is securely connected to a computer USB port. If 
the USB configuration key is not connected, the following error message appears: CytExpert cannot find 
the license. Please check whether the correct USB configuration key has been plugged in.

This chapter describes the instrument startup procedure.
Workflow:

This chapter contains information on:
 • Pre-Startup Inspection
 • Turning On the Instrument
 • Logging Into the Software
 • System Startup Program
 • Selecting Experiments from the Start Page

Pre-Startup Inspection

Before using the CytoFLEX SRT instrument, perform the following system checks.

System Connections Inspection

1 Verify that the power cable of the computer is securely connected to the power source.

2 Check that the monitor, mouse, keyboard, and the Sorter USB cable are properly connected to 
the computer. Refer to Figure 1.34.

Pre-startup 
inspection Ô Turn on power Ô Open software Ô

System Startup 
Program
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3 Verify that all sheath fluid tubing, waste fluid tubing, shutdown fluid tubing, and the sensor 
cable from the fluidics cart are properly connected to the Sorter. Refer to Figure 1.11.

4 Verify that the power cable located below the power switch on the lower left side of the Sorter, 
and verify it is securely connected to both the Sorter and the power source. Refer to Figure 3.1.

Figure 3.1  Power Cable

5 Check the Ethernet cable located above the power switch on the lower left side of the Sorter, 
and verify it is securely connected to the workstation. Refer to Figure 1.34.

Checking Fluid Levels

1 Examine the sheath tank, waste container, and the shutdown fluid container. Refer to 
Figure 1.4. Verify that there is sufficient fluid in the sheath tank and shutdown fluid container, 
and the waste container is empty. 
NOTE You can view the fluidics status information from the fluidic status bar on the CytExpert SRT 

software if the software has been started. 
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CAUTION
Risk of instrument damage. Fluid spills in the fluidics cart can damage the 
instrument electronics. Remove the sheath tank from the fluidics cart before 
filling the sheath tank to avoid damage to instrument electronics. 

2 If necessary, fill the sheath fluid tank while not exceeding the upper position ring. Refer to 
Filling the Sheath Tank in CHAPTER 11, Replacement/Adjustment Procedures.

3 If necessary, fill the shutdown fluid container with CytoFLEX SRT Shutdown fluid while not 
exceeding the bottom of the neck. Refer to Filling the Shutdown Fluid Container in 
CHAPTER 11, Replacement/Adjustment Procedures.

WARNING
Risk of chemical injury from bleach. To avoid contact with the bleach, use barrier 
protection, including protective eyewear, gloves, and suitable laboratory attire. 
Refer to the Safety Data Sheet for details about chemical exposure before using 
the chemical.

4 If necessary, empty all waste liquid from the waste container. If biohazardous samples are used 
for data collection, add 400 mL high-quality, fragrance-free, gel-free bleach (5 to 6% solution of 
sodium hypochlorite - available chlorine) to the waste container. Refer to Emptying the Waste 
Container in CHAPTER 11, Replacement/Adjustment Procedures.

5 Verify that all sheath fluid tubing, waste fluid tubing, shutdown fluid tubing, and sensor cables 
are properly connected on the fluidics cart. Refer to Figure 1.6.

Turning On the Instrument

IMPORTANT For users who have the optional Biosafety Cabinet, the Biosafety Cabinet must be turned on 
first (manually) or left on from the previous day for the instrument to be ready to run right away. 
Otherwise, allow at least 30 minutes for the system to reach thermal equilibrium.

1 Optional: Turn on the Biosafety Cabinet (if part of the system).

2 Turn on the main power switch located on the lower left side of the Sorter.
NOTE Or select Turn on from the Cytometer menu to remote power on the Sorter if the software has 

been open.
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3 Wait for the Sorter to finish powering on, then turn on the Workstation.

Logging Into the Software

1 Log into the Windows operating system and double-click the CytExpert SRT desktop icon 

 to open the software. 
If you are running the CytExpert Default software installation, login is not required. Proceed to 
Step 4.
If you are running the CytExpert User Management software installation, the login window 
appears.

NOTE The default software shortcut appears on the desktop. If you do not see the icon, the default 
installation path is under C:/Program Files/CytExpert SRT. Double-click CytExpert SRT.exe to run the 
software.

2 Enter your username and password.

3 Select .
NOTE The full name of the user that is currently logged in displays in the top right corner of the software 

screen.
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4 Confirm that the software and the Sorter are properly connected.
a. Open the software. The Startup screen appears.
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b. Verify that the connection indicator light in the lower left corner of the software screen is 
green, and Connected is displayed. The left side shows the connection status, the middle 
shows the instrument status, and the right side shows the status details.

NOTE
 • A red connection indicator light indicates that there is a faulty connection. Ensure that the 

instrument is properly turned on and connected. If necessary, restart both the Sorter and 
the Workstation.

 • Select the status information in the lower left to open the system log. Send a copy of the 
system log to your Beckman Coulter Representative for support if a service call is 
requested.

c. Verify that the Sheath, Waste and Shutdown flow indicators in the lower right corner of the 
software screen are green indicating that the fluidics system is normal. 

NOTE When the flow indicator is yellow or red, the fluid containers need your attention.
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IMPORTANT Ensure that the sheath tank you used matches with the sheath tank type you selected. 
Otherwise, you could encounter System Startup failure, Aseptic Cleaning failure, Long-term Shutdown 
failure, or sheath flow indication error.

5 Verify that the sheath tank you used matches with the sheath tank type you selected. Select 
Sheath Tank Scale Reset from the Advanced menu to display the current sheath tank type. 

Table 3.1  Sheath Status

Normal

Insufficient

 (with audible warning)
Empty

 (with audible warning) Overfilling

The value in the symbol indicates the remaining time that the sheath can sustain.

NOTE When the sheath flow indicator displays “empty”, refill the sheath tank as soon. Otherwise, the 
system stops the fluid and goes into standby automatically. Refer to Filling the Sheath Tank in 
CHAPTER 11, Replacement/Adjustment Procedures.

NOTE When the sheath flow indicator displays “full”, pour the excessive sheath and ensure that the 
sheath level is lower than the position ring (refer to step 6) inside the sheath tank. 

Table 3.2  Waste Status

Waste volume< 25%

25% ≤ Waste volume ≤ 50%

50% ≤ Waste volume ≤ 75%

 (with audible warning) Waste volume ≥ 75%

 (with audible warning)
Approaching full 

NOTE When the waste flow indicator is yellow, empty the waste container as soon. Otherwise, system 
stops the fluid and goes into standby immediately when the waste flow indicator turns red. Refer to 
Emptying the Waste Container in CHAPTER 11, Replacement/Adjustment Procedures.

Table 3.3  Shutdown Fluid Status

Normal

Empty

NOTE When the shutdown flow indicator is red, refill the shutdown fluid container. Refer to Filling the 
Shutdown Fluid Container in CHAPTER 11, Replacement/Adjustment Procedures.



C37808AC   3-8

Daily Startup
System Startup Program  

System Startup Program

The System Startup Program is required every time when you turn on the instrument. The System 
Startup Program allows the system to pressurize the sheath tank, check fluidic system, debubble, 
stabilize the pressure, and clean sample probe. The program takes 10–15 minutes depending on the 
sheath tank type you used.
IMPORTANT Ensure that the sheath tank you used matches with the sheath tank type you selected. 

Otherwise, you could encounter startup failure, aseptic cleaning failure, long-term shutdown failure, or 
sheath flow indication error.

Restarting after the Daily Shutdown (CytoFLEX SRT Shutdown Fluid in the Instrument)

1 Select  or System Startup in the Cytometer menu.

The System Startup window appears.
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2 Open the sort chamber sliding door and the sort protection door. 

3 Clean the bottom of the flow cell, the sliding rails for the nozzle lift, and the V-plate surface. For 
instructions, refer to Daily Decontamination During Shutdown in CHAPTER 10, Cleaning 
Procedures.

IMPORTANT A wet or clogged nozzle might cause the fluid stream off center or even no stream.

4 Verify that the nozzle is clean and dry. If necessary, clean the nozzle. For instructions, refer to 
Cleaning the Nozzle in CHAPTER 10, Cleaning Procedures.
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5 Insert the nozzle module carefully into Sorter with the UP symbol facing up. The nozzle module 
is locked into its position when you hear a click.

6 Close the sort protection door, the sort chamber sliding door, and the sample station door.
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7 Select Next. 
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The system starts running Startup Program.

NOTE Select Hide to hide the System Startup window.
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The Confirm window displays when the System Startup Program is finished, 

NOTE Select Yes to start QC now. For instructions on running QC, refer to CHAPTER 4, Instrument 
Quality Control and Standardization.
Or select No to defer the QC. 

8 Select Close to quit the System Startup program. The system is now ready for use.
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Restarting after the Long-Term Shutdown (70% Ethanol in the Instrument)

1 Select  or System Startup in the Cytometer menu.

The following message appears.

IMPORTANT Ensure the sheath is sterile.

2 Empty the sheath tank and refill the sheath tank with at least 1.5 L sheath. Refer to Filling the 
Sheath Tank in CHAPTER 11, Replacement/Adjustment Procedures.

3 Empty the waste container. Refer to Emptying the Waste Container in CHAPTER 11, 
Replacement/Adjustment Procedures.
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4 Select Next. The system starts to rinse the sheath line with sheath.

The following message appears when the system finishes the perfusion.

5 Switch the aseptic cleaning filter with the sheath fluid filter. Refer to Replacing the Aseptic 
Cleaning Solution Filter in CHAPTER 11, Replacement/Adjustment Procedures.
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6 Select Next. 

7 Open the sort chamber sliding door and the sort protection door. 
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8 Insert the nozzle module carefully into Sorter with the UP symbol facing up. The nozzle module 
is locked into its position when you hear a click.

9 Close the sort protection door, the sort chamber sliding door, and the sample station door.

10 Select Next. The system starts running Startup Program. 

NOTE Select Hide to hide the System Startup window.
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The Confirm window displays when the System Startup Program is finished, 

NOTE Select Yes to start QC now. For instructions on running QC, refer to CHAPTER 4, Instrument 
Quality Control and Standardization.
Or select No to defer the QC. 

11 Select Close to quit the System Startup program. The system is now ready for use.

12 Optional: Sample DI water at 10 μL/min for 1 hour. This is to remove the tiny air bubbles which 
might be introduced in the Long-term Shutdown program. 
NOTE For more instructions on removing air bubbles, refer to Removing Trapped Air Bubbles in 

CHAPTER 11, Replacement/Adjustment Procedures.

Selecting Experiments from the Start Page

Refer to Start Page in CHAPTER 2, Using the CytExpert SRT Software.
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CHAPTER 4
Instrument Quality Control and

Standardization

Overview

This chapter provides information on performing daily Quality Control (QC) on the CytoFLEX SRT 
Sorter and how to confirm that the instrument is working properly within the specified 
parameters. Quality Control allows you to determine whether your instrument can provide 
adequate signal strength and precision.
This chapter also provides information on performing standardization. CytoFLEX Daily QC 
Fluorospheres, CytoFLEX Ready to Use Daily QC Fluorospheres, or any other reference material that 
is relevant for your application may be used as the standardization sample. The system can only 
recognize a single peak. 
Standardization can be used to monitor the Median Fluorescent Intensities (MFI), or target values 
for scatter and fluorescent parameters that have been defined and optimized for a specific 
application. All channels in the current configuration, those with/without an assigned QC target, 
can be tracked as necessary via Standardization since this portion of the CytExpert SRT Software is 
used to assess application specific settings. Standardization, however, does NOT replace QC as the 
Sorter's optical alignment (rCV statistical analysis), Laser Power and Laser Delay outputs are not 
measured during the run. 
NOTE Beckman Coulter recommends performing QC prior to performing Sort Calibration on a daily basis or 

after using a new nozzle.

NOTE QC target values apply exclusively to standard channels. A channel is a laser-filter combination. Refer 
to Verifying, Selecting, Editing, and Creating Detector Configuration in CHAPTER 5, Sorting to verify that 
the default factory detector configuration is selected before running QC.

NOTE CytExpert SRT QC includes an automated QC routine with Levey-Jennings (LJ) charts tracking and 
logging.

NOTE CytExpert SRT Standardization allows for application-specific settings to be established and applied to 
future experiments.

NOTE Perform QC on the same day prior to performing the CytExpert SRT standardization. 

QC Workflow:

Prepare the QC 
sample Ô

Enter the QC 
experiment Ô

Select QC 
target values Ô Acquire data Ô Confirm results



C37808AC   4-2

Instrument Quality Control and Standardization
Quality Control  

Standardization Workflow:

This chapter contains information on:
 • Quality Control

— Preparing the QC Sample
— Importing Lot-Specific Target Values
— Collecting QC Data
— Confirming Results

 • Standardization
— Preparing the Standardization Sample
— Generating Target Median Values
— Adding a New Standardization Item
— Performing the Standardization
— Applying the Standardized Acquisition Settings
— Standardization Target Library

Quality Control

The QC process verifies important system functions. The system:
1. Verifies that the unit hardware configuration matches the default configuration specified in 

the software. Refer to Verifying, Selecting, Editing, and Creating Detector Configuration in 
CHAPTER 5, Sorting. 

2. Measures the laser power of each individual laser and ensures that each laser meets the system 
specifications.

3. Loads the QC sample and begins to acquire data.
4. Verifies that the actual laser delays match those set in the software and will adjust the delay 

accordingly.
5. If laser delay is ≤ 2 μs from the previous setting, the software automatically changes the laser 

delay setting.
OR
Notifies you if laser delay is within 2 μs -5 μs from the previous setting. The software prompts 
you to confirm the laser delay setting.
OR

Obtain target 
acquisition 

settings
Ô

Run 
standardization 

sample
Ô

Perform 
standardization Ô

Apply standardization 
settings 
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Notifies you if laser delay is > 5 μs from the previous setting. Manual laser delay adjustments 
are required. Refer to Setting Laser Delay in CHAPTER 11, Replacement/Adjustment 
Procedures.

6. Verifies and calibrates the gain settings. If any of these parameters are outside of the operating 
limits, the system automatically adjusts these parameters. If the system is unable to adjust 
these parameters to fall within the operating limits, the system notifies you.

7. Optimize the fluid stream and verify whether the jitter of T1 signal is acceptable. Then 
determine the DD1 value.

Preparing the QC Sample

Required Materials
The following materials are required to complete the QC process:
 • CytoFLEX Daily QC Fluorospheres or CytoFLEX Ready to Use Daily QC Fluorospheres
 • IsoFlow Sheath Fluid or another saline sheath fluid
 • Sample tubes (12 x 75 mm)
 • Vortexer

CytoFLEX Daily QC Fluorospheres Preparation Process

IMPORTANT For preparation instructions for the CytoFLEX Ready to Use Daily QC Fluorospheres, refer to 
CytoFLEX Ready to Use Daily QC Fluorospheres Preparation Process.

1 Take one sample tube and label it as the QC sample tube.

2 Add approximately 1 mL of deionized water to the sample tube.

3 Use the Vortexer or shake vigorously to thoroughly mix the bottle of CytoFLEX Daily QC 
Fluorospheres.

4 Add three drops of CytoFLEX Daily QC Fluorospheres to the sample tube.

5 Vortex the sample tube to uniformly suspend the fluorospheres. 
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6 Place the sample tube in a dark location at 2-8 C until ready to load the tube into the 
instrument for QC.
NOTE Tubes containing diluted CytoFLEX Daily QC Fluorospheres should be sealed and stored in a dark 

location at 2-8 C for up to 5 days.

CytoFLEX Ready to Use Daily QC Fluorospheres Preparation Process

IMPORTANT For preparation instructions for the CytoFLEX Daily QC Fluorospheres, refer to CytoFLEX Daily 
QC Fluorospheres Preparation Process.

1 Take one sample tube and label it as the QC sample tube.

2 Use the Vortexer or shake vigorously to thoroughly mix the bottle of CytoFLEX Ready to Use 
Daily QC Fluorospheres.

3 Add 10 drops of CytoFLEX Ready to Use Daily QC Fluorospheres to the sample tube.

4 Vortex the sample tube to uniformly suspend the fluorospheres. 

5 Place the sample tube in a dark location at 2-8 C until ready to load the tube into the 
instrument for QC.
NOTE Tubes containing CytoFLEX Ready to Use Daily QC Fluorospheres should be sealed and stored in 

a dark location at 2-8 C for up to 5 days.

Importing Lot-Specific Target Values
Import lot-specific target values for each new lot of CytoFLEX Daily QC Fluorospheres, CytoFLEX 
Ready to Use Daily QC Fluorospheres.

CAUTION
Risk of erroneous QC results. Different target value information corresponds to 
different lot numbers. Selecting the wrong lot number will lead to erroneous QC 
results.

1 Open the CytExpert QC screen.
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2 Select Target Library from the Settings menu. The Target Library window appears. 

IMPORTANT The Beckman Coulter website may prompt you to select your Region and Country prior to the 
Beckman Coulter Technical Documents and Software page.

3 Select Download Target File. The Beckman Coulter Software Downloads page appears.

NOTE If your CytoFLEX SRT Workstation does not have access to the internet, navigate to https://
www.beckmancoulter.com/wsrportal/page/softwareDownloadSearch using a computer with access 
to the internet and save the file to a USB drive. If the website is not accessible, contact us.

4 If necessary, register and log in to the Beckman Coulter website.

https://www.beckmancoulter.com/wsrportal/page/softwareDownloadSearch
https://www.beckmancoulter.com/wsrportal/page/softwareDownloadSearch
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5 In the Search By Product section of the screen, select the following:
a. Select Research & Discovery from the Market Segment drop-down menu.
b. Select Flow Cytometry from the Product Line drop-down menu.
c. Select Instruments from the Product Platform drop-down menu.
d. Select CytoFLEX from the Product drop-down menu.
e. Select CytoFLEX QC Fluorospheres Target Values or CytoFLEX Ready to Use QC Fluorospheres 

Target Values from the Software Name drop-down menu.
f. Select All from the Lot Number drop-down menu.
g. Select English from the Language drop-down menu.

[CytoFLEX QC Fluorospheres Target]

[CytoFLEX Ready to Use Daily QC Fluorospheres Target]

6 Select Search.

7 The search results appear below the Search By Lot Number tab.
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[CytoFLEX QC Fluorospheres Target]

[CytoFLEX Ready to Use Daily QC Fluorospheres Target]
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8 Select CytoFLEX QC Fluorospheres Target Values under the Software Name column. The 
CytoFLEX QC Fluorospheres Target Values page appears.

9 Select Download under the correct lot number from the CytoFLEX QC Fluorospheres Target 
Values page. 

10 If the File Download pop up window appears, select Save and browse to the desired file path.
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11 Select Import from the Target Library window in the CytExpert SRT software.

12 Navigate to the file saved in step 10 and select Open.

13 Select Close to exit the Target Library window.
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Collecting QC Data
QC data and reports are saved by default. Select QC/Standardization Setting in the Settings menu to 
change the default save settings or modify the file path these files are saved to.

1 Double-click  to start the CytExpert SRT software.
a. Ensure that the Connected icon on the Status Bar near the bottom-left side of the display is 

green.

b. If the icon is not green, ensure that the Sorter USB is securely connected to the Workstation 
and restart the Workstation.

2 Verify the detector configuration. Refer to Verifying, Selecting, Editing, and Creating Detector 
Configuration in CHAPTER 5, Sorting.
NOTE Ensure that the instrument configuration is properly configured for the QC experiment. The QC 

experiment may not be completed or may end in erroneous results if incorrect settings are chosen. 
Beckman Coulter recommends using the factory configuration and ensuring that the proper optical 
filters are in place.

3 Verify the laser settings. Refer to Laser Settings in CHAPTER 5, Sorting.

4 Select Initialize to put the instrument in the initialized state.
NOTE Skip this step if the instrument has already been in the initialized state.
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5 Select Start QC/Standardization in the QC/Standardization menu to access the QC experiment. 

Ensure that the QC bead lot number is selectable in the Lot No. drop-down menu. If the lot 
number is not selectable, refer to Importing Lot-Specific Target Values, then select the proper 
lot number.

6 Insert the prepared QC sample tube (refer to CytoFLEX Daily QC Fluorospheres Preparation 
Process or CytoFLEX Ready to Use Daily QC Fluorospheres Preparation Process) into the tube 
holder.

7 Select Start to load the sample and begin to run the QC procedure.
Completed processes appear on the left. Plots appear on the right. The QC experiment 
sequentially detects the system configuration, laser power, laser delay, signal strength, 
coefficient of variation, and Drop Delay 1.
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During QC, the software automatically seeks the CytoFLEX QC Fluorospheres and computes the 
results. The software returns to the QC Report screen after the QC run is complete. 

8 If the sampling rate is too low, the Sorter stops the QC run and displays a prompt alerting you 
that the QC run failed to reach the required event flow rate. This is not considered a QC failure. 
If this situation occurs, increase the sample concentration by adding one drop of CytoFLEX 
Daily QC Fluorospheres to the sample tube or prepare a new tube of CytoFLEX Ready to Use 
Daily QC Fluorospheres, and then perform the QC.
NOTE Mix the fluorospheres dropper bottle thoroughly before dispensing it into a sample tube.

9 If the lot number of CytoFLEX QC Fluorospheres is new and QC fails, the following software 
message appears. Select Yes. 

NOTE Target gain values must be established for each new lot number of CytoFLEX QC Fluorospheres. 
QC could fail up to 3 times upon running each new lot number for the first time until target gain 
values are established.

If the lot number of CytoFLEX QC Fluorospheres is NOT new and QC fails, refer to Step 3 of 
Confirming Results, or CHAPTER 9, Troubleshooting.
If QC passes, proceed to Step 10.
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10 Select Yes to start Sort Calibration now. Refer to Sort Calibration (Auto Drop Delay) in 
CHAPTER 5, Sorting.
Or
Select No to defer the Sort Calibration.
NOTE Sort calibration is required prior to the sorting. For analysis experiments, skip the Sort Calibration.

Confirming Results
Select Start QC/Standardization in the QC/Standardization menu to return to the QC Setting screen 
at any time to review completed experiment results.

1 Select the desired default configuration and date range from the drop-down menus located on 
the left side of the QC screen to sort by the configuration used during the specified date range.

NOTE At least one date range must be specified.
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2 Select a QC run from the QC Process list on the left and a QC report appears on the right.

NOTE The results column indicates a passing QC result with a  and a failed QC result with . 
QC results must meet the following criteria to pass:
 • DD1 must be within the range of 720 - 880 μs. 
 • DD laser must be within the range of 90 - 110 mW.
 • The delay differences must be 5 μs. 
 • The gain differences must be 20% from the target gain. 
 • The median fluorescence intensity (MFI) differences must be 5% from the target MFI.
 • The rCV must be within the range.
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The report area on the right displays detailed experiment results, including laser power, delay, 
testing conditions, and signal results. The same  and  symbols are used to indicate each 
result. For items that fail, values falling outside the prescribed range are displayed in red font. 
In the Comment area, an explanation appears for each failed item.

3 If QC fails, follow the procedure below:
a. Verify whether the beads used were within their shelf life and stored in accordance with 

the appropriate instruction manual.
b. Verify whether the allocated sample tube was prepared as required and correctly 

positioned.
c. Verify whether the detector configuration selected for QC matches with the current 

detector configuration. Refer to Verifying, Selecting, Editing, and Creating Detector 
Configuration in CHAPTER 5, Sorting.

d. Run Performing the Flow Cell De-bubble in CHAPTER 11, Replacement/Adjustment 
Procedures, and retest.
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e. Run Performing the Sheath Filter De-bubble in CHAPTER 11, Replacement/Adjustment 
Procedures, and retest.

f. Run Backflush. Select Cytometer > Backflush, and retest.
g. Verify whether the Nozzle is clean and installed properly. Refer to Cleaning the Nozzle in 

CHAPTER 10, Cleaning Procedures, and retest.
h. Run Removing Trapped Air Bubbles in CHAPTER 11, Replacement/Adjustment Procedures, 

and retest.
i. Restart the system, and retest.

NOTE If QC fails after repeating Steps a-i, contact us.

4 If necessary, you can select  (for CSV format) or  (for PDF format) in the top left corner 
of the report area to export the QC results.

5 Select Close QC/Standardization in the QC/Standardization menu to exit the QC screen.

Creating Levey-Jennings Charts

1 Select Start QC/Standardization in the QC/Standardization menu to open the QC screen.

2 Select LJ chart  on the left side of the screen.
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IMPORTANT When there are multiple lots, select which lot to create the LJ charts from.

3 Select LJ Chart Settings  on the top of the LJ Chart screen. The LJ Chart Settings screen 
appears. 
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4 Select the Laser tab, and select the power and/or delay checkboxes for each laser as needed.
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5 Select the Channel tab, and select each channel checkbox as needed.

6 Select Apply.

7 Select OK.
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8 Select the Levey-Jennings plot and select the start and end date from the drop-down boxes at 
the top of the LJ Chart screen to specify the desired date range.

NOTE Select the desired configuration and date range from the drop-down menus located at the top of 
the LJ Chart screen to sort by the configuration used during the specified date range.

9 Select Close QC/Standardization in the QC/Standardization menu to exit the QC screen.

QC Result Manager
The QC Result Management window can be used to search, delete, print, and export QC results.
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To access the QC Result Manager, right-click the desired QC result and select Result Manager in the 
QC screen. The QC Result Manager window appears.

Standardization

Ensure that the standardization sample has been run at optimized experiment settings to 
determine the standardization sample threshold setting as well as median values for all relevant 
channels.

Preparing the Standardization Sample
Use Beckman Coulter CytoFLEX Daily QC fluorospheres or CytoFLEX Ready to Use Daily QC 
Fluorospheres or any other reference material that is relevant for your application. 
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Required Materials
The following materials are required to complete the QC process:
 • CytoFLEX Daily QC Fluorospheres or CytoFLEX Ready to Use Daily QC Fluorospheres, or other 

material applicable for your application
 • IsoFlow or ISOTON II sheath
 • Sample tubes (12 x 75 mm).
 • Vortexer

Preparation Process
For procedures, refer to CytoFLEX Daily QC Fluorospheres Preparation Process or CytoFLEX Ready 
to Use Daily QC Fluorospheres Preparation Process.

Generating Target Median Values

1 Double-click  to start the CytExpert SRT software.
a. Ensure that the Connected icon on the Status Bar near the bottom-left side of the display is 

green.

b. If the icon is not green, ensure that the Sorter USB is securely connected to the Workstation 
and restart the Workstation.

2 Select Open Experiment to open an experiment with the desired acquisition settings to 
standardize. 
NOTE Ensure the Gain and Threshold settings are optimal. Refer to Adjusting the Gain and Adjusting the 

Threshold in CHAPTER 5, Sorting.

3 Right-click the tube and select Duplicate without Data to create a tube with the same acquisition 
settings.
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4 Change the tube name. Refer to Changing the Tube Name in CHAPTER 5, Sorting. 

5 Select Save As from the File menu to save the experiment.

6 Select  to delete all the remaining tubes.
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7 Select . The Compensation Matrix window appears.

8 Select Clear to clear the compensation matrix. The message Are you sure you want to clear the 
compensation matrix? appears. Select Yes.

9 Load the sample tube.
NOTE The sample tube holder only accommodates 12 x 75 mm sample tubes.

10 Select Run.
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11 View the plots and establish the gates. Refer to Creating Plots and Gates in CHAPTER 5, Sorting. 
NOTE Use the FSC channel as the trigger channel and select Automatic threshold. 

NOTE The threshold may need to be adjusted to visualize the QC beads populations. If so, record this 
value for future reference. 

12 Select the Statistics tab.
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13 Right-click the table and select Statistics Settings. The Statistics Setting window appears. 
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14 Select the Population tab and select the relevant population for the tube.
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15 Select the Statistics tab then select the Median Fluorescence value for all parameters used.

NOTE The median values are the target settings that will be used for standardization.

16 Select Stop.

17 Right-click the statistics table and select Export to CSV file.
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If Excel is not available, manually record all the median values or take a screen shot. 

18 Save the experiment.
NOTE Rerun the experiment if:

 • You change the standardization fluorosphere used.
 • The Lot number for the standardization fluorosphere is changed.

Adding a New Standardization Item

1 Select Start QC/Standardization in the QC/Standardization menu to access the Standardization 
screen.
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2 Select Standardization Target Library from the Settings menu.
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3 Select . The Add Standardization Target Value window appears.

4 Enter the Item, Lot No., and Expire date from the dropdowns located at the top of the Add 
Standardization Target Value window.
NOTE A single Lot No. can include several Items, but you cannot add duplicate Items under the same 

Lot No..

NOTE If the Lot No. selected already exists, the Expire date cannot be edited.

5 Select either Manual or Automatic threshold from the Standardization Test Setting or 
Acquisition Setting section of the window.
NOTE If you select Manual threshold, enter a value greater than 0, but less than 8,388,600.

NOTE Keep the threshold setting the same as previous Step 11 in Generating Target Median Values.

NOTE Unchecking the Use the same threshold setting for acquisition setting checkbox allows you to 
specify custom threshold settings.
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6 Set the channels to be standardized.
NOTE The contents of the channel, laser, and filter column come from the current detector configuration 

setting. Refer to Verifying, Selecting, Editing, and Creating Detector Configuration in CHAPTER 5, 
Sorting.

NOTE Do not set the median tolerance range any lower than 5%.

NOTE FSC is a required channel.

7 Enter the target median values saved in Step 15 into the corresponding channels.

Or copy the median values from the previously exported CSV file and paste into the 
corresponding median column.
NOTE Verify that the target values are entered correctly.
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8 Select OK to save the target value.
The saved results display in the Standardization Target Library window. This item is ready to 
be run through the Standardization experiment. Refer to Performing the Standardization in 
CHAPTER 4, Instrument Quality Control and Standardization.

9 Select  to exit the Standardization Target Library window.

Performing the Standardization

1 Select Start QC/Standardization in the QC/Standardization menu to access the Standardization 
screen.
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2 Select the Standardization radio button.

3 Select the correct Lot No. from the Lot No. dropdown.

NOTE Ensure the Lot No. corresponds to the standardization sample that generated the target median 
values.

4 Select the Items to be standardized.
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5 Select the proper detector configuration. Refer to Verifying, Selecting, Editing, and Creating 
Detector Configuration in CHAPTER 5, Sorting.

6 Select .
The Process section of the screen displays the process details.

Once the process is complete, the Standardization Report displays.

NOTE The updated Standardization item is added to the Acquisition Catalog automatically and 
overwrites the previously existing standardized settings for this item.
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7 Select Acq. Setting Catalog from the Cytometer menu to verify the gain settings. The Acq. 
Setting Catalog window appears.

NOTE  designates test items from Standardization.

8 Run Daily Clean. Refer to Daily Clean Program in CHAPTER 10, Cleaning Procedures. 

9 Select Close QC/Standardization. 

Applying the Standardized Acquisition Settings

1 Open an experiment.
NOTE The corresponding compensation matrix should have been determined as the optimal settings. 

Refer to CHAPTER 6, Compensation for detailed instructions on setting compensation. 
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2 Select Acq.Setting from the Cytometer menu. The Acq. Setting window appears.

3 Select Import from Catalog. The Acq. Setting Catalog window appears.
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4 Browse for the item to import and select Import. 
The standardized settings are applied to the sample tube.

The Information window appears to notify of the corresponding channels with the changed 
gain as a result of the Standardization. 
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5 Select OK.

Standardization Target Library
Select Standardization Target Library... from the Settings menu. The standardization Target Library 
window appears.

NOTE The Item name displays in the Acquisition Setting Catalog window as the saved acquisition setting 
name.

Importing a Standardization Item

1 Select  on the Standardization Target Library window.

2 Browse for the Item to import and select .
The imported item displays at the top of the list in the Standardization Target Library window.
NOTE If the standardization item is existing in the target library, the importing will overwrite the existing 

item. The system will prompt to ask you to confirm.



C37808AC   4-40

Instrument Quality Control and Standardization
Standardization  

3 Select  to exit the Standardization Target Library window.

Exporting a Standardization Item

1 Browse for the Item to export.
The available items display on the left panel of the Standardization Target Library window.

2 Select  on the Standardization Target Library window.

3 Navigate to the desired file path and select Save.
NOTE The standardization items save as .stgt file. This file can be used to standardize the settings 

between different instruments with the same laser and optical filter configuration.

4 Select  to exit the Standardization Target Library window.

Editing Standardization Item Parameters

1 Select an item from the Item column on the Standardization Target Library window and select 
.

2 Edit the parameters for that item and select OK.
NOTE Task Item, Lot No., and Expire date cannot be edited.

3 Ensure the item parameters are correct then select  and save the file.

4 Select  to exit the Standardization Target Library window.

Duplicating Standardization Items

1 Select an existing item from the Item column on the Standardization Target Library window 
and select .
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2 Edit Item, Lot No., Expire date and the parameters for that item and select OK.
NOTE Perform a new standardization if the Lot No. of standardization sample is changed.

3 Ensure the item parameters are correct then select  and save the file.

4 Select  to exit the Standardization Target Library window.

Deleting Standardization Items

1 Select an item from the Item column on the Standardization Target Library window.

2 Select . The confirm message The target values will be permanently deleted. Are you 
sure? displays. Select Yes to confirm.

3 Select  to exit the Standardization Target Library window.



C37808AC   5-1

CHAPTER 5
Sorting

Overview

This chapter contains information on how to use your CytoFLEX SRT instrument to perform an 
acquisition or sorting experiment.
Workflow:

This chapter contains information on:
 • Sort Calibration (Auto Drop Delay) 
 • Setting Drop Delay Manually (Optional) 
 • Creating an Experiment 
 • Configuring Acquisition Settings
 • Load Sample and Record Data
 • Sorting

— Setting Up Tube Sorting
— Setting Up Plate/Slide Sorting
— Stop Criteria for Sorting
— Calibrating the Sort Collection Device
— Manual Side Stream Calibration (Optional)
— Adjusting Tube Position (Optional)
— Starting and Monitoring a Sort
— Pause Sorting and Resume Sorting
— Index Sorting
— Sort Report
— Additional Information for Aseptic Sorting

 • Exporting Data
 • Saving the Experiment

Sort 
calibration Ô

Create 
experiment Ô

Load 
sample Ô

Acquisition 
and sorting Ô

Save 
experiment
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Sort Calibration (Auto Drop Delay)

IMPORTANT Beckman Coulter recommends performing the sort calibration immediately after passing QC 
for better sorting performance. For analysis experiments, skip the Sort Calibration.

IMPORTANT Sort calibration is mandatory after reinstalling a nozzle or replacing a new nozzle. Beckman 
Coulter recommends re-running the sort calibration to ensure the auto drop delay is accurate if the 
system enters standby state during a sorting.

Sort Calibration allows the system to achieve an optimal droplet break-off point, optimal side 
stream settings, and generate the drop delay value automatically (auto drop delay). Effective 
sorting is highly dependent on the appropriate drop delay. For detailed explanations about drop 
delay, refer to Operation Principles in CHAPTER 1, System Overview. 
The whole Sort Calibration process takes about 10 minutes.

1 Select Initialize to turn on the sheath flow.

2 Select Sort Calibration in the Sorting menu. The Sort Calibration window appears.

NOTE Auto start maintain is selected by default. To view the status of Auto maintain during a sort, 
select Sorter Status from the CytExpert status bar.

NOTE Manual Droplet Calibration is used to scan the Frequency and Amplitude parameters manually 
during the Droplet Calibration. Refer to Step 4.
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IMPORTANT The system is sensitive to airflow interference. Ensure that the sort protection door and the 
sort chamber sliding door are always closed during the sort calibration.

3 Select Start to begin the Sort Calibration procedure.
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a. The system automatically scans the frequency and amplitude to form an optimal droplet. 
The dynamic stream appears on the right. Completed processes appear on the left.
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Or perform Manual Droplet Calibration.
IMPORTANT Manual Droplet Calibration should be activated before the Droplet Calibration starts. 

Refer to Step 2.

Enter the frequency and amplitude values manually and select Continue to begin the 
manual droplet calibration. The dynamic stream appears on the right. 
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b. After completing the droplet calibration, the system sequentially calibrates charge phase, 
charge voltage, and defanning automatically. These calibrated parameters appear in the 
middle.

 • Frequency: The rate at which the crystal in the nozzle vibrates.
 • Amplitude: The force with which the crystal in the nozzle vibrates.
 • Charge Phase: Used to determine where the inconsistent charging occurs and then 

optimize for single side stream.
 • Charge Voltage: Used to adjust the amount of charge applied to the droplet.
 • Defanning: Used to place a little residual charge on the droplet following a charged 

droplet to minimize the potential impact of charged droplet.
 • Drop Delay: Defined as the amount of time it takes for a particle to travel from the 

interrogation point of the primary laser to the last attached drop in the stream. 
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c. After completing the droplet calibration, the system determines the drop delay 
automatically.

4 When the Sort Calibration procedures finish and pass, select Close.
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Default Amplitude Setting (Optional)
This function allows you to set the default amplitude as the datum point to scan the amplitude 
during the automatic Sort Calibration. Use this function only when the Droplet Calibration fails and 
prompts the error code 070015 or error code 070030. Increase the Amplitude when the break-off 
point is too low, and decrease the Amplitude when the break-off point is too high. For the criteria 
of break-off point, refer to Figure 5.1. Then, rerun the Sort Calibration until it passes.
Select Advanced > Default Amplitude Setting to access the Default Amplitude Setting window. 

Figure 5.1  Break-off Point Position Reference

< 7

< 5
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Setting Drop Delay Manually (Optional)

IMPORTANT The Auto Drop Delay generated from the Sort Calibration may differ from Manual Drop Delay 
due to different measurement criteria. Manual Drop Delay is the most accurate, while the Auto Drop 
Delay is accurate to ±10%.

The following procedures can be used to determine the drop delay manually or verify the accuracy 
of automatic drop delay.

1 Run the System Startup procedure. Refer to CHAPTER 3, Daily Startup.

2 Run the QC procedure. Refer to CHAPTER 4, Instrument Quality Control and Standardization.

3 Run Sort Calibration (Auto Drop Delay).

4 Create an experiment. Refer to Creating an Experiment.

5 Run Flow-Check Fluorospheres (approximately 0.5 mL undiluted) at low sample flow rate.

6 Create a plot of two fluorescent parameters and gate this plot.

NOTE Ensure the beads are positive on the two channels.
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7 Place a clean slide on the sort output holder.

8 Select Manual Drop Delay from the Sorting menu.
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The Manual Drop Delay window displays.

9 Select the desired gate for the Sort Logic.
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10 Enter a desired Drop Delay for the puddle in the middle. The Drop Delay setting appears in the 
puddle.

NOTE If you did not run the Manual Drop Delay test, the system starts with an Auto Drop Delay as the 
initial Drop Delay setting. If you have run the Drop Delay test, the initial Drop Delay will be the same 
as the last time you used the instrument. 

NOTE The range of Drop Delay is 0.01-100.
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11  Set a Delay Increment to specify a set of drop delays for the adjacent puddles.

NOTE The range of Delay increment is 0.01-100.

12 Set Beads Per Puddle to specify the target count of beads for each puddle.

NOTE The range of Beads Per Puddle is 1-1,000,000.
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13 Set the Number of Puddles. 

NOTE The range for Number of Puddles is 3-20. The default setting is 10 puddles.

14 Select Stop to stop loading.
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IMPORTANT The slide calibration archived in the Collection Device Library cannot be used for the Manual 
Drop Test. Slide calibration is mandatory for the initial use of a slide during the Manual Drop Delay Test. 
Skip the slide calibration if you have calibrated a slide for a Manual Drop Delay Test. 

15 Select Calibrate Slide to calibrate the slide position if needed. 

NOTE For instructions on calibrating a slide, refer to Calibrating the Sort Collection Device. 
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16 Select Test. 

You will see the circles turn blue as the puddles are created.
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17 Select Calculate when all puddles have been created. The following window displays.

18 Remove the slide and inspect the puddles under a fluorescent microscope.

19 Determine the puddle that contains the most beads. Puddle number one is located on the edge 
of the slide closest to the CyClone arm when the test was run.

20 Count the beads in the puddles adjacent to the puddle that contains the most beads.
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21 Enter the values in the Drop Delay Test window.

The system automatically calculates the Drop Delay.

NOTE The Test Result indicates a passing result with a  and a failed result with . 

NOTE The passing criteria: the difference between the number of beads in the puddles adjacent to the 
target puddle is less than 3%.
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22 If the test result passes, select  to save the calibrated manual drop delay.

Or
If the test result fails, select Retest and repeat Steps 18-21 until the test result passes.

23 Select Close.
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24 Optional: Save this experiment as a template if needed.

Creating an Experiment

Creating an Experiment

CAUTION
Risk of file corruption. When modifying experiment (*.xit) file names in Windows 
Explorer, ensure you modify the corresponding experiment folder name to match 
the new file name.

1 Open the CytExpert SRT software and confirm that the instrument is connected. Refer to 
Logging Into the Software in CHAPTER 3, Daily Startup. 

2 Verify the detector configuration. Refer to Verifying, Selecting, Editing, and Creating Detector 
Configuration.

3 Verify the laser settings. Refer to Laser Settings in CHAPTER 5, Sorting. 

4 Create or open an experiment using one of the following methods:
 • Create a new experiment:

— Select New Experiment on the Start page, specify the file path, and save the experiment.
Or

— Select New Experiment in the File menu, specify the file path, and save the experiment.
 • Create a new experiment from a template:

— Select New Experiment from Template on the Start page. Select Browse next to New 
Experiment and specify the file path for the new experiment, then select Browse next 
to Template and specify the file path to the existing template.
Or

— Select New Experiment from Template in the File menu, specify the file path and save 
the experiment.
Or

— Select the Template tab on the Start page and select the template from the list of 
recently used templates. Specify the file path and save the experiment.

 • Open an existing experiment:
—  Select Open Experiment on the Start page, specify the file path and save the 

experiment.
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Or
—  Select Open Experiment in the File menu, specify the path and save the experiment.

Or
—  Select the Experiment tab on the Start page and select the experiment from the list of 

recently opened experiments. Specify the file path and save the experiment.
NOTE Experiments are saved as an .xits file. Template are saved as an .xitm file. 

NOTE The CytoFLEX SRT software can read the experiments with the suffix xits. Selecting Convert 
CytExpert Experiment from the File menu to convert the .xit file to the .xits file if you want to use 
the CytoFLEX SRT software to analyze the experiments with the suffix xit. 

NOTE If desired, import saved settings/standardization settings from the catalog.

Changing the Tube Name
To change the name of a new sample tube or the sample ID, right-click the tube name or the sample 
ID name in the Tube section of the screen and select Edit Name or simply double-click the sample 
tube or sample ID name.
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Setting the Channel and Label

1 Select Set Channel in the Settings menu. The Set Channel window appears.
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2 In the Set Channel window, modify which channels are used and how they are displayed.
a. Select the channel signal check box, then you can add the reagent name in the Label 

column. The information you add appears in the corresponding axis of the relevant plot in 
the plot area. Unselected channel signals are not stored in the data file.

NOTE You can select which signal type to use Height or Area.
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b. Select Apply to. The Apply Channel Setting window appears.

c. Select the tubes to apply the channel settings to and select OK.
d. If you only need to modify the label name, select Set Label in the Settings menu to make the 

required changes. The Set Label screen appears. The Set Label screen does not allow you to 
select which channels to use, but it does allow you to apply the modified label to all the 
sample tubes.
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e. Select Apply to. The Apply Label Setting window appears.

f. Select the tubes to apply the label settings to and select OK.

Creating Plots and Gates
IMPORTANT The maximum number of elements allowed in an experiment is 200. Elements include plots, 

statistics tables, and gate hierarchy tables.

IMPORTANT The maximum number of gates allowed in an experiment is 200.

1 Use the plotting controls (refer to Figure 2.1) in the plot area to create plots and gates and to 
generate graphs as shown.

Use the  icons to generate histograms, dot plots, density plots, pseudo color plots, 
and contour plot.
The experiment uses scatter plots, histograms, polygon gating, four-quadrant gating, and 
line-segment gating.

a. After selecting a plot, click and drag the mouse to adjust the position and select and drag 
the sizing handles at the edge of the graph to adjust the size of the graph.
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b. Select an axis name to change which channel is displayed. An “A” after the channel name 
indicates signal pulse area, while an “H” indicates height. The default setting is "A". 

NOTE To modify the default settings, select Options in the Settings menu. The Options window 
appears. Select Plot on the left side of the Options window. Under the Signal section of the 
window, change the Main Channel default by selecting the Height or Area.

NOTE When using both Height and Area signals, ensure the gain setting is set to where the Height 
signal does not reach its upper range.
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c. Signal width can be used as a tool for doublet discrimination and to differentiate somatic 
cell adhesion. If necessary, select  to open the Acq. Setting window. 
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d. Select the Width tab, and select a channel with the required signal width.

e. Plot properties can be configured to display axes in Log, Log-Linear, or Linear format.
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1) Double-click the plot or right-click the plot and select Property from the drop-down 
menu. The Plot Property screen appears.

2) Select whether to display the axes in logarithmic or linear format for both the X-axis 
and Y-axis. Enter a value for log-linear coefficient if the log-linear view is desired. 

3) Select Close.
Or
Select the logarithmic axis on the plot. The slider appears. Drag the slider along the 
axis to change the log-linear coefficient and view events that are not shown, including 
events with negative values.
NOTE The log-linear slider is also available during data acquisition.

NOTE To reset the axis back to logarithmic, right-click on the axis and select Property. Select 
X axis Default or Y axis Default to reset the axis.

Histogram with logarithmic X-axis Histogram with log-linear X-axis
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f. You can adjust axis ranges using the pan axis display controls located at the top of the 
screen.

 • Select , to zoom-in and define which area of a plot to enlarge. The selected area 
can be magnified to fill the entire graph. By selecting the zoom-out function, you can 
click on the graph and restore the plot to its original appearance before magnification.

 • Select  to shift the axes. The mouse pointer appears as a hand. It allows you to 
drag the graph to reveal the axis segment you need. 

—  Pan: Modifies the axis display range dimensions when panning both axes. 
When the pan control is selected, you can right-click the graph and select which 
axis you need to adjust when dragging. You can also pan directly to the default axis 
range.

—  Single side pan: Modifies the axis display range dimensions when panning one 
axis.
NOTE Only the low end of the axis can be adjusted by the single side pan tool.

 • Double-click the border area of the plot to open the Plot Property window, or 
right-click the plot, then select Property to open the same Plot Property window.

Dot plot with logarithmic X-axis Dot plot with log-linear X-axis 
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 • In the Plot Property window, manually enter the minimum and maximum display 
values for the X- and Y-axes. You can also select Fit With Sample to let the software 
automatically adjust the lower limit according to the signal and perform the 
corresponding log-linear transformation. The X- and Y-axes Default settings are the 
default parameters. The default parameters are 100-1,000,000. 
NOTE Select Fit With Sample to identify the signal’s lower limit, adjusting automatically as 

warranted. Selecting this item is recommended whenever the signal appears to be 
relatively low.

NOTE Select Auto to automatically set the upper and lower display limits of the axes based on 
the data already collected.

NOTE Select Options in the Settings menu, then select Plot to modify the default setting of 
the axis range under the Axis Default Setting section of the window.
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2 To create gates, use the  control buttons or right-click the plot 
and select the gate type required. Gates can be set according to different requirements to 
differentiate cell populations.

NOTE To add a vertex to a polygon gate:
1. Select the gate.
2. Hover your cursor over the perimeter of the gate until the cursor changes to the hand icon.
3. Select the desired location for the new gate vertex.

NOTE A newly created gate becomes a subset of the plot where it appears. The relationship between 
parent and progeny/daughter gates can be changed when a displayed gate is subsequently 
modified.
The position of the same gate in different sample tubes may vary. To change the position of a gate 
and apply the change to all sample tubes accordingly, you can right-click the gate and select Apply 
to All Tubes.
You can also apply the change to select tubes by selecting Apply to Tubes.
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3 Select the gates to display.
a. Select the heading area of the plot, select the parent population/gate to display in the plot 

from the drop-down menu. The selected parent gate appears in the tab area of the plot.

NOTE The auto gates cannot be used as the sort logic.

NOTE The CytExpert SRT software will not list gates which would create circular gating logic.
Figure 5.2 shows all gates defined in the example experiment below. Note that the only gate 
option in plot 1 of Figure 5.3 is P2 for the following reasons:
 • Plot 1 cannot be gated on P1 because P1 is on that plot.
 • Plot 1 cannot be gated on P2 because P2 is gated on P1. 
 • Plot 1 cannot be gated on the P2 OR P1 combo population because the gate logic contains 

P1.

Figure 5.2  All Gates - Example Experiment

Figure 5.3  Circular Gating Logic - Example Experiment
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b. If necessary, you can select the Combo Population option from the drop-down menu to 
create a combination gate, using the Boolean relationships “and”, “or”, and “not” to 
produce a new gate. You can also select the population color or change the gate name.

 • “And” indicates that all selections must be satisfied. For example, “P1 and P2” means 
that the data for the newly added gate represent the intersection of P1 and P2.

 • “Or” indicates that only one of the selections needs to be satisfied. For example, “P1 or 
P2” means that the data for the newly added gate represent the union of P1 and P2.

 •  “Not” indicates exclusion from the selection. For example, “Not P1” means that the 
data for the newly added gate represent the events that are not part of P1.
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4 Select to display the population hierarchy.
The Population Hierarchy function allows you to view how gates rank in relation to one 
another. To change the display color, double-click the default color and select the desired color 
from the drop-down color palette. To change the name of each gate, double-click the name of 
the desired gate. By hovering your mouse pointer over a combo population whose display name 
has just been changed, you can view its corresponding Boolean logical operation.

Creating and Adjusting Auto Gates
Two types of auto gates are available in the CytExpert SRT software: auto line segment and auto 
polygon. 

To create an auto line segment gate, select  from the tool bar or right-click on the histogram 
and select Auto Line Segment from the drop-down menu. 
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Select the population you want to gate in the histogram to automatically gate that population.

To create an auto polygon gate, select  from the tool bar or right-click on the 2D plot and select 
Auto Polygon from the drop-down menu.
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Select the population you want to gate in the 2-D plot. The gate will automatically be drawn to fit 
the population.

NOTE To add a vertex to an auto polygon gate:
1. Select the gate.
2. Hover your cursor over the perimeter of the gate until the cursor changes to the hand icon.
3. Select the desired location for the new gate vertex.

Turning Auto Recalculate On/Off
When auto recalculate is turned on, all auto gates will recalculate when:
 • The current tube is changed
 • Compensation is changed
 • Gating is changed
 • Collection stops
 • An FCS file is imported to the tube or well
Auto recalculate turns off after a gate is moved or the size of a gate is altered You must select Auto 
Recalculate from the auto gate menu again to turn auto recalculate back on.
NOTE Auto recalculate turns on after adjusting movement or extent.

Right-click an auto gate and select Auto Recalculate from the auto gate menu to toggle auto 
recalculate on and off.
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Adjusting Autogate Movement and Extent

Movement — The distance an autogate can move to find the target population.
To adjust movement, right-click an autogate and drag the Movement handle in the auto gate menu 
left and right.

NOTE The default value setting for movement is 20 units. The minimum value setting for movement is 0 
units and the maximum value setting for movement is 100 units.

If a target population is consistently in the same location, movement is not needed. However, if a 
target population is periodically missing from some samples, or events are rare, movement can be 
used to move the gate within a certain percentage of its axis to capture the correct population. 
Refer to Figure 5.4 for an example of the default movement setting. Refer to Figure 5.5 for an 
example of the maximum movement setting.

Figure 5.4  Movement - Default Setting
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Figure 5.5  Movement - Max Setting

Extent — Shrinks or expands the gate around the population.
To adjust extent, right-click an autogate and drag the Extent handle in the auto gate menu left and 
right.

NOTE The default value setting for extent is 20 units. The minimum value setting for extent is 0 units and 
the maximum value setting for extent is 100 units.

Refer to Figure 5.6 for an example of the default extent setting. Refer to Figure 5.7 for an example 
of the maximum extent setting.

Figure 5.6  Extent - Default Setting
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Figure 5.7  Extent - Maximum Setting

Configuring Acquisition Settings

Laser Settings
To access the Laser Setting window, select Advanced > Laser Setting. The Laser Setting window 
appears. Refer to Figure 5.8.
NOTE The instrument must be in Standby mode to access the Laser Setting window.
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Figure 5.8  Laser Setting Window 

1. Enable/Disable: Enables or disables the laser.

IMPORTANT The laser target power setting is not available to users.

2. Target Power (mW): Used to change the laser target power.

NOTE The power detector has ±1 mW tolerance. Refer to Table 5.1 or Figure 2.2 (the target Power 
column in the QC report area) for range limits of each laser.

3. : Sets the laser target power setting.

IMPORTANT The Actual Power readings are +/- 1 mW.

4. : Reads the current laser power before the flow cell assembly and displays the current 
laser power in the Actual Power (mW) column of the Laser Setting window. 

Table 5.1  Target Power Ranges in the Laser Setting Screen

Laser Power Range (mW) Max Power (mW)

405 90 120
488 50 60
561 30 40
638 100 120
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Select the Enable or Disable radio button next to each laser on the Laser Setting window to enable 
or disable lasers. When a laser is disabled or abnormal, the laser status icon  appears in 
the software status bar. Hover your mouse over  to display details for each laser.

NOTE Lasers can only be enabled or disabled when the system is in standby state.

Adjusting the Gain
While the instrument is in use, the signal value can be increased or decreased by adjusting the 
instrument's gain configuration.

1 Select  in the Cytometer menu. The Acq. Setting window appears. 
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2 Select the Gain tab in the Acq. Setting window. 
Select or edit the instrument’s default gain settings using one of the following methods:
 • Edit the gain settings and select Set as Default to create a new default setting.
 • Select Default to return to your saved default settings.
 • Select QC Gain to use the instrument’s QC settings.
NOTE In cases where you do not specify your own default parameters, the recommended settings and 

default settings are identical.

3 Adjust the gain setting of each channel under the Gain tab in the Acq. Setting window. Raising 
the gain increases the signal. Lowering the gain reduces the signal.

NOTE Optimize the gain settings according to your own experimental goals. The recommended values 
are only for reference.
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Another option is to use the Gain Control button  on the tool bar in the graphic control 
area to adjust the gain values for cell population data to their desired levels, directly on the 
plots where the data appears during data collection.

NOTE Gain adjustments have a predefined range between 1 and 3,000.

4 If necessary, change the coordinate display range and the plot type. 

Adjusting the Threshold
By adjusting the threshold, the user can remove unnecessary signal noise to ensure that most of the 
data collected consists of desired signal data. After the threshold settings have been configured for 
a given channel, the acquisition of data from this channel will only be triggered by signals that 
exceed the established threshold. Threshold settings have considerable bearing on whether the 
appropriate events can be acquired.

1 Create a plot to view the channels where the threshold will occur. Generally, a bivariate plot 
showing FSC and SSC is used. 
NOTE Threshold can be defined for any of the fluorescence channels.

2 Select  on the left side of the screen.
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3 Select the Threshold tab in the Acq. Setting window. 

4 Set the desired threshold using one of the following methods:
 • Choose the channel that is used for setting the threshold. Manually enter the threshold 

value in the Threshold tab.
NOTE For dual-parameter plots, you can right-click the plot and select both parameters if desired. 

Then, select the desired threshold boundary for the second parameter.

 • Select Automatic in the Primary Threshold Trigger Level section of the Acq. Setting screen 
to seek the target signal based on the background signal. It can quickly help find the target 
population if the signal-to-noise ratio (SNR) of the channel is comparatively good. The 
threshold can be set to either “H” (signal height) or “A” (signal area).
NOTE The automatic threshold value is based on the relative signal difference. When adjusting 

gain, you do not need to update the threshold settings. For channels with a low SNR or an 
excessively impure signal, manually setting the threshold parameters is recommended.

Moreover, “and” as well as “or” can be applied to as many as two channels, so as to allow 
these Boolean logical operators to be used in setting the threshold value.
— “and”: Data is displayed and collected only when two threshold conditions are met 

simultaneously.
— “or”: Data is displayed and collected when at least one of two threshold conditions are 

met.
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 • Select  from the plot control area. Move your mouse pointer to the desired threshold 
position in the desired plot and select once.

5 Select Close.

Setting Collection Conditions

1 Check mark the conditions required to set the necessary stop count events on the left side of 
the Acquisition screen. 
Two stop conditions are available for sample recording:
 • Events to Record. Used to set the number of events to record in the specified population.
 • Time to Record. Used to set the collection time duration in seconds.
For example, if the event to record is set to record 1,000 P1 events, the software automatically 
stops recording when P1 events reach 1,000 events. However, the software saves all data 
acquired, including events outside of P1, when 1,000 P1 events is reached. You can also specify 
the time to store if necessary. When multiple acquisition conditions are established, any one of 
these conditions stops the collection process.

NOTE The sorting stop criteria takes precedence over the collection stop condition in a sort. Refer to 
Stop Criteria for Sorting.

NOTE Navigate to Settings > Options > Record to customize the default value for Events to Record. 
Refer to Software Settings in CHAPTER 2, Using the CytExpert SRT Software.

2 Select Record and wait for the software to complete collecting the data, at which time the 
sample chamber and sample probe are in loading position.
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3 If you made changes to the data acquisition conditions and need to apply these changes to an 
established sample tube, right-click the sample tube and select Apply Acq. Settings To, to apply 
the conditions accordingly.

Setting Sample Flow Rate
Set the sample flow rate by specifying the sample pressure located in the lower left corner of the 
software screen. The allowable range is 10-100. The value can be adjusted in 1 increment.

 10: approximately10 μL/min 
 30: approximately 30 μL/min 
 60: approximately 60 μL/min 

NOTE Customize the pressure differential according to the nature of the sample. Big pressure differential 
may increase the measurement CVs. 

The sample flow rate setting might not be accurate. If the deviation between the setting and the 
actual (calculated flow rate based on known sample concentration) is ≤ 30%, and leads to QC failure, 
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select Sample Flow Parameter Adjustment from the Cytometer menu to offset the sample flow rate. 
The allowable range is -5 to 10. 

 10: increase by approximately 10 μL/min 
 -5: decrease by approximately 5 μL/min 

NOTE If the sample flow rate deviation is > 30%, or the QC problem persists after adjusting the sample flow 
rate offset, contact us to perform the sample flow rate calibration.

Setting Mixing Speed
Set the mixing speed located in the lower left corner of the software screen.

 Low: approximately 100 r/min 
 Medium: approximately 300 r/min 
 High: approximately 500 r/min

NOTE You can customize the sample mixing speed for each tube. The sample mixing automatically stops 
when the acquisition ends.
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Setting Plot Display Conditions
Select Events Display Setting in the Settings menu. The Events Display Setting window appears.

Three display options are available:
 • Display all events. Used to view all events on the plot.
 • Display first XXXX events. Used to set the set number of events to display.

NOTE The selected number of events displays in the bottom, left corner of the plot. For example, if you 
choose to show 5000 events, the bottom, left corner of the plot displays 5000 Show.

 • Display XX percent of events acquired. Used to set the percentage of events to display.
NOTE The selected percentage of events displays in the bottom, left corner of the plot. For example, if 

you choose to show 20 percent of events acquired, the bottom, left corner of the plot displays 20% 
Show.
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Setting Customized Parameters
Set custom parameter to create fluorescence calculations.

1 Select Set Customized Parameter from the Settings menu. Or, right-click a test tube from the 
test tube menu and select Set Customized Parameter. The Set Customized Parameter window 
appears.

2 Enter a name for the parameter in the Name section.

3 Select the parameters for calculation in the Parameter dropdowns.

4 Select OK.

5 Select the equation operations from the Oper dropdown menu.
The new parameter name is displayed in the list of parameters and statistic items.
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Setting Custom Statistics
Set custom statistics to create calculations based on populations of interest.

1 Right-click the statistics table and select Statistics Setting. The Statistics Setting window 
appears.
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2 Select Expression.

3 Select Edit. The Expression window appears. 
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4 Enter the expression name in the Name section and enter the expression using the equation 
buttons.
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5 Select OK.
NOTE The equation populates in the Statistics Setting window under the Expression selection. 
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Load Sample and Record Data

Before Running Samples

CAUTION
Risk of erroneous results if the Sorter has been idle for an extended period of time. 
Perform a prime if the system has been idle for an extended period of time. Refer 
to Performing the Flow Cell De-bubble in CHAPTER 11, Replacement/Adjustment 
Procedures.

1 Run the System Startup Program procedure.

2 Run the Instrument Quality Control and Standardization procedure.

3 Create an experiment. Refer to Creating an Experiment.

4 Run Sort Calibration. Refer to Sort Calibration (Auto Drop Delay).

5 Ensure that there is sufficient space on your hard drive for sample processing and data 
acquisition.

6 Verify the detector configuration. Refer to Verifying, Selecting, Editing, and Creating Detector 
Configuration.
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7 Verify the laser settings. Refer to Laser Settings in CHAPTER 5, Sorting.

Setting Up Violet Side Scatter (VSSC) Channel
For micro-particles, a VSSC option can be added to better separate side scatter signals from noise. 
Beckman Coulter recommends using this channel to detect particles smaller than 500 nm.
NOTE Since the total available channel numbers remain the same when the VSSC channel is used, the 

number of fluorescent channels in the violet WDM is reduced by 1 channel.

CAUTION
Risk of erroneous results. Beckman Coulter recommends using the VSSC channel 
to detect side scatter signals for particles smaller than 0.5 μm. VSSC could be too 
sensitive when large particles are being acquired. Switch back to the original 
detector configuration for particles larger than 5 μm. For particles larger than 
5 μm, set the gain of the VSSC to 1 to increase the threshold and decrease the 
collection of sample noise.

1 Open the Violet WDM lid (refer to Replacing the Optical Filter in CHAPTER 11, Replacement/
Adjustment Procedures) and remove the 405-nm filter, the 450-nm filter, and a third filter not 
required for the test, for example, the 780-nm filter. 
NOTE Refer to Table 5.1 to identify the WDM filter mount color codes.

NOTE The orientation for position 1 through 6 starts with position 1 located closest to the fiber coming 
into the WDM, and position 6 located on the side furthest from the fiber coming into the WDM.

1. Position 1
2. Position 2
3. Position 3

4. Position 4
5. Position 5
6. Position 6

b

c

d

e

f

g
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2 Place the sixth filter in position 1, the 405-nm filter in position 2, and the 450-nm filter in 
position 3. 
NOTE For the Violet WDM, Beckman Coulter recommends placing the filters in sequential order from the 

shortest wavelength to the longest wavelength in positions 2 to 6. Position 1 will always contain the 
unused filter.

3 Start the CytExpert SRT software. Refer to Logging Into the Software in CHAPTER 3, Daily 
Startup.

4 Select Detector Configuration from the Cytometer menu. The Detector Configuration window 
appears.

1. Position 1
2. Position 2
3. Position 3

4. Position 4
5. Position 5
6. Position 6

b

c

d

e

f

g
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5 Select the Default Configuration and select Save As. The Configuration Save As window appears.

6 Name the new configuration VSSC and select OK.

7 Select the VSSC configuration and select Edit. The Edit Detector Configuration window appears.

8 Change the filters and channel names according to the filter order in the violet WDM.
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9 Right-click the VSSC channel, and select Set SSC to set it as the Violet SSC channel.

10 Select OK to save the changes and close the Edit Detector Configuration window.

11 Select Set as Current.

12 Select OK to save the changes and close the Detector Configuration window.

13 Create a new experiment using the VSSC configuration. Refer to Creating an Experiment.
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Verifying, Selecting, Editing, and Creating Detector Configuration

CAUTION
Risk of erroneous results. The system will read the selected Detector 
Configuration even if the optical filters do not match the selected Detector 
Configuration. You must verify the installed optical filters match the selected 
Detector Configuration.

1 Select Detector Configuration in the Cytometer menu to verify the correct detector 
configuration is selected. To change the configuration:
a. Select the desired configuration.
b. Select Set as Current.

A green check mark appears in front of the selected configuration.

NOTE A configuration is locked when  appears to the left of a configuration. A configuration locks for 
two reasons:
 • QC was run using the configuration.
 • The compensation library contains data for the configuration.

Locked configurations can be deleted, but not edited. 

2 Select OK to close the Detector Configuration screen.

3 Proceed to Step 4 if you need to edit the Detector Configuration settings, or skip to Step 5 if you 
need to create a new Detector Configuration, or skip to Step 12 if you need to delete a Detector 
configuration.
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4 If a saved configuration requires changes, edit that configuration.
NOTE The factory configuration is in bold and cannot be edited.

a. Select the configuration, then select Edit to access the Edit Detector Configuration screen.

b. Channels with a white background can be edited. Drag the names of the appropriate 
fluorescence channels and optical filters on the left to the correct channels.

c. Continue to Step 6.

5 If an appropriate configuration is not saved, create a new configuration.
a. Select Detector Configuration... in the Cytometer menu. 
b. Select New... and name your configuration.

You can also select a previously saved configuration and select Save As to create a copy. 
c. Select OK.
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d. Ensure the new configuration is highlighted, then select Edit. The Edit Detector 
Configuration window appears. 

e. Customize the new configuration. Channels with a white background can be edited. Drag 
the names of the appropriate fluorescence channels and optical filters on the left to the 
correct channels.

f. Continue to Step 6.

6 If a required channel name or filter is not listed on the left, select Fluorescence or Filter to add 
or modify the channel name or the filter.
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7 When finished, select OK.

8 Select the appropriate configuration.

9 Verify that the correct optical filters are installed in the Sorter and match the newly created 
configuration.

10 Select Set As Current.

11 Select OK.

12 To delete a configuration created in error, select Delete. The following confirmation message 
appears. Select OK.

Sampling and Collecting Data

Use universal precautions when working with pathogenic materials. Means must be available to 
decontaminate the instrument and to dispose of biohazardous waste.
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CAUTION
Risk of clogging the sample line. Filter the biological sample using a 70-μm mesh 
aperture filter before sampling.

NOTE Settings can be imported from the Acquisition Settings Catalog. Refer to Importing and Exporting 
Instrument Settings.
If compensation settings are desired, import the compensation from the Compensation Library or import 
the compensation file. Refer to Importing and Exporting Compensation in CHAPTER 6, Compensation.

NOTE If the instrument has been idle for more than two hours, select Backflush from the Cytometer menu 
before sampling.

1 Select  from the Test Tube screen to create the new sample tube.
NOTE The first sample tube is already created by default.

2 Change the tube name if necessary. Refer to Changing the Tube Name.

WARNING
Risk of biohazardous contamination. When using 12x75 mm tube for sample 
loading, do not exceed 4 mL sample volume. Running sample with volumes 
exceeding 4 mL can result in sample splashing. Clean up spills immediately. Use 
universal precautions when working with pathogenic materials. Means must be 
available to decontaminate the instrument and to dispose of biohazardous waste.

WARNING
Risk of instrument damage. When using 12x75 mm tube, always cut the cap off. 
Running samples with a cap attached to the sample tube can result in a bent 
sample probe.

CAUTION
Risk of clogging the sample line if the sample contains aggregates or clumps. 
Filter the sample using an appropriately sized mesh aperture filter before loading 
sample. Enable the sample mixing.

3 Place the sample tube in the sample tube holder. 
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4 Select the desired acquisition parameters (Events/Time to Record, Sample Flow Rate, and 
Sample Mixing) on the left side of the screen. 

5 Select Run to load the sample.
NOTE When you select a tube that only contains acquired data, as indicated by the blue tube  in the 

test tube section of the screen, the following message appears:

 • Create new tube. Saves the current tube and creates an additional tube.
 • Overwrite the data. Overwrites the current tube data with new data.

6 View the plots and establish the gates. Refer to Creating Plots and Gates. Adjust the gate and 
instrument settings as necessary. Refer to Configuring Acquisition Settings.

7 Adjust the gain settings. Refer to Adjusting the Gain.

8 Adjust the threshold settings. Refer to Adjusting the Threshold.

9 Adjust the Acquisition conditions. Refer to Setting Collection Conditions.
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10 Select Record to save the data.
Wait for the saving process to finish. 
NOTE When you select a tube that contains recorded data, as indicated by the green tube  in the 

test tube section of the screen, the following message appears:

NOTE When you select a tube that only contains acquired data, as indicated by the blue tube  in the 
test tube section of the screen, the following message appears:

 • Create new tube. Creates a new tube in the test tube section of the screen for the data.
 • Overwrite existing data. Overwrites the current tube data with new data.
 • Append data to existing file. Adds new data to the existing data.

11 Repeat steps 1-10 until all sample tube data required for testing has been collected.
NOTE If the rate suddenly appears to drop, check to see if the sample has run dry or the sample probe 

is clogged. Any time the sample probe becomes clogged, immediately select Stop to unload the 
sample. Then select Backflush to clean the sample probe. Refer to Daily Clean Program in 
CHAPTER 10, Cleaning Procedures to flush out the sample probe. If you are still unable to clear the 
sample probe, contact us.
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Sorting

Setting Up Tube Sorting

1 Open the sort chamber sliding door.

2 Place the appropriate sorting tubes into the output holder and ensure they are secure.

[Two 5 ml tubes and two 15 ml tubes]

DO NOT  OPEN  THE  SORTER 
PROTECTION  DOOR  DURING 
A SORTING PROCESS.
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CAUTION
Risk of sample loss and biohazardous contamination. Ensure that the tube 
adapters are installed in the output holder when using the 12x75 mm tubes to 
collect the L2 and/or R2 side stream during the sorting. Otherwise, the sorted 
sample can spray outside the collection tube and contaminate the sort output 
holder.

[Four 5 ml tubes]

IMPORTANT Ensure that the sort protection door is closed.

3 Close the sort chamber sliding door.
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4 Add a sample tube from the Tube Management screen.

5 Select  in the Tube Management Control screen to set the sorting settings. The Tube Sort 
window appears.
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6 Set the stop conditions for sorting. 

Explanation of restrictions:
Events to Process: 1 ~ 864,000,000
Time to Sort: 1 second ~ 8 hour
NOTE When multiple conditions are established, any one of these conditions stops the sorting process. 

Refer to Stop Criteria for Sorting.

NOTE The Elapsed Sorting Time records the sorting duration, exclusive of the sorting pause.
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IMPORTANT Place the most precious and/or rare events in the outer streams (L2/R2) for maximum purity. 
However, it is better to use the inner streams (L1/R1) for sorting macro-particles (≥15 μm).

7 Set the side streams to be sorted.

NOTE L1 refers to the left side stream closer to the core stream and L2 refers to the outer left side 
stream. R1 refers to the right-side stream closer to the core stream and R2 refers to the outer right 
side stream. 

L2   L1  R1   R2
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8 Set the Sort Logic. 

NOTE Sort Logic is the combinational Boolean logic of regions and gates to determine if an 
event is positive (desired for sorting). Events that fall outside the sort logic are considered 
negative events.

NOTE The available logic displays in the dropdown list depends on the gates established in the plots. 
Refer to Creating Plots and Gates.

NOTE The auto gates cannot be used as the sort logic.

9 Verify that the desired Sort Mode is selected.

NOTE For explanations about the Sort Mode or setting the default Sort Mode, refer to Sort Mode in 
CHAPTER 2, Using the CytExpert SRT Software.
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10 Set the target count of cells to be sorted for each stream.
NOTE The allowable range is 0~ 864,000,000. Target count “0” means unlimited.

NOTE If the target volume setting exceeds the tube volume in theory, the system will display  in 
the corresponding sort stream. 

11 Set the tube size.

12 Enter the initial buffer volume.
NOTE If the target volume setting exceeds the tube volume in theory, the system will display  in 

the corresponding sort stream. 

Setting Up Plate/Slide Sorting

1 Open the sort chamber sliding door.

DO NOT  OPEN  THE  SORTER 
PROTECTION  DOOR  DURING 
A SORTING PROCESS.
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2 Place the appropriate sorting plate/slide on the output holder and ensure it is secure.

[Standard 96-well plate]

[96-well deep well plate]

[Slide]
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IMPORTANT Ensure that the sort protection door is closed.

3 Close the sort chamber sliding door.

4 Select a sample tube from the Tube Management screen.

5 Select  in the Tube Management Control screen. The Plate Sort window appears.
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6 Select the desired plate type from the Plate Type drop-down menu.

[Standard 96-well plate]

[Slide]

NOTE The screen varies according to the type of collection devices.
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7 Set the sorting sequence.

8 Select the desired wells, and select  to set the well settings for the desired wells. The Well 
Setting window appears.

NOTE Ensure that the gates are created prior to this well settings.
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a. Enter a name for the group of desired wells.

b. Select a color for the group of desired wells.

c. Set the Sort logic.
d. Set the Sort Mode for this group. 

NOTE For explanations about Sort Mode, refer to Sort Mode in CHAPTER 2, Using the CytExpert SRT 
Software.
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e. Set the Target Count for each well.

NOTE The range of target count is 1- 1,000,000.

The CyClone Movement system automatically moves to next well when the sorted events 
in a well reach the target. The sorting stops until all the desired wells reach the target.

f. Select OK. The settings display in the Sort Information area. 

NOTE Index Sorting is selected by default. For explanations, refer to Index Sorting.

NOTE To cancel the well settings, select the desired wells and select .

OR
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Select  to set the well settings for several groups of desired wells. 

9 Exit the Collection Plate window. 

Stop Criteria for Sorting
Three stop sorting conditions are available for tube sorting. When multiple stop conditions are 
established, any one of these conditions stops the sorting process.
 • Events to Process. Used to set the number of total events acquired.
 • Time to Sort. Used to set the sorting duration.
 • Target Count. Used to set the target number of cells to be sorted for each side stream L2/L1/R1/

R2.
Explanation of restrictions:
Events to process: 1- 864,000,000
Time to sort: 1 - 28,800 seconds
Target count: 0- 864,000,000
NOTE Target count “0” means unlimited. Use this feature for the continuous sorting. 

NOTE In plate sorting mode, only Target Count is available. Select  to access the Target Count tab.

NOTE The sorting stop criteria takes precedence over the collection stop condition in a sort. Refer to 
Setting Collection Conditions.
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Calibrating the Sort Collection Device
Calibrate the plate or slide position for the following cases:
 • Every time after running the sort calibration 
 • When switching the sort collection device from tube to plate, or vice versa.
 • After using a new plate type
 • After changing the manufacturers of a plate type
 • After replacing the nozzle module
The software supports two ways to access the Collection Device Calibration window:
 • Select Advanced > Collection Device Library. Then select Calibrate from the Collection Device 

Library window.

 • Select  from the Tube management area to open the Collection Plate window. Then select 

 on the Collection Plate window.
NOTE The slide calibration archived in the Collection Device Library cannot be used for the Manual Drop 

Delay Test. Calibrate the slide again for the Manual Drop Delay Test at the initial use. Refer to Setting 
Drop Delay Manually (Optional).

1 Open the sort chamber sliding door.

DO NOT  OPEN  THE  SORTER 
PROTECTION  DOOR  DURING 
A SORTING PROCESS.
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2 Select Collection Device Library in the Advanced menu. The Collection Device Library window 
appears.

3 Select the collection device type from the Collection Device Library window and place a plate 
or slide on the output holder. 

[Standard 96-Well Plate]

NOTE Ensure plate well A1 aligns with position A1.
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[Slide]

4 Select Calibrate on the Collection Device Library window. The Collection Device Calibration 
window appears.

[Standard 96-Well Plate]
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[Slide]

5 Select the well to be calibrated. 
NOTE The selected well is highlighted in yellow. 

 • UL: upper-left well A1. 
 • UR: upper-right well A12.
 • LL: lower-left well H1.
 • LR: lower-right well H12.
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6  Select  and  or  and  to adjust the well positions in the X-, and 
Y-axes. You can type a number as well.
The X-axis arrows moves the well position left and right. The Y-axis arrows moves the well 
position forward and back. 

NOTE Use Step to set the increment for each step.

7 Set the Test Type to specify how many wells to deposit each time. All corners is set by default.

X

Y

UL UR

LL LR

UL UR

LL LR

Home position

(0,0)
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[Standard 96-Well Plate]
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8 Set the count of droplets for each well.

[Standard 96-Well Plate]
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9 Select Test to deposit a small puddle over the wells.

[Standard 96-Well Plate]

10 Remove the plate lid or slide and verify that the drops are located in the center of each well at 
the corners.
NOTE  If the drops are not aligned with the center of the well, repeat steps 6-9 until the stream R1 hits 

the center of each well.

11 Select Save to save the calibrated settings. 
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[Standard 96-Well Plate]

NOTE Select Restore to Customer Settings to discard the current calibration and use the previous 
calibration setting.
Select Restore to Factory Settings to set back to the factory default.

12 Select Close to exit. 

13 Close the sort chamber sliding door. 

Manual Side Stream Calibration (Optional)
This function is for advanced users to fine tune the charge voltage settings to ensure that the drops 
are deposited into the center of a tube.
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IMPORTANT The charge voltage and defanning setting can cause the side stream detection to be 
inaccurate. The system will deactivate the Side Stream Monitor function when the manual charge voltage 
or defanning setting takes effect. To restart the Side Stream Monitor, you need to perform the Sort 
Calibration again. Refer to Sort Calibration (Auto Drop Delay).

1 Select Initialize to put the instrument in the Ready state.
NOTE Skip this step if the instrument has already been initialized.

2 Select Manual Side Stream Calibration from the Sorting menu. The Manual Side Stream 
Calibration window displays.

3 Select Tube Sort Setting. A new tube is created automatically in the Tube Management screen.
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The Tube Sort window displays. 

4 Set up the tube sort settings. Refer to Setting Up Tube Sorting.

5 Open the sort chamber sliding door and place a clean slide over the top of tubes.
NOTE The slide is for viewing the position of drops into a tube.

6 Select Close to exit the Tube Sort window. 
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7 Adjust the charge voltage to set the deflection angle for L2 stream.

Explanation of restrictions:
L2 Stream: 60 ~180 V
L1 Stream: 10 ~ 100 V
Core Stream: -40 ~ 40 V
R1 Stream: -10 ~ 100 V
R2 Stream: -60 ~ -180 V

8 Adjust the defanning.

9 Select Test to deposit drops on the slide.

10 Select Stop to stop the sorting.

11 View the drops that were deposited on the slides. If the drops are not in the center of the tubes, 
repeat Steps 7-10 until the drops are correctly positioned. 

12 Repeat Steps 7- 11 to adjust the charge voltage for other side streams.

13 Select Close to exit the Manual Side Stream Calibration. The calibrated charge voltages are 
applied automatically.
NOTE Select Default to discard the calibrated charge voltage setting and use the charge voltage setting 

which was calibrated by the last sort calibration.
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Adjusting Tube Position (Optional)
The Tube Position Setting allows you to slightly adjust the output holder position in the X-axis and 
Y-axis to align the sort tubes with the side streams when a sorting is in process. This function is 
helpful when all the side streams are slightly tilted to one side. Select Sorting > Tube Position Setting 
to access the Tube Position Setting window. 

NOTE The Tube Position Setting is only available when tube sorting is in process.

NOTE Select Set as Default to set the current position as the default setting. Select Recommended to 
return to the factory setting.

NOTE You can manually fine tune the L2/R2 tube positions in the X-axis if your sort output holder has already 
been upgraded to the new design (refer to Figure 5.9). This feature is helpful when the L1/R1 streams are 
aligned with the L1/R1 tubes, but L2/R2 stream cannot be deposited into the L2/R2 tube center.

Figure 5.9  New Output Holder
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Starting and Monitoring a Sort

During a Sort

CAUTION
Risk of contaminating the sorted sample. Do NOT open the sort protection door 
(refer to Figure 1.22) when a sorting is in process. Otherwise, the system disables 
the voltage to the deflection plates immediately, and a small amount of the waste 
stream (L1 stream) in the Straight Down mode will drop on a plate or slide due to 
the response delay of the waste catcher.

NOTE If you open the sort protection door during a sort, you will find that:
 • the system stops the sorting abruptly 
 • the waste catcher moves into place
 • sample flow halts
 • the CyClone movement stops.

During a sort the following events occur:
 • An event is detected at the interrogation point.
 • A decision is made on the event to determine if it is a particle or cell that satisfies the sort and/

or abort logic.
 • If it is determined that a cell is to be sorted, the system waits until the cell reaches the Last 

Attached Drop.
 • The electronics sends a charge through the sheath and sample stream. The charge can be 

various positive, negative, or neutral amplitudes depending upon the direction the drop is to 
be sorted.

 • The last attached drop breaks off carrying the charge that was applied to the stream.
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Viewing Sorter Status

Select  in the lower right corner of the software screen, or select Sorter Status 
from the Sorting menu to access the Sorter Status window. 

NOTE The green line indicates the break-off position at the moment when the Sort Calibration finishes. The 
green line is created automatically, and can be used as a baseline.
To mark the real-time break-off position, you can create a red line by dragging the slider where the 
droplet breaks. These two lines help you to monitor the stability of fluid.
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Side Stream Monitor

IMPORTANT The Side Stream Monitor is not available if the default voltage or defanning has ever been 
changed manually. You can re-start the Side Stream Monitor only after performing the Sort Calibration 
again. For instructions on Sort Calibration, refer to Sort Calibration (Auto Drop Delay).

IMPORTANT Open the Side Stream Monitor window and continue to monitor the side stream status during 
a sort. A neglected error might impact the sorting result.

Eight photo-diodes (PDs) behind the side stream detection windows, the side stream illumination 
source (refer to Figure 1.22) and the software make it possible to monitor whether the desired 
droplets are directed to the targeted sort output device and whether the waste stream is deposited 
into the waste catcher. 
Select Side Stream Monitor from the Cytometer menu to access the Side Stream Monitor screen.

NOTE The droplet animation, which updates proportionally with the real-time sorting, is only for your 
reference.

Explanation of Background Colors:

 • : Indicates a normal state that the percent of the detected droplets of a side stream L1/R1 
relative to the charged droplets is ≥ 60%, or the percent of the detected droplets of a side stream 
L2/R2 relative to the charged droplets is ≥ 50%. 

 • : Indicates an abnormal state which requires your attention, for example, the sample 
contains macro-particles, or clumps, or the droplets are too quick for the software to respond. 

 • : Indicates that the detected droplets of a side stream are less than 30% of the charged 
droplets. You need pause the sorting and troubleshoot the problem.
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Auto Maintain

IMPORTANT Ensure that the Auto Maintain is enabled prior to starting a sort. Otherwise, the following 
warning message appears.

When a sort is in process, the software with the IntelliSort technology monitors the droplet stream 
and maintains the Drop Delay automatically, which is called Auto Maintain. If the software detects 
an instability, Auto Maintain modifies the amplitude parameter (without affecting the determined 
DD) to ensure that the sort continues uninterrupted with no operator intervention.
If the software detects a dramatic droplet-formation failure or stream instability which cannot be 
restored by Auto Maintain within 1 minute, Auto Maintain turns off and the system starts Auto 
Recovery automatically.
In Auto Recovery, the system sequentially stops the sample flow, extends the waste catcher, and 
starts Flow Cell De-bubble. If Auto Recovery succeeds, the system re-enters the Auto Maintain state 
and restarts sorting automatically. If Auto Recovery fails, the sorting stops and user intervention is 
required, for example, cleaning the Nozzle, removing the bubbles, and performing the sort 
calibration. For instructions, refer to Cleaning the Nozzle in CHAPTER 10, Cleaning Procedures, or 
Removing Trapped Air Bubbles in CHAPTER 11, Replacement/Adjustment Procedures.
NOTE Auto Recovery can be stopped at any time by selecting Stop from the Sorting control screen. If you 

select Stop, the following message appears.



C37808AC   5-98

Sorting
Sorting  

The status of Auto Maintain can be viewed by the icon  below the droplet view on the Sorter 
Status window. Following the instructions below to enable the Auto Maintain.
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1 Select  in the lower right corner of the software screen. The Sorter Status 
window appears. 
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2 Select More details to unfold the Sorter Status window.
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3 Select Turn On to turn on the Auto Maintain.

The Auto Maintain icon turns green.
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Viewing Sorting Statistics

CAUTION
Risk of sample loss and biohazardous contamination. Remove the sample 
collection tube when the tube is nearly full. The Tube Volume value on the 
software might not be accurate due to the various sample conditions. Use suitable 
laboratory attire when removing the sample.

Table 5.2  Sort Statistics

Screen Element Function

Sort Count Total positive events that have been sorted for the stream.
Sort Rate Total sorted events per second for the stream.
Abort Count Total positive events that have been aborted for the stream.
Abort Rate Total aborted events per second for the stream.
% Total The percent of positive sorted events relative to the Total Events for the 

acquisition.
Efficiency The number of positive events sorted, divided by the total events that could have

been sorted for the stream. sorted/(sorted + aborted)
Total Volume The percent of the collection volume relative to the tube size. (number of charged 

drops x droplet volume + initial volume)/tube volume
 • Grey: indicates the initial volume
 • Green: indicates that the collection volume is normal
 • Red: indicates that the collection volume reaches the limit. You need pause 

sorting and replace a new tube.

NOTE This Total Volume is based on theoretical estimation and may be 
inaccurate. Check the status of sample collection tube on a regular basis and 
replace the tube if it is nearly full.
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[Tube Sorting]

[Plate Sorting]
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Pause Sorting and Resume Sorting
In certain situations, you may want to pause data acquisition but continue the sampling so you can 
view events, and then resume data acquisition later. If a sort collection device has become full, but 
the sort is not complete, pause the sort to replace the sort collection device.
NOTE If the sample tube is empty, you must stop the sorting and then select Unload.

CAUTION
Risk of sample loss and biohazardous contamination if the sample collection tube 
overflows. Check the status of sample collection tube on a regular basis. Remove 
the sample collection tube when the tube is nearly full. Use suitable laboratory 
attire when removing the tube.

Replacing the Collection Devices

1 Select .

2 Open the sort chamber door.

3 Replace the full collection device with a new one.

Table 5.3  Additional Information for Plate Sorting

The green dot at the upper right corner indicates that the 
sorting of this well has completed. The target count of this 
well is 100. The sorting sequence is the 75th. 

The red square indicates that the sorting of this well is in 
process. 8 events have been collected.

“0” indicates that this well is to be sorted. The sorting 
sequence of this well is the 77th.
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4 Select  to reset the initial buffer volume.

5 Select  to resume sorting and acquiring data.

Index Sorting
You can use the index sorting to sort single cells onto a plate or slide, and index the well or slide 
location to the collected parameters for that cell. The index sorting helps to ensure that a sorted 
cell with a specific phenotype has been sorted. Index sorting is useful in characterizing 
subpopulations of phenotypically similar events using post-sort genetic, chemical, and/or 
metabolic applications.

1 Create an experiment. Refer to Creating an Experiment.

2 Load sample. Refer to Sampling and Collecting Data.

3 Create the plots and gates needed to define the populations of interest.

4 Set up for sorting. Refer to Setting Up Plate/Slide Sorting.

IMPORTANT If Index Sorting selected, the entire index sort data (within the acquisition recording limit) is 
automatically recorded during a sorting. You can export the data for post-sort analysis.

5 Verify that Index Sorting is selected.
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6 Select Sort to start sorting.

7 Select  from the drawing control tool bar to view the index sorting result.

8 Select the wells you want to index on the index sorting plot.
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9 Right-click on the gate and select Show as rare events.

NOTE Show as rare events is to increase the visibility of the gated population anywhere they appear 
on the plots.

You can see that the location of the populations is highlighted on the plot. 
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Sort Report

Creating a Sort Report

To create a sort report, select  from the tube management area. A new sort report page appears.
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Designing a Report

Select  on the sort report tool bar then select a property element to add to a report.
NOTE The Sort Report Setting is different for tube experiment and plate experiment. Refer to Figure 5.10 and 

Figure 5.11.

Figure 5.10  Sort Report Setting-Tube Experiment
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Figure 5.11  Sort Report Setting-Plate Experiment

Report Output
Reports can be either be printed or exported as a PDF or CSV file via the output icons on the report 
tool-bar. Refer to Figure 5.12.

Figure 5.12  Output Options on Sort Report Toolbar

Statistics-[With Index Sorting Disabled] Statistics-[With Index Sorting Enabled]
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Additional Information for Aseptic Sorting
Aseptic Sorting Workflow:

For instructions on the Aseptic Cleaning, refer to Aseptic Clean Program in CHAPTER 10, Cleaning 
Procedures.

Exporting Data

1 Select the sample tube to be analyzed.

2 Establish new gates or adjust the position of existing gates. Refer to Creating Plots and Gates.

NOTE Changing a gate’s position does not affect the positions of other gates already established on a 
given sample tube. Each test tube individually records the positions of its associated gates. If you 
need to make a change that concerns all the tubes, you must select the gate, then right-click the 
correctly positioned gate and select Apply to All Tubes.

3 Select . The Gate Hierarchy screen appears.

4 Check the relationship between the parent and daughter gates in the Gate Hierarchy window. 
NOTE Newly added gates become subsets of populations displayed in plots with existing gates. The 

name and display color can be modified. Right-click directly on a gate plot to change the name and 
color.

NOTE Select No Color to leave the gated events uncolored while retaining the color of the parent 
populations. By default, the populations defined by a vertical gate, hinged gate, or four-quadrant 
gate are uncolored.

Aseptic 
Cleaning Ô

System 
Startup Ô QC Ô

Sort 
calibration Ô

Create 
experiment Ô Sorting
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5 Right-click the plot and select Bring population to front to make the display color of the specified 
gate appear in front of all other colors, or select Send population to back to hide the display 
color of the specified gate behind all other colors.

6 Select  in the plot area to generate a statistical table.
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7 Right-click the table and select Statistics Setting to modify the settings of the statistics display 
parameters. The Statistics Setting window appears.
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The Statistics Setting window allows you to change the display of the header, statistical 
elements and cell populations included.
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The final generated plots appear as shown below.

8 Right-click a plot and select Export to Clipboard or Export to Graphic File from the drop-down 
menu to select an image to export.

 • Export to Clipboard copies the plot to the clipboard, allowing you to paste it directly into 
documents in common file formats.
NOTE Multiple plots can only be copied and pasted into Microsoft® Word. If a single plot is copied, 

this can be pasted into both Microsoft® Word or Microsoft® PowerPoint.
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 • Export to Graphic File saves the plot as an image file.
NOTE Export to Graphic File can export plots in two selectable file formats. BMP bitmap format 

and EMF vector format.

9 To export statistics, right-click a statistical table to select any one of the available export 
options.

 • Export to CSV File exports individual tube statistics as a single CSV file.
 • Export All Samples to CSV File exports all tube statistics as a single CSV file.
 • Export to Clipboard copies the statistics of an individual sample to the clipboard, allowing 

you to paste them directly into a Microsoft® Excel file or other file formats. 
 • Export All Samples to Clipboard assembles the statistics for all the sample tubes of an 

experiment and copies them together to the clipboard. From there they can be pasted as a 
group into a Microsoft® Excel file or other file formats.

 • Copy converts a statistical table into an image format that can be pasted into documents.

10 Export the FCS file if necessary. Refer to Exporting FCS Files. 
NOTE Ensure that any storage devices used with the instrument are free from viruses. To guard against 

data loss, Beckman Coulter recommends backing up data on a regular basis. Beckman Coulter is not 
liable for any loss of data resulting from computer viruses or damage to hardware.
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Exporting FCS Files

Exporting Single Tube Files

1 Right-click the desired tube from the test tube section of the screen and select Export FCS File. 
The Export FCS File window appears.
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2 Select the population from the Population dropdown menu.

3 Select either Area or Height. 
NOTE Select Index Sort to export the Index Sort data. The two parameters Sort Index-X and the Sort 

Index-Y will be added in the exported FCS file, which can be viewed by other analysis software.

4 Select the FCS format next to File Version.
NOTE The default setting is FCS 3.0. If FCS 2.0 is selected, select the parameter type (linear or log) from 

the parameter type section of the window.

NOTE The default CytExpert SRT FCS file contains high auto-fluorescence vector values that may not be 
recognized by third party software. Therefore, the data displays differently in third party software 
packages than in CytExpert SRT. Auto-fluorescence values are added for the FCS 3.0 (High 
auto-fluorescence) export option to accommodate the use of third party software. Since both FCS 
3.0 options have the same .fcs file extension, ensure that you save the FCS 3.0 (High 
auto-fluorescence) files to a different folder than the FCS 3.0 files.

5 Select OK to export the file.

6 Select the path to save the FCS file and select Save.
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Exporting Multiple FCS Files

1 Select Export FCS File from the File menu. The Export FCS File window appears.

2 Select the tubes to export and select Next.

3 Repeat Steps 2-5 from Exporting Single Tube Files.
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Exporting Plots or the Statistics Table of Multiple Tubes as Picture Files

1 Right-click on the plot or statistics to export.

2 Select Export Samples to Graphic File. The Export Samples to Graphic Files window appears.

3 Select the desired tubes to export.

4 Select OK.
NOTE The plots of the selected tubes save as .bmp file.
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Importing and Exporting Instrument Settings
The CytExpert SRT software supports importing and exporting instrument settings to facilitate the 
experiment process. Only instrument settings identical to the current configuration can be 
imported with current detector settings.

Select  to edit gain, threshold, and width. These can be imported from an 
experiment file or from a catalog of instrument settings.

Importing Instrument Settings

1 Select the desired sample tube to import. Then select .
NOTE Instrument settings can only be imported into tubes where data has not yet been recorded.
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2 Select Import From File, locate the file with the required instrument settings, or select Import 
From Catalog to import the instrument settings.
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Then the Information window displays.

3 Select OK.

Exporting Instrument Settings

1 Select the desired sample tube to export. Then select .

2 Select Export To File to export a current set of instrument settings, stored in a file ending in .acq. 
Or 
Select Export To Catalog, give a name to the settings to be exported, and export the file to the 
software’s Acquisition Setting Catalog, then select OK. 

3 Select Close.

Importing and Exporting Compensation Settings
The software supports unrestricted importing and exporting of compensation data, regardless of 
whether the sample tube data has already been acquired. Imported compensation values only cover 
channels identical with the current instrument configuration. The software automatically adjusts 
compensation values according to differences in the gain level. Refer to Importing and Exporting 
Compensation in CHAPTER 6, Compensation.
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Printing Graphics
CytExpert SRT offers printing functionality for the plots and tables that appear in the plot area. The 
software also allows you to save these images by converting them into .jpg or .pdf files.

Select  in the printer control area to print directly. Or, select the print drop-down arrow for 
the following options:

 •  Print Preview. Used to access the Preview screen.

— Select  to select the required format of the file to be exported and to save the file in 
that format.
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— Print preview also lets you choose between printing directly (1), modifying the printer 
configuration (2), or adjusting the page settings (3).

 •  Page Setup. Used to adjust the page settings.

 •  Batch Print. Used to print data for multiple tubes.
1. Select Batch Print. The Batch Print window appears.

2. Select the tubes to print.
3. Select OK.

b c d
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 •  Batch Export to PDF File. Used to print a PDF of the data for multiple tubes.
1. Select Batch Export to PDF File. The Batch Export to PDF File window appears.

2. Select the tube to print to PDF.
3. Select OK.

Saving the Experiment

Selecting Save in the File menu allows you to save the experiment. 
Selecting Save As and saving the experiment under a different name allows you to create a backup. 
Selecting Save As Template in the File menu allows you to save the experiment as a template.

Concluding the Experiment
Conclude the experiment as follows:
 • Select File > Close Experiment to close the experiment and return to the Start Page.

NOTE If changes were made to the experiment, the software prompts you to save the latest changes in 
the experiment before returning to the Start Page.

 • Shut down the system. Refer to CHAPTER 8, Shutting Down the System.
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CHAPTER 6
Compensation

Overview

This chapter describes how to create a compensation experiment and automatically calculate 
compensation values after acquiring the data. It also explains how to use these calculations for 
other experiments.
Compensation involves correction for fluorescence spillover emitted by the primary fluorochrome 
that is detected by the secondary fluorescent channels. For example, the excitation and the 
resulting fluorescence emission for the PE fluorochrome leads to the spillover fluorescence 
detected in the ECD, PC5.5, and PC7 channel. Compensation reduces the spillover fluorescence of 
the PE-positive population to match the background of the PE-negative population in the secondary 
channels. Compensation requires a single positive and a negative population for every single color 
sample.
Properly configured compensation minimizes false data interpretation caused by spillover 
fluorescence from another fluorochrome. Refer to Figure 6.1 and Figure 6.2 for an example of plots 
before and after compensation. Compensation adjustments can be completed during the data 
acquisition process or after the data acquisition process is complete.

Figure 6.1  Before Compensation
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Figure 6.2  After Compensation

NOTE CytExpert SRT compensation allows full matrix compensation, manual, and automatic.
CytExpert SRT compensation also includes a novel Compensation Library for storage of spillover values 
of dyes to easily determine the correct compensation matrix with new gain settings.

Workflow:

This chapter contains information on:
 • Creating a Compensation Experiment
 • Creating the Compensation Matrix from Previously Acquired Data
 • Adjusting Compensation

Creating a Compensation Experiment

Before creating a compensation experiment, you must verify the instrument’s detector 
configuration settings. Refer to Verifying, Selecting, Editing, and Creating Detector Configuration 
in CHAPTER 5, Sorting.

1 Select New Compensation in the File menu or on the start page to create a new compensation 
experiment.
NOTE The file name of the newly created compensation experiment has a “.xitc” suffix.

Prepare 
Compensation 

Samples
Ô

Create 
compensation 

experiment
Ô

Acquire and 
record data Ô

Calculate 
compensation Ô

Apply 
compensation 
to sample for 
data analysis
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2 Navigate to the desired file path and select Save. The Compensation Setup window appears.

CAUTION
Risk of erroneous results. Select an unstained tube, according to which the 
fluorescence background will be set. If there is not an unstained tube 
available, then each single color tube must have a negative population.
It is important to specify the appropriate sample type. Otherwise, the 
background information could be incorrectly calculated and lead to erroneous 
compensation results.

3 Select the channel requiring compensation calculation and the sample type. 
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If a negative population is not present in each single color tube, then an unstained control tube 
is recommended.
NOTE The default selection is Area. The unstained negative control tube can be selected if needed.

NOTE Label and lot number information can be retained in the Compensation Library to facilitate future 
compensation calculations.



C37808AC   6-5

Compensation
Creating a Compensation Experiment  6

4 Select OK.
After confirmation, the software automatically generates the following compensation 
experiment.

NOTE Select Area to calculate compensation based on the Area measured. Alternatively, select Height 
to calculate compensation based on the Height measured.

Preparing the Compensation Sample
To perform a compensation experiment, prepare:
 • A single positive control tube for each color
 •  A negative control tube (optional)

NOTE A negative control tube is required if a single positive control tube does not contain a negative 
population.

For the negative control sample and single positive control sample, you can use blood, cells, or 
dedicated compensation beads such as VersaComp Antibody Capture Beads. For details, refer to the 
appropriate reagent instructions for use. The negative control tube is used to determine the 
autofluorescence of the sample.
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Using Control Samples to Generate the Compensation Matrix

Defining the Negative Population Using Unstained Samples

1 Select Initialize to put the instrument in the Ready state.
NOTE Skip this step if the instrument has already been initialized.

CAUTION
Risk of erroneous results. Calculations based on excessively small volumes of 
sampled data can be inaccurate. Ensure that more than 1,000 positive events and 
more than 1,000 negative events are sampled. If the ratio of positive cells is 
comparatively low, increase the number of acquisition events to a suitable 
amount.

2 Import the gain setting and apply the setting to all tubes. Refer to Adjusting the Gain in 
CHAPTER 5, Sorting. Use the pan tool to adjust the axis scale so that the sample signal appears 
in a suitable position. Adjust the gate so that it encloses the target cell population. Refer to 
Creating Plots and Gates in CHAPTER 5, Sorting. 

3 Place the negative control tube in the sample tube holder.

4 Select the unstained tube.
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5 Select Run to load the sample.

6 Set an appropriate number of cells to save in Events to Record located on the left side of the 
screen.

7 Select Record to save the data.

Running the Single Positive Control Samples

1 Place the single positive tube in the sample station.

2  Select the appropriate, corresponding tube. 

3 Select Run to load the sample.
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CAUTION
Risk of erroneous results. Calculations based on excessively small volumes of 
sampled data can be inaccurate. Ensure that more than 1,000 positive events and 
more than 1,000 negative events are sampled. If the number of positive cells is 
comparatively low, increase the number of acquisition events to a suitable 
amount.

4 Move the gate in the FSC/SSC plot so that it encloses the desired population. Move the positive 
gate in the plot so that it encloses the positive population. 
NOTE Figure 6.3 shows an example of selecting the positive population when the negative population 

is defined by the unstained sample.

Figure 6.3  Positive Population Selected from the Single-Stained Sample 

1. Positive population

1
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NOTE Figure 6.4 shows an example of selecting both the positive and negative populations without an 
unstained sample.

Figure 6.4  Positive and Negative Populations Without an Unstained Sample

5 Select Record.

6 Repeat steps 1-5 to acquire data from subsequent single positive sample tubes. 

CAUTION
Risk of erroneous results. While the software automatically adjusts the 
compensation calculation according to gain, excessive manual adjustment of the 
fluorescence gain could lead to inaccurate results.

7 If necessary, adjust gain while acquiring data from single positive sample tubes. Refer to 
Adjusting the Gain in CHAPTER 5, Sorting.

1. Negative population
2. Positive population

21
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Calculating Compensation Values

1 Check all acquired sample tubes and confirm that the gating is appropriate.

2 Select  or select Compensation Calculation in the Compensation menu to calculate the 
compensation values.

The Compensation Matrix window appears, displaying the calculated compensation values.

NOTE The primary fluorescence channels are listed in columns; the secondary fluorescence channels 
are listed in rows.

NOTE In the Compensation Matrix window:
 • The Use checkbox applies the compensation to the selected sample.
 • The Show Autofluorescence checkbox displays the vectors for the autofluorescence.

3 Select Save As to export the compensation matrix as a .comp file and specify where to save it. 
NOTE The compensation matrix can also be imported for use in other experiments.
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4 Select Save To Compensation Library to save the single color compensation values in the 
compensation library. 

5 Specify the key words and select OK.

NOTE The settings stored in the compensation library are specific to the detector configuration. The 
compensation library can only be applied when the detector configurations are the same.

At any time, saved compensation experiments can be reopened and the compensation values 
recalculated.

6 Select Close.

Creating the Compensation Matrix from Previously Acquired Data

The software supports importing single color data acquired from other experiments into a 
compensation experiment to perform compensation calculations. The data to be imported must 
match the active detector configuration at the time that the compensation experiment was created. 
Otherwise, the data cannot be imported. It is important to ensure that imported data comes from 
the same instrument and uses the same configuration and channels. Data originating from a 
different instrument will cause erroneous calculations.
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1 Select New Compensation from the File menu or the start page.

2 To create a compensation experiment, select the required channels. Refer to Setting the 
Channel and Label in CHAPTER 5, Sorting.

3 Right-click on the appropriate test tube and select Import FCS File. Locate the corresponding 
data file and import the file. Only files compatible with the detector configuration are 
supported by the software for importing.

 in front of a test tube indicates that the corresponding data have been imported.

4 After importing the data, adjust the gates to properly identify the positive population and the 
negative population for each single-color sample.
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5 Calculate the compensation values and export them. Refer to Calculating Compensation Values.

Adjusting Compensation

Manually Adjusting Compensation
The compensation can be manually adjusted in an experiment in two ways:

 • Select the populations where needs to be adjusted in the bivariate plot. Select  from the 
graphic control area, then click and drag the mouse pointer up and down or left and right inside 
the plot to adjust compensation.

 • Select Compensation Matrix in the Setting menu to open the compensation matrix. Adjust the 
compensation value between the primary channel and the secondary channel. 

Importing and Exporting Compensation

Importing Compensation Settings from Compensation Matrix Files

1 Select the desired sample tube for importing compensation values. 

2 Select Compensation Matrix in the Setting menu.

3 Select Import and locate the path where compensation matrix files are saved. Select the 
corresponding compensation matrix file (.comp) to import the compensation values. 
You can also select Import from Library to import compensation values from the compensation 
library. The Import from Compensation Library window appears. Refer to Importing 
Compensation Settings from the Compensation Library.
Both methods allow you to import the compensation values with or without the adjustment 
based on the gain settings.
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4 After opening the desired compensation file, the Import Compensation window appears. Select 
one of the following:
 • Import compensation matrix and convert it with current gains.
 • Import compensation matrix.
 • Import compensation matrix and gain.

NOTE
 • If the tube does not have any data when importing compensation values calculated from other 

instrument settings, the software prompts you to select whether the gain settings must be 
imported as well. Select Yes to import fluorescence channel gains settings along with the rest 
of the data. Select No to allow the CytExpert SRT software to adjust the compensation matrix 
values based on the current gain settings.

 • If the tube does have data when importing compensation values from other instrument settings, 
the software prompts you to select whether the compensation values are adjusted based on the 
current gain settings. 

 • It is important to note that automatic adjustments to compensation values calculated from 
other instrument gain settings could result in incorrect compensation. Always review the data 
after importing compensation values to ensure the sample is compensated properly.

5 Select OK.

6 If necessary, select Apply to to apply the compensation values to the selected test tubes.

7 Select Close.
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Importing Compensation Settings from the Compensation Library
You can choose which single color data to include from the compensation library. Only single color 
data in the compensation library from the same detector configuration can be imported into the 
compensation matrix.
NOTE Files available in the compensation library are configuration-specific. The compensation library only 

displays the files created under the current default configuration.

1 Select Import From Compensation Library to select which compensation values to import from 
the compensation library.
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2 In the Keywords column, the corresponding compensation values can be selected for each 
channel. The compensation values of the same keyword can also be selected using the 
drop-down menus in the Keywords column.

3 Select OK to import the compensation values. 

Exporting Compensation Settings

1 Select the desired sample tube to export.

2 Select Compensation Matrix in the Setting menu.
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3 Select Export to specify a path and file name for the compensation file you are saving.

4 Select Save.
NOTE The generated file ends in .comp.
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Managing the Compensation Library
Compensation values can be managed in the Compensation Library. 

1 Select Compensation Library from the Settings menu. The Compensation Library window 
appears.

NOTE The Compensation Library is arranged by fluorescence detection channels. 

2 Select the desired single color sample. The compensation information appears on the right side 
of the window. 
NOTE Existing compensation values (height and area) can be modified by double-clicking the 

appropriate column in the Compensation Library window.

3 Enter the Label and Lot No. for the specified single color sample.

4 Select OK.
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Adding Channels for Compensation
Channels requiring compensation calculations that have not been previously acquired can be added 
to the compensation experiment by acquiring the necessary positive tubes.

1 In the compensation experiment, select  in the compensation controls, or select 
Compensation Setup in the Settings menu. The Compensation Setup window appears.

2 Select the channel that needs to be added and select OK.
The software automatically adds a new single positive tube to the compensation experiment. It 
also adds a plot with appropriate parameters in the negative control tube.
NOTE It is important to ensure that the data for the previously acquired negative control now includes 

the data of the newly added channel and that the settings are correct. Otherwise, you must 
reacquire the negative control tube and adjust the gain.

3 Repeat 1-2 to detect and acquire newly added single positive sample data.

4 Repeat Calculating Compensation Values to recalculate and export the compensation results.
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CHAPTER 7
Data Review

Overview

This chapter discusses how to use the Analysis screen to analyze data. Data can be analyzed using 
any computer equipped with the CytExpert SRT software. No online connection is required.
Workflow:

This chapter contains information on:
 • Copying Experiments and Importing Data
 • Setting the Plots and Statistics
 • Calculating Sample Concentration
 • Adjusting Compensation Settings
 • Exporting Results

Copying Experiments and Importing Data

Copying a Previously Acquired Experiment
Experiments acquired by other CytoFLEX instruments using CytExpert software can be imported to 
your computer for analysis, provided your computer also uses CytExpert SRT software.
Select Convert CytExpert Experiment in the File menu. Then select Browse to open the folder where 
the experiment data files are stored and select a path to save the converted experiment. Then, 
select OK.
NOTE The .xits and data folder must be stored in the same path.

Importing Previously Acquired Data
The CytExpert SRT software can import and analyze compatible FCS data files acquired by other 
Sorters or cytometers.

1 Create a new experiment or open a saved experiment. Refer to Creating an Experiment in 
CHAPTER 5, Sorting.

Import experiment or data Ô Plot and configure statistics Ô Export results
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2 In the new or opened experiment, select Import FCS File in the File menu to import the data 
files.

Imported data files appear in the Tube screen. 

The  symbol in front of each data tube indicates that the data tube is an imported data file. 
Imported data files are copied and saved in the folder where the current experiment data files 
are saved.
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Setting the Plots and Statistics

Opening the Analysis Screen

1 Select  on the left to enter the Analysis screen.

2 Copy plots obtained during data acquisition.

a. If you need original plots used during data acquisition, select  to access the Acquisition 
screen. 

b. Select the appropriate plots.
c. Right-click the selected plots and select Copy from the drop-down menu or press Ctrl+C to 

copy.

d. Select  to return to the Analysis screen. 
e. Select the required test tube from the tube list on the left side of the screen.
f. Right-click the plot area and select Paste from the drop-down menu or press Ctrl+V to paste 

the plot. 
NOTE Pasted plots include all gates, but the gate names are reassigned.

3 New plots can be created according to need. After selecting the test tubes requiring analysis, 
use the plotting control buttons at the top of the screen to create a new plot.
NOTE Each graph in the Analysis screen may correspond to different data. Pay special attention to each 

plot’s heading to avoid mistakes during analysis. 
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4 Use the sample selection controls in the graphics controls tool bar at the top of the page (see 
Figure 2.1) to change the data displayed in a plot.

a. Select the plot requiring a change to the data displayed. By pressing and holding the Ctrl 
key while selecting plots, you can select several plots at one time.

b. Select one of the two triangular sample selection buttons (  or ) to choose between 
the previous sample and the next sample, or select  to specify which data to display.

Creating Histogram and Dot Plot Overlays
The CytExpert SRT software supports histogram and dot plot data overlay functionality, allowing 
you to combine data from differing sources onto the same histogram or dot plot.

1 Select Histogram Overlay under the histogram icon drop-down list to create a new multi-data 
histogram.

Or
Select Dot Plot Overlay under the dot plot icon drop-down list to create a new dot plot overlay.
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IMPORTANT A maximum of 10 samples can be overlaid.

2 Select  to select samples for overlay display. Or, drag and drop samples from the tube list 
on the left into the histogram or dot plot overlay. The software automatically assigns different 
colors to different data.

To remove a sample, select  and uncheck the sample. Or, right-click the color legend and 
select Remove [sample name] or Remove All Sample. The corresponding data will no longer 
appear on the graph. 

3 To change the color selections, right-click on the sample name in the legend located on the 
right side of the plot and select Color from the drop-down menu. A color pallet appears. 

For configuring gates and generating statistics, refer to CHAPTER 5, Sorting.
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Calculating Sample Concentration

The CytoFLEX SRT instrument supports the calculation of the sample concentration based on the 
known concentration of the reference beads. The system does not support the direct calculation of 
concentration based on the volume.
NOTE If the Events/μL(V) checkbox is selected, the Events/μL(V) column displays #### in the statistics 

table. However, the system is compatible with the experiments using other CytExpert software. Select 
the Events/μL(V) checkbox to display the Events/μL(V) value if needed.

 • Select Statistics in the graphic controls tool bar to create a statistics table.
 • Right-click on the statistics table and select Statistics Setting. The Statistics Setting window 

appears.
 • Select the Statistics tab. Refer to Figure 7.1.
 • Select the Events/μL(B) checkbox and select the gated Beads Population.
 • Enter the total number of reference beads as the Beads Count, as well as the Sample Volume in 

total.
NOTE You can also enter the reference bead concentration directly in the Beads Count field and set the 

Sample Volume as 1.

 • The software automatically calculates the original sample concentration based on the input 
values. 

To obtain accurate calculations, throughout the data acquisition process, ensure that:

 • The sample concentration is 2 x 104-107 units/mL.
 • Samples are thoroughly mixed before loading and that they exhibit no apparent subsidence 

throughout the testing process.
 • The detection rate is maintained at less than 10,000 events/second throughout the sampling 

process. 
 • A constant sampling rate is maintained when recording data.
 • You acquire at least 10 μL of sampling volume.
NOTE While collecting samples, instantaneous data calculation can appear inaccurate. Regard the 

calculation as accurate only after data acquisition has been completed.
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Figure 7.1  Statistics Setting

Adjusting Compensation Settings

Data compensation can be carried out at any time. You can select the desired tube in the tube list 
on the left side of the screen and select  in the compensation controls, or select Compensation 
Setup in the Compensation menu. Refer to Adjusting Compensation in CHAPTER 6, Compensation, 
for detailed instructions on adjusting compensation settings.
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Exporting Results

Refer to Exporting Data in CHAPTER 5, Sorting.
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CHAPTER 8
Shutting Down the System

Overview

CAUTION
Risk of saline buildup in the fluidics system. Do not use the Urgent Stop button for 
routine shutdown. Urgent stop skips the important cleaning steps and may cause 
high carryover.

CAUTION
Risk of corrupting the embedded controller's file system. Do not skip the System 
Shutdown program to shut down the system. Turning off the main power switch 
located on the Sorter directly may corrupt the system.

This chapter provides procedures for shutting down the CytoFLEX SRT instrument.
Shutdown Workflow:

This chapter contains information on:
 • Running the Daily Clean
 • Running Shutdown Program

— System Shutdown
— Long Term Shutdown

 • Cleaning during Shutdown
 • Turning Off the Power

Running the Daily Clean

1 Select Initialize to put the instrument in the Ready state.
NOTE Skip this step if the instrument has already been initialized.

Daily Clean Ô
System 

Shutdown 
Program

Ô
Turn the 

instrument off Ô
Cleaning 

instrument
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2 Run Daily Clean to clean the sample line. Refer to Daily Clean Program in CHAPTER 10, Cleaning 
Procedures.

3 Select Standby to Turn off Sheath.

Running Shutdown Program

The System Shutdown Program is to rinse the sample line and perfuse the flow cell with the 
CytoFLEX SRT Shutdown fluid to prevent saline accumulation. 
It is required to run the System Shutdown Program every time you shut down the instrument. Refer 
to System Shutdown. However, if the instrument will not be used for more than 7 days, it is 
recommended to perform the Long Term Shutdown program. Refer to Long Term Shutdown.

System Shutdown

1 Select Standby to turn off the sheath. 

2 Select System Shutdown from the Cytometer menu. 
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The System Shutdown window appears.
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CAUTION
Risk of damage to the nozzle. When cleaning or replacing the nozzle, always 
handle with care to prevent the nozzle module from falling. 

3 Remove the nozzle module by pushing the metal release clamps inwards.

4 Select Next. The Confirm window displays. 
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5 Select Yes to start the System Shutdown program. The System Shutdown program takes about 
five minutes.
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Then the following window displays.

6 Perform the cleaning. Refer to Cleaning during Shutdown.
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7 Select Next. 

8 Select Close. 
The system enters into the idle state.

Long Term Shutdown
The Long Term Shutdown is only available when the system is in the idle state. 
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IMPORTANT Once you begin, ensure that you complete the entire Long Term Shutdown procedure before 
leaving the instrument. The entire process takes about 30 minutes.

IMPORTANT If the Long Term Shutdown procedure was terminated by accident, perform the following:
 • Empty the sheath tank and refill the sheath tank with IsoFlow sheath.
 • Switch the aseptic cleaning filter back to the sheath fluid filter
 • Restart the instrument
 • Run the System Startup Program.

Required materials
 • 1.5 L 70% ethanol in deionized water
 • An aseptic clean solution filter
 • A new waste air filter

1 Run System Shutdown program to put the system in idle state. Refer to System Shutdown. 

IMPORTANT Ensure that the sheath tank you used matches with the sheath tank type you selected. 
Otherwise, you could encounter System Startup failure, Aseptic Cleaning failure, Long-term Shutdown 
failure, or sheath flow indication error.

2 Verify that the sheath tank you used are matched with the sheath tank type you selected. Select 
Sheath Tank Scale Reset from the Advanced menu to display the current sheath tank type. 

3 Select Long Term Shutdown in the Cytometer menu. 
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The Long Term Shutdown window appears.
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CAUTION
Risk of damage to the nozzle. When cleaning or replacing the nozzle, always 
handle with care to prevent the nozzle module from falling. 

4 Remove the nozzle module by pushing the metal release clamps inwards.
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5 Select Next. The following window appears.
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WARNING
Risk of fire hazard. Ethanol is a volatile liquid that cannot be used near a fire 
source.

6 Empty the sheath tank and refill the sheath tank with at 1.5 L 70% ethanol. For instructions, 
refer to Filling the Sheath Tank in CHAPTER 11, Replacement/Adjustment Procedures

7 Replace the sheath fluid filter with an aseptic cleaning filter. For instructions, refer to 
Replacing the Aseptic Cleaning Solution Filter in CHAPTER 11, Replacement/Adjustment 
Procedures.

1.5L

  ethanol
(70%)

Aseptic Cleaning Solution Filter
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8 Replace the waste air filter with a new one. For instructions, refer to Replacing the Waste Air 
Filter in CHAPTER 11, Replacement/Adjustment Procedures.

9 Empty the waste container. For instructions, refer to Emptying the Waste Container in 
CHAPTER 11, Replacement/Adjustment Procedures.
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10 Select Next. The system starts cleaning the sheath line, flow cell, and sample probe with the 70% 
ethanol solution. This process takes about 15 minutes.
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Wait for the process to finish. The following window appears.

11 Perform the cleaning. Refer to Cleaning during Shutdown.
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12 Select Next. 

13 Select Close. The flow cell becomes empty.
NOTE The Long Term Shutdown program might introduce air bubbles into the system. Refer to 

Removing Trapped Air Bubbles in CHAPTER 11, Replacement/Adjustment Procedures.
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Cleaning during Shutdown

Use universal precautions when working with pathogenic materials. Means must be available to 
decontaminate the instrument and to dispose of biohazardous waste.

WARNING
Use barrier protection, including protective eye wear, gloves, and suitable 
laboratory attire. Refer to the Safety Data Sheet for details about chemical 
exposure before using chemicals.

Before you leave the instrument, clean the following instrument components:
 • Deflection plates
 • Nozzle 
 • Nozzle lift
 • Bottom of cuvette
 • Side stream illumination source
 • Stream detection window
 • Sort output holder
 • All surfaces inside sort chamber
 • Auxiliary door
 • Sample station

WARNING
Risk of chemical injury from bleach. To avoid contact with the bleach, use barrier 
protection, including protective eyewear, gloves, and suitable laboratory attire. 
Refer to the Safety Data Sheet for details about chemical exposure before using 
the chemical.

If a hazardous substance such as blood is spilled on the instrument, clean up the spill by using a 10% 
high-quality, fragrance-free, gel-free bleach solution, or use your laboratory decontamination 
solution. Then follow your laboratory procedure for disposal of hazardous materials. If the 
instrument needs to be decontaminated, contact us.

1 Clean the nozzle. For instructions, refer to Cleaning the Nozzle in CHAPTER 10, Cleaning 
Procedures.
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2 Clean the deflection plates and side stream illumination source. For instructions, refer to 
Cleaning the Side Stream Illumination Source and the Deflection Plates in CHAPTER 10, 
Cleaning Procedures.

3 Clean the nozzle lift. Refer to Daily Decontamination During Shutdown in CHAPTER 10, 
Cleaning Procedures.

4 Clean the side stream illumination source, the bottom of cuvette, the sort output holder, side 
stream detection window and sort chamber. Refer to Daily Decontamination During Shutdown 
in CHAPTER 10, Cleaning Procedures.

5 Optional: Clean and refill the sheath tank. Refer to Filling the Sheath Tank in CHAPTER 11, 
Replacement/Adjustment Procedures and Cleaning the Sheath Tank in CHAPTER 10, Cleaning 
Procedures.
NOTE Cleaning the sheath tank can be done daily or weekly as deemed appropriate by your laboratory 

manager.

6 Optional: Empty and clean the waste container. Refer to Emptying the Waste Container in 
Replacement/Adjustment Procedures, and Cleaning the Waste Container in CHAPTER 10, 
Cleaning Procedures.

Turning Off the Power

CAUTION
Risk of corrupting the embedded controller's file system. Do not skip the System 
Shutdown program to shut down the system. Turning off the main power switch 
located on the Sorter or unplug the Sorter’s power cable directly may corrupt the 
system.

NOTE Powering down is optional for daily shutdown but mandatory for the Long Term Shutdown.

1 Turn off the Sorter's main power switch located on the lower left side.
NOTE Turn off in the Cytometer menu can be used to remote power off the Sorter.

2 Exit the software.
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3 Turn the computer off.

4 Optional: Turn the Biosafety Cabinet off.
NOTE It is recommended to leave the Biosafety Cabinet on to save time for the thermal equilibrium if 

the Sorter will be used the next day.
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CHAPTER 9
Troubleshooting

Overview

IMPORTANT In addition to the information stated, never disassemble the instrument or have it repaired by 
unauthorized personnel. Beckman Coulter bears no responsibility for any problems arising from the 
unauthorized repair of the instrument. 

This chapter introduces solutions to common problems. If there is a problem, follow the 
information in this chapter to carry out self-inspection. If the problem cannot be resolved, contact 
us.
This chapter contains information on:
 • Laser Related Hazards
 • Hazard Labels and Locations
 • Disposal Precaution
 • Troubleshooting Table
 • Backup and Restore

Laser Related Hazards

Beckman Coulter design and manufacture of the instrument complies with the requirements 
governing the use and application of a laser specified in regulatory documents issued by the:
 • U.S. Department of Health and Human Services
 • Center for Devices and Radiological Health (CDRH)
 • International Electrotechnical Commission (IEC)
In compliance with these regulatory documents, every measure has been taken to ensure the health 
and safety of users and laboratory personnel from the possible dangers of laser use.
Use the instrument according to the information in the manuals.
Use controls or adjustments or performance of procedures other than those specified herein might 
result in hazardous radiation exposure.
To ensure your safety, the lasers are covered with protective shields. Do not remove these shields.
No user-serviceable assemblies are accessible. Do not attempt to remove the laser or open it. The 
instrument has components that are dangerous to the operator. If any attempt has been made to 
defeat a safety feature, or if the instrument fails to perform as described in its manuals, disconnect 
the power and contact us.
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Laser Beam Hazards
The CytoFLEX SRT instrument contains 4 solid-state diode lasers that are capable of producing laser 
light at the following levels: 
 • 405-nm, 90-mW solid-state diode laser
 • 488-nm, 50-mW solid-state diode laser
 • 561-nm, 30-mW solid-state diode laser
 • 638-nm, 100-mW solid-state diode laser
A laser beam is a unique light source that shows characteristics different from conventional light 
sources. The safe use of the laser depends upon familiarity with the instrument and the properties 
of coherent, intense beams of light.

WARNING
Risk of personal injury. The laser beam can cause eye damage if viewed either 
directly or indirectly from reflective surfaces (such as a mirror or shiny metallic 
surfaces). To prevent eye damage, avoid direct exposure to the laser beam. Do not 
view it directly or with optical instruments.

The laser beam can cause eye or skin damage, as well as instrument damage. The laser has enough 
power to ignite substances place in the beam path, even at a distance. Indirect contact with the laser 
beam from reflective surfaces (such as jewelry or a screwdriver) is called specular reflection and 
might also cause damage. 
For these reasons, use the following precautions when working near an exposed laser:
 • Never look directly into the laser light source or at scattered laser light from any reflective 

surface. Never look down the beam into the source.
 • As a precaution against accidental exposure to the output beam or its reflection, wear proper 

laser safety glasses (as required by the wavelength being used) when performing service or 
maintenance procedures on the system.

 • Do not use lasers in the presence of flammable material or explosives; these include volatile 
substances such as alcohol, solvents, and ether.

 • Avoid direct exposure and indirect reflection of the laser beam to your skin. The intensity of 
the beam can cause flesh burns.

 • Assure that any spectators are not potentially exposed to a hazardous condition.
 • Do not leave the laser unattended if there is a chance that an unauthorized person may try to 

use it.
 • Make the following recommendations to the laboratory:

— Limit access to the instrument. Keep the instrument out of hands of inexperienced and 
untrained personnel. 

— Never attempt to remove a shield housing a laser.
— Post warning signs at the site to alert personnel that lasers are being used.
— Never remove a warning label from the instrument.
— Contact us if a label is missing or unclear.
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Laser Warning Labels

WARNING
Risk of personal injury from radiation exposure. Never remove the shield 
surrounding a laser. Never remove covers.

CDRH-approved and IEC compliant labels are also placed near or on those covers that when 
removed might expose laser radiation. If necessary, a cover with a CDRH-approved or IEC compliant 
label must be removed by a qualified Beckman Coulter Representative only.
Refer to the following figures for the locations of the CDRH-approved and IEC compliant labels:

Refer to Figure 9.1 for the Laser Warning Label on the Sorter optical bench.
Refer to Figure 9.2 for the Laser Warning Label on the optical bench (located Inside the Sorter).
Refer to Figure 9.3 for the Laser Warning Labels on the Sorter Back Cover.

The laser product is classified as CLASS 1 when all protective measures are in place. This product 
complies with 21 CFR Parts 1040.10 and 1040.11 as well as EN60825-1. Refer to Figure 9.1. 

Figure 9.1  Laser Warning Label on the Laser Optical Bench
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Figure 9.2  Laser Warning Label within the Optical Bench (Located Inside the Sorter) 

Figure 9.3  Laser Warning Labels on the Sorter Back Cover 

Hazard Labels and Locations

Carefully read the hazard warning labels on the instrument. The hazard labels are located on the 
instrument as indicated. 
NOTE If a label is missing or unclear, contact us. 

CLASS  1 LASER PRODUCT
PRODUIT LASER CLASSE 1

CLASS  1 LASER PRODUCT

PRODUIT LASER CLASSE 1

CLASS 1 LASER PRODUCT

COMPLIES WITH 21 CFR 1040.10 AND 1040.11

EXCEPT FOR DEVIATIONS PURSUANT TO

LASER NOTICE NO. 56 DATED MAY 08, 2019

MANUFACTURED 

SN
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Biohazard Label and Location
Figure 9.4  Biohazard Label on the Fluidics Cart and Waste Container

Figure 9.5  Biohazard Label on the Sample Station and Sort Chamber 

DO NOT  OPEN  THE  SORTER 
PROTECTION  DOOR  DURING 
A SORTING PROCESS.
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Electrical Shock Hazard Label and Location
Figure 9.6  Electrical Shock Hazard Label 

Caution Labels and Location 
Figure 9.7  Caution Label on the Sorter Back Cover

DO NOT  OPEN  THE  SORTER 
PROTECTION  DOOR  DURING 
A SORTING PROCESS.

CLASS  1 LASER PRODUCT

PRODUIT LASER CLASSE 1

CLASS 1 LASER PRODUCT

COMPLIES WITH 21 CFR 1040.10 AND 1040.11

EXCEPT FOR DEVIATIONS PURSUANT TO

LASER NOTICE NO. 56 DATED MAY 08, 2019

MANUFACTURED 

SN
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Figure 9.8  Label on the Sort Protection Door 

Figure 9.9  Caution Label on the Sample Station

DO NOT  OPEN  THE  SORTER 
PROTECTION  DOOR  DURING 
A SORTING PROCESS.

DO NOT  OPEN  THE  SORTER 
PROTECTION  DOOR  DURING 
A SORTING PROCESS.
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Pinch Hazard Labels and Location
Figure 9.10  Pinch Hazard Label on the Sample Station

Figure 9.11  Pinch Hazard Label on the Sort Chamber

DO NOT  OPEN  THE  SORTER 
PROTECTION  DOOR  DURING 
A SORTING PROCESS.
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Disposal Precaution

WARNING
Risk of biohazardous contamination if you have skin contact with the waste 
container, its contents, and its associated tubing. The waste container and its 
associated tubing could contain residual biological material and must be handled 
with care. Clean up spills immediately. Dispose of the contents of the waste 
container in accordance with your local regulations and acceptable laboratory 
procedures.

Use universal precautions when working with pathogenic materials. Means must be available to 
decontaminate the instrument and to dispose of biohazardous waste.

Troubleshooting Table

Table 9.1 and Table 9.2 list problems that you could encounter while running the Sorter, the 
probable causes of each problem, and the corrective actions. These problems are listed 
alphabetically in the Index, under the primary entry “troubleshooting.”
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Table 9.1  Troubleshooting-[Error Codes]

Problem Probable Cause Corrective Action

[Error code 010037] Bubble 
detector error.

 • The silicone tubing is not 
completely seated in the slot of 
the sample line bubble detector.

 • Tube holder contains water.
 • The sample probe height is not 

accurate.
 • The bubble detector is defective.
 • Bubble Detector Calibration is not run 

after replacing the sample line.

1. Verify that the joint between the silicone tubing and 
the PEEK tubing is completely in the slot of bubble 
detector. Refer to Steps19 -21 in Replacing the 
Sample Line.

2. Verify that the tube holder is clean and dry.
3. Verify that the sample probe height is accurate. 

Refer to Steps 10 - 14 in CHAPTER 11, Replacement/
Adjustment Procedures. 

4. Calibrate the bubble detector again. Refer to 
Calibrating the Sample Line Bubble Detector.

5. If the problem persists, contact us.
[Error code 060048] Failed to 
set the charge phase. No 
droplet is detected.

 • The fluid stream is unstable.
 • The side stream illumination is 

defective or not installed.
 • The charge drive board is defective.
 • The acquisition circuit board is 

defective.
 • The photodiodes are defective.
 • High-voltage components are 

broken.

1. Select Standby to turn off the sheath.
2. Verify that the nozzle is clean and O-ring is present. 

 • Clean the nozzle if needed. Refer to Cleaning the 
Nozzle in CHAPTER 10, Cleaning Procedures.

 • If necessary, replace the O-ring. Refer to 
Replacing the O-Ring in CHAPTER 11, 
Replacement/Adjustment Procedures.

 • If the nozzle is damaged, replace the nozzle. 
Refer to Replacing the Nozzle in CHAPTER 11, 
Replacement/Adjustment Procedures.

3. Reinstall the nozzle module. Refer to Removing/
Installing the Nozzle Module in CHAPTER 11, 
Replacement/Adjustment Procedures.

4. Run Flow Cell Debubble. Refer to Performing the 
Flow Cell De-bubble in CHAPTER 11, Replacement/
Adjustment Procedures.

5. Run Sheath Filter debubble. Refer to Performing the 
Sheath Filter De-bubble in CHAPTER 11, 
Replacement/Adjustment Procedures.

6. Run Daily Clean. Refer to Daily Clean Program in 
CHAPTER 10, Cleaning Procedures.

7. Run Flow cell Clean. Refer to Flow Cell Clean 
Program in CHAPTER 10, Cleaning Procedures.

8. Clean the side stream illumination source. Refer to 
Cleaning the Side Stream Illumination Source and 
the Deflection Plates in CHAPTER 10, Cleaning 
Procedures.

9. If the problem persists, contact us.
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[Error code 060049] The charge 
phase value is out of range.

 • The fluid stream is unstable.
 • The photodiodes are defective.
 • The charge drive board is defective.

1. Select Standby to turn off the sheath.
2. Verify that the nozzle is clean and O-ring is present. 

 • Clean the nozzle if needed. Refer to Cleaning the 
Nozzle in CHAPTER 10, Cleaning Procedures.

 • If necessary, replace the O-ring. Refer to 
Replacing the O-Ring in CHAPTER 11, 
Replacement/Adjustment Procedures.

 • If the nozzle is damaged, replace the nozzle. 
Refer to Replacing the Nozzle in CHAPTER 11, 
Replacement/Adjustment Procedures.

3. Reinstall the nozzle module. Refer to Removing/
Installing the Nozzle Module in CHAPTER 11, 
Replacement/Adjustment Procedures.

4. Run Flow Cell Debubble. Refer to Performing the 
Flow Cell De-bubble in CHAPTER 11, Replacement/
Adjustment Procedures.

5. Run Sheath Filter debubble. Refer to Performing the 
Sheath Filter De-bubble in CHAPTER 11, 
Replacement/Adjustment Procedures.

6. Run Daily Clean. Refer to Daily Clean Program in 
CHAPTER 10, Cleaning Procedures.

7. Run Flow cell Clean. Refer to Flow Cell Clean 
Program in CHAPTER 10, Cleaning Procedures.

8. Clean the side stream illumination and the deflection 
plates. Refer to Cleaning the Side Stream 
Illumination Source and the Deflection Plates in 
CHAPTER 10, Cleaning Procedures.

9. Wipe the side stream detection window. Refer to 
Figure 1.23.

10. Verify that the nozzle lift is clean and dry. Refer to 
Steps 4 - 6 in CHAPTER 10, Cleaning Procedures.

11. If the problem persists, contact us.

Table 9.1  Troubleshooting-[Error Codes] (Continued)

Problem Probable Cause Corrective Action
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[Error code 060050] Failed to 
set the charge voltage of R1 
stream.

 • The fluid stream is unstable.
 • The photodiodes are defective.
 • The charging drive board is defective.
 • Electric leakage of high-voltage 

component.

1. Select Standby to turn off the sheath.
2. Verify that the nozzle is clean and O-ring is present. 

 • Clean the nozzle if needed. Refer to Cleaning the 
Nozzle in CHAPTER 10, Cleaning Procedures.

 • If necessary, replace the O-ring. Refer to 
Replacing the O-Ring in CHAPTER 11, 
Replacement/Adjustment Procedures.

 • If the nozzle is damaged, replace the nozzle. 
Refer to Replacing the Nozzle in CHAPTER 11, 
Replacement/Adjustment Procedures.

3. Reinstall the nozzle module. Refer to Removing/
Installing the Nozzle Module in CHAPTER 11, 
Replacement/Adjustment Procedures.

4. Run Flow Cell Debubble. Refer to Performing the 
Flow Cell De-bubble in CHAPTER 11, Replacement/
Adjustment Procedures.

5. Run Sheath Filter debubble. Refer to Performing the 
Sheath Filter De-bubble in CHAPTER 11, 
Replacement/Adjustment Procedures.

6. Run Daily Clean. Refer to Daily Clean Program in 
CHAPTER 10, Cleaning Procedures.

7. Run Flow cell Clean. Refer to Flow Cell Clean 
Program in CHAPTER 10, Cleaning Procedures.

8. Wipe the side stream detection window. Refer to 
Figure 1.23.

9. Clean the side stream illumination and the deflection 
plates. Refer to Cleaning the Side Stream 
Illumination Source and the Deflection Plates in 
CHAPTER 10, Cleaning Procedures.

10. Verify that the nozzle lift is clean and dry. Refer to 
Steps 4 - 6 in CHAPTER 10, Cleaning Procedures.

11. If the problem persists, contact us.

Table 9.1  Troubleshooting-[Error Codes] (Continued)

Problem Probable Cause Corrective Action
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[Error code 060051] Charge 
phase verification failed.

 • The fluid stream is unstable.
 • The photodiodes are defective.
 • The charging drive board is defective.
 • Electric leakage of high-voltage 

component.

1. Select Standby to turn off the sheath.
2. Verify that the nozzle is clean and O-ring is present. 

 • Clean the nozzle if needed. Refer to Cleaning the 
Nozzle in CHAPTER 10, Cleaning Procedures.

 • If necessary, replace the O-ring. Refer to 
Replacing the O-Ring in CHAPTER 11, 
Replacement/Adjustment Procedures.

 • If the nozzle is damaged, replace the nozzle. 
Refer to Replacing the Nozzle in CHAPTER 11, 
Replacement/Adjustment Procedures.

3. Reinstall the nozzle module. Refer to Removing/
Installing the Nozzle Module in CHAPTER 11, 
Replacement/Adjustment Procedures.

4. Run Flow Cell Debubble. Refer to Performing the 
Flow Cell De-bubble in CHAPTER 11, Replacement/
Adjustment Procedures.

5. Run Sheath Filter debubble. Refer to Performing the 
Sheath Filter De-bubble in CHAPTER 11, 
Replacement/Adjustment Procedures.

6. Run Daily Clean. Refer to Daily Clean Program in 
CHAPTER 10, Cleaning Procedures.

7. Run Flow cell Clean. Refer to Flow Cell Clean 
Program in CHAPTER 10, Cleaning Procedures.

8. Clean the side stream illumination and the deflection 
plates. Refer to Cleaning the Side Stream 
Illumination Source and the Deflection Plates in 
CHAPTER 10, Cleaning Procedures.

9. Wipe the side stream detection window. Refer to 
Figure 1.23.

10. Verify that the nozzle lift is clean and dry. Refer to 
Steps 4 - 6 in CHAPTER 10, Cleaning Procedures.

11. Verify that the ambient temperature in the lab is 
within the range (15-27 ℃), and the fluctuation is 
within < ±2 °C. Use appropriate air condition if 
necessary.

12. If the problem persists, contact us.

Table 9.1  Troubleshooting-[Error Codes] (Continued)

Problem Probable Cause Corrective Action
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[Error code 060052] Charge 
phase optimization failed.

 • The fluid stream is unstable.
 • The photodiodes are defective.
 • Airflow interference.
 • The narrow slot mask of the PD is 

partly or completely blocked.

1. Select Standby to turn off the sheath.
2. Verify that the nozzle is clean and O-ring is present. 

 • Clean the nozzle if needed. Refer to Cleaning the 
Nozzle in CHAPTER 10, Cleaning Procedures.

 • If necessary, replace the O-ring. Refer to 
Replacing the O-Ring in CHAPTER 11, 
Replacement/Adjustment Procedures.

 • If the nozzle is damaged, replace the nozzle. 
Refer to Replacing the Nozzle in CHAPTER 11, 
Replacement/Adjustment Procedures.

3. Reinstall the nozzle module. Refer to Removing/
Installing the Nozzle Module in CHAPTER 11, 
Replacement/Adjustment Procedures.

4. Run Flow Cell Debubble. Refer to Performing the 
Flow Cell De-bubble in CHAPTER 11, Replacement/
Adjustment Procedures.

5. Run Sheath Filter debubble. Refer to Performing the 
Sheath Filter De-bubble in CHAPTER 11, 
Replacement/Adjustment Procedures.

6. Run Daily Clean. Refer to Daily Clean Program in 
CHAPTER 10, Cleaning Procedures.

7. Run Flow cell Clean. Refer to Flow Cell Clean 
Program in CHAPTER 10, Cleaning Procedures.

8. Clean the side stream illumination and the deflection 
plates. Refer to Cleaning the Side Stream 
Illumination Source and the Deflection Plates in 
CHAPTER 10, Cleaning Procedures.

9. Wipe the side stream detection window. Refer to 
Figure 1.23.

10. Verify that the nozzle lift is clean and dry. Refer to 
Steps 4 - 6 in CHAPTER 10, Cleaning Procedures.

11. Verify that the ambient temperature in the lab is 
within the range (15-27 ℃), and the fluctuation is 
within < ±2 °C. Use appropriate air condition if 
necessary.

12. Verify that the Sorter is not exposed directly to a 
ventilation outlet of an air condition.

13. Rerun Sort Calibration. Refer to Sort Calibration 
(Auto Drop Delay) in CHAPTER 5, Sorting. 

14. If the problem persists, contact us.

Table 9.1  Troubleshooting-[Error Codes] (Continued)

Problem Probable Cause Corrective Action
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[Error code 060053] The charge 
voltage of L2 stream is out of 
range.
[Error code 060054] The charge 
voltage of L1 stream is out of 
range.
[Error code 060056] The charge 
voltage of R1 stream is out of 
range.
[Error code 060057] The charge 
voltage of R2 stream is out of 
range.

 • The fluid stream is unstable.
 • The photodiodes are defective.
 • Airflow interference.
 • Electric leakage of high-voltage 

component.
 • Leakage of the fluidics system.
 • The narrow slot mask of the PD is 

partly or completely blocked.
 • The core stream or the side stream 

Hardware is not straight enough. 

1. Select Standby to turn off the sheath.
2. Verify that the nozzle is clean and O-ring is present. 

 • Clean the nozzle if needed. Refer to Cleaning the 
Nozzle in CHAPTER 10, Cleaning Procedures.

 • If necessary, replace the O-ring. Refer to 
Replacing the O-Ring in CHAPTER 11, 
Replacement/Adjustment Procedures.

 • If the nozzle is damaged, replace the nozzle. 
Refer to Replacing the Nozzle in CHAPTER 11, 
Replacement/Adjustment Procedures.

3. Reinstall the nozzle module. Refer to Removing/
Installing the Nozzle Module in CHAPTER 11, 
Replacement/Adjustment Procedures.

4. Run Flow Cell Debubble. Refer to Performing the 
Flow Cell De-bubble in CHAPTER 11, Replacement/
Adjustment Procedures.

5. Run Sheath Filter debubble. Refer to Performing the 
Sheath Filter De-bubble in CHAPTER 11, 
Replacement/Adjustment Procedures.

6. Run Daily Clean. Refer to Daily Clean Program in 
CHAPTER 10, Cleaning Procedures.

7. Run Flow cell Clean. Refer to Flow Cell Clean 
Program in CHAPTER 10, Cleaning Procedures.

8. Wipe the side stream detection window. Refer to 
Figure 1.23.

9. Clean the side stream illumination and the deflection 
plates. Refer to Cleaning the Side Stream 
Illumination Source and the Deflection Plates in 
CHAPTER 10, Cleaning Procedures.

10. Verify that the nozzle lift is clean and dry. Refer to 
Steps 4 - 6 in CHAPTER 10, Cleaning Procedures.

11. Ensure that the ambient temperature in the lab is 
stable and within the range (15-27 ℃), and the 
fluctuation is within < ±2 °C. Use appropriate air 
condition if necessary.

12. Verify that the Sorter is not exposed directly to a 
ventilation outlet of an air condition.

13. Rerun Sort Calibration. Refer to Sort Calibration 
(Auto Drop Delay) in CHAPTER 5, Sorting. 

14. If the problem persists, contact us.

Table 9.1  Troubleshooting-[Error Codes] (Continued)

Problem Probable Cause Corrective Action
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[Error code 060058] Failed to 
optimize the charge voltage for 
L2 stream.
[Error code 060059] Failed to 
optimize the charge voltage for 
L1 stream.
[Error code 060060] Failed to 
optimize the charge voltage for 
R1 stream.
[Error code 060061] Failed to 
optimize the charge voltage for 
R2 stream.
[Error code 060062] Failed to 
optimize the charge voltage for 
central stream.

 • The fluid stream is unstable.
 • The photodiodes are defective.
 • Airflow interference.
 • Electric leakage of high-voltage 

component.
 • Leakage of the fluidics system.
 • The narrow slot mask of the PD is 

partly or completely blocked.
 • The core stream or the side stream 

Hardware is not straight enough. 

1. Select Standby to turn off the sheath.
2. Verify that the nozzle is clean and O-ring is present. 

 • Clean the nozzle if needed. Refer to Cleaning the 
Nozzle in CHAPTER 10, Cleaning Procedures.

 • If necessary, replace the O-ring. Refer to 
Replacing the O-Ring in CHAPTER 11, 
Replacement/Adjustment Procedures.

 • If the nozzle is damaged, replace the nozzle. 
Refer to Replacing the Nozzle in CHAPTER 11, 
Replacement/Adjustment Procedures.

3. Reinstall the nozzle module. Refer to Removing/
Installing the Nozzle Module in CHAPTER 11, 
Replacement/Adjustment Procedures.

4. Run Flow Cell Debubble. Refer to Performing the 
Flow Cell De-bubble in CHAPTER 11, Replacement/
Adjustment Procedures.

5. Run Sheath Filter debubble. Refer to Performing the 
Sheath Filter De-bubble in CHAPTER 11, 
Replacement/Adjustment Procedures.

6. Run Daily Clean. Refer to Daily Clean Program in 
CHAPTER 10, Cleaning Procedures.

7. Run Flow cell Clean. Refer to Flow Cell Clean 
Program in CHAPTER 10, Cleaning Procedures.

8. Clean the side stream illumination and the deflection 
plates. Refer to Cleaning the Side Stream 
Illumination Source and the Deflection Plates in 
CHAPTER 10, Cleaning Procedures.

9. Wipe the side stream detection window. Refer to 
Figure 1.23.

10. Verify that the nozzle lift is clean and dry. Refer to 
Steps 4 - 6 in CHAPTER 10, Cleaning Procedures.

11. Ensure that the ambient temperature in the lab is 
stable and within the range (15-27 ℃), and the 
fluctuation is within < ±2 °C. Use appropriate air 
condition if necessary.

12. Verify that the Sorter is not exposed directly to a 
ventilation outlet of an air condition.

13. Rerun Sort Calibration. Refer to Sort Calibration 
(Auto Drop Delay) in CHAPTER 5, Sorting. 

14. If the problem persists, contact us.

Table 9.1  Troubleshooting-[Error Codes] (Continued)

Problem Probable Cause Corrective Action
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[Error code 060063] Failed to 
determine the Detector Delay 
for L2 stream. 
[Error code 060064] Failed to 
determine the Detector Delay 
for L1 stream. 
[Error code 060065] Failed to 
determine the Detector Delay 
for R1 stream. 
[Error code 060066] Failed to 
determine the Detector Delay 
for R2 stream. 
[Error code 060067] Failed to 
determine the Detector Delay 
for Gap detector. 
[Error code 060068] Failed to 
determine the Detector Delay 
for Central stream. 

 • The fluid stream is unstable.
 • The photodiodes are defective.
 • Airflow interference.
 • Electric leakage of high-voltage 

component.
 • Leakage of the fluidics system.
 • The narrow slot mask of the PD is 

partly or completely blocked.
 • The core stream or the side stream 

module is not aligned. 

1. Select Standby to turn off the sheath.
2. Clean the side stream illumination and the deflection 

plates. Refer to Cleaning the Side Stream 
Illumination Source and the Deflection Plates in 
CHAPTER 10, Cleaning Procedures.

3. Wipe the side stream detection window. Refer to 
Figure 1.23.

4. Verify that the nozzle is clean and O-ring is present. 
 • Clean the nozzle if needed. Refer to Cleaning the 

Nozzle in CHAPTER 10, Cleaning Procedures.
 • If necessary, replace the O-ring. Refer to 

Replacing the O-Ring in CHAPTER 11, 
Replacement/Adjustment Procedures.

 • If the nozzle is damaged, replace the nozzle. 
Refer to Replacing the Nozzle in CHAPTER 11, 
Replacement/Adjustment Procedures.

5. Reinstall the nozzle module. Refer to Removing/
Installing the Nozzle Module in CHAPTER 11, 
Replacement/Adjustment Procedures.

6. Run Flow Cell Debubble. Refer to Performing the 
Flow Cell De-bubble in CHAPTER 11, Replacement/
Adjustment Procedures.

7. Run Sheath Filter debubble. Refer to Performing the 
Sheath Filter De-bubble in CHAPTER 11, 
Replacement/Adjustment Procedures.

8. Run Daily Clean. Refer to Daily Clean Program in 
CHAPTER 10, Cleaning Procedures.

9. Run Flow cell Clean. Refer to Flow Cell Clean 
Program in CHAPTER 10, Cleaning Procedures.

10. Verify that the Sorter is not exposed directly to a 
ventilation outlet of an air condition.

11. Rerun Sort Calibration. Refer to Sort Calibration 
(Auto Drop Delay) in CHAPTER 5, Sorting. 

12.  Restart the system. Refer to CHAPTER 3, Daily 
Startup.

13. If the problem persists, contact us.

Table 9.1  Troubleshooting-[Error Codes] (Continued)

Problem Probable Cause Corrective Action
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[Error code 060069] Scan 
defanning value error.

 • The fluid stream is unstable.
 • The photodiodes are defective.
 • Airflow interference.

1. Select Standby to turn off the sheath.
2. Clean the side stream illumination and the deflection 

plates. Refer to Cleaning the Side Stream 
Illumination Source and the Deflection Plates in 
CHAPTER 10, Cleaning Procedures.

3. Wipe the side stream detection window. Refer to 
Figure 1.23.

4. Verify that the nozzle is clean and O-ring is present. 
 • Clean the nozzle if needed. Refer to Cleaning the 

Nozzle in CHAPTER 10, Cleaning Procedures.
 • If necessary, replace the O-ring. Refer to 

Replacing the O-Ring in CHAPTER 11, 
Replacement/Adjustment Procedures.

 • If the nozzle is damaged, replace the nozzle. 
Refer to Replacing the Nozzle in CHAPTER 11, 
Replacement/Adjustment Procedures.

5. Reinstall the nozzle module. Refer to Removing/
Installing the Nozzle Module in CHAPTER 11, 
Replacement/Adjustment Procedures.

6. Run Flow Cell Debubble. Refer to Performing the 
Flow Cell De-bubble in CHAPTER 11, Replacement/
Adjustment Procedures.

7. Run Sheath Filter debubble. Refer to Performing the 
Sheath Filter De-bubble in CHAPTER 11, 
Replacement/Adjustment Procedures.

8. Run Daily Clean. Refer to Daily Clean Program in 
CHAPTER 10, Cleaning Procedures.

9. Run Flow cell Clean. Refer to Flow Cell Clean 
Program in CHAPTER 10, Cleaning Procedures.

10. Verify that the Sorter is not exposed directly to a 
ventilation outlet of an air condition.

11. Rerun Sort Calibration. Refer to Sort Calibration 
(Auto Drop Delay) in CHAPTER 5, Sorting. 

12. If the problem persists, contact us.

Table 9.1  Troubleshooting-[Error Codes] (Continued)

Problem Probable Cause Corrective Action
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[Error code 060070] The Central 
stream is not tight.

 • The fluid stream is unstable.
 • The photodiodes are defective.
 • Airflow interference.

1. Select Standby to turn off the sheath.
2. Clean the side stream illumination and the deflection 

plates. Refer to Cleaning the Side Stream 
Illumination Source and the Deflection Plates in 
CHAPTER 10, Cleaning Procedures.

3. Wipe the side stream detection window. Refer to 
Figure 1.23.

4. Verify that the nozzle is clean and O-ring is present. 
 • Clean the nozzle if needed. Refer to Cleaning the 

Nozzle in CHAPTER 10, Cleaning Procedures.
 • If necessary, replace the O-ring. Refer to 

Replacing the O-Ring in CHAPTER 11, 
Replacement/Adjustment Procedures.

 • If the nozzle is damaged, replace the nozzle. 
Refer to Replacing the Nozzle in CHAPTER 11, 
Replacement/Adjustment Procedures.

5. Reinstall the nozzle module. Refer to Removing/
Installing the Nozzle Module in CHAPTER 11, 
Replacement/Adjustment Procedures.

6. Run Flow Cell Debubble. Refer to Performing the 
Flow Cell De-bubble in CHAPTER 11, Replacement/
Adjustment Procedures.

7. Run Sheath Filter debubble. Refer to Performing the 
Sheath Filter De-bubble in CHAPTER 11, 
Replacement/Adjustment Procedures.

8. Run Daily Clean. Refer to Daily Clean Program in 
CHAPTER 10, Cleaning Procedures.

9. Run Flow cell Clean. Refer to Flow Cell Clean 
Program in CHAPTER 10, Cleaning Procedures.

10. Verify that the Sorter is not exposed directly to a 
ventilation outlet of an air condition.

11. Rerun Sort Calibration. Refer to Sort Calibration 
(Auto Drop Delay) in CHAPTER 5, Sorting. 

12.  Restart the system. Refer to CHAPTER 3, Daily 
Startup.

13. If the problem persists, contact us.

Table 9.1  Troubleshooting-[Error Codes] (Continued)

Problem Probable Cause Corrective Action
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[Error code 060075] The 
defanning value is out of range.

 • The fluid stream is unstable.
 • The photodiodes are defective.
 • Airflow interference.

1. Select Standby to turn off the sheath.
2. Clean the side stream illumination and the deflection 

plates. Refer to Cleaning the Side Stream 
Illumination Source and the Deflection Plates in 
CHAPTER 10, Cleaning Procedures.

3. Wipe the side stream detection window. Refer to 
Figure 1.23.

4. Verify that the nozzle is clean and O-ring is present. 
 • Clean the nozzle if needed. Refer to Cleaning the 

Nozzle in CHAPTER 10, Cleaning Procedures.
 • If necessary, replace the O-ring. Refer to 

Replacing the O-Ring in CHAPTER 11, 
Replacement/Adjustment Procedures.

 • If the nozzle is damaged, replace the nozzle. 
Refer to Replacing the Nozzle in CHAPTER 11, 
Replacement/Adjustment Procedures.

5. Reinstall the nozzle module. Refer to Removing/
Installing the Nozzle Module in CHAPTER 11, 
Replacement/Adjustment Procedures.

6. Run Flow Cell Debubble. Refer to Performing the 
Flow Cell De-bubble in CHAPTER 11, Replacement/
Adjustment Procedures.

7. Run Sheath Filter debubble. Refer to Performing the 
Sheath Filter De-bubble in CHAPTER 11, 
Replacement/Adjustment Procedures.

8. Run Daily Clean. Refer to Daily Clean Program in 
CHAPTER 10, Cleaning Procedures.

9. Run Flow cell Clean. Refer to Flow Cell Clean 
Program in CHAPTER 10, Cleaning Procedures.

10. Verify that the Sorter is not exposed directly to a 
ventilation outlet of an air condition.

11. Rerun Sort Calibration. Refer to Sort Calibration 
(Auto Drop Delay) in CHAPTER 5, Sorting. 

12.  Restart the system. Refer to CHAPTER 3, Daily 
Startup.

13. If the problem persists, contact us.

Table 9.1  Troubleshooting-[Error Codes] (Continued)
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[Error code 060093] The central 
stream is not aligned with the 
detectors.

 • The fluid stream is unstable.
 • The photodiodes are defective.
 • The nozzle is clogged or damaged.
 • Air bubbles are in the system.
 • Airflow interference.
 • Leakage of the fluidics system.
 • Electric leakage of high-voltage 

components.
 • The narrow slot mask of the PD is 

partly or completely blocked.
 • The side stream detector or gap 

detector are not aligned with the core 
stream. 

1. Select Standby to turn off the sheath.
2. Wipe the side stream detection window. Refer to 

Figure 1.23.
3. Verify that the nozzle is clean and O-ring is present. 

 • Clean the nozzle if needed. Refer to Cleaning the 
Nozzle in CHAPTER 10, Cleaning Procedures.

 • If necessary, replace the O-ring. Refer to 
Replacing the O-Ring in CHAPTER 11, 
Replacement/Adjustment Procedures.

 • If the nozzle is damaged, replace the nozzle. 
Refer to Replacing the Nozzle in CHAPTER 11, 
Replacement/Adjustment Procedures.

4. Reinstall the nozzle module. Refer to Removing/
Installing the Nozzle Module in CHAPTER 11, 
Replacement/Adjustment Procedures.

5. Run Flow Cell Debubble. Refer to Performing the 
Flow Cell De-bubble in CHAPTER 11, Replacement/
Adjustment Procedures.

6. Run Sheath Filter debubble. Refer to Performing the 
Sheath Filter De-bubble in CHAPTER 11, 
Replacement/Adjustment Procedures.

7. Run Daily Clean. Refer to Daily Clean Program in 
CHAPTER 10, Cleaning Procedures.

8. Run Flow cell Clean. Refer to Flow Cell Clean 
Program in CHAPTER 10, Cleaning Procedures.

9. Verify that the Sorter is not exposed directly to a 
ventilation outlet of an air condition.

10. If the problem persists, contact us.

Table 9.1  Troubleshooting-[Error Codes] (Continued)
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[Error code 070004] No stream 
is detected. 

 • The camera USB cable is not securely 
connected.

 • Some quick connectors for the sheath 
line are not securely connected.

 • The clogged nozzle blocks the fluid 
stream.

 • The O-ring is missing or damaged.
 • Air bubbles get into the sheath filter, 

or flow cell. 
 • The fluid leaks around the nozzle.
 • The abnormal sheath pressure 

causes the break-off point to 
descend.

 • The sheath tank gets moved.
 • The fluid stream is not in the center of 

camera view after the nozzle is 
replaced.

 • The stream camera does not work 
properly.

 • The strobe LED is defective.

1. Select Standby to turn off the sheath.
2. Verify that the camera USB on the Sorter is securely 

connected to the workstation. Refer to Figure 1.34.
3. Verify that the quick connectors on the sheath tank, 

the fluidics cart, and the Sorter are securely 
connected. Refer to Figure 1.6, Figure 1.8, 
Figure 1.11.

4. Verify that the nozzle is clean and O-ring is present. 
 • Clean the nozzle if needed. Refer to Cleaning the 

Nozzle in CHAPTER 10, Cleaning Procedures.
 • If necessary, replace the O-ring. Refer to 

Replacing the O-Ring in CHAPTER 11, 
Replacement/Adjustment Procedures.

 • If the nozzle is damaged, replace the nozzle. 
Refer to Replacing the Nozzle in CHAPTER 11, 
Replacement/Adjustment Procedures.

5. Reinstall the nozzle module. Refer to Removing/
Installing the Nozzle Module in CHAPTER 11, 
Replacement/Adjustment Procedures.

6. Run Sheath Filter debubble. Refer to Performing the 
Sheath Filter De-bubble in CHAPTER 11, 
Replacement/Adjustment Procedures.

7. Run Flow Cell Debubble. Refer to Performing the 
Flow Cell De-bubble in CHAPTER 11, Replacement/
Adjustment Procedures.

8. Run Daily Clean. Refer to Daily Clean Program in 
CHAPTER 10, Cleaning Procedures.

9. Run Flow cell Clean. Refer to Flow Cell Clean 
Program in CHAPTER 10, Cleaning Procedures.

10. Restart the system.
11. If the problem persists, contact us.
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